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Copyright © 2013 ASUSTeK COMPUTER INC. All Rights Reserved.

No part of this manual, including the products and software described in it, may be reproduced,
transmitted, transcribed, stored in a retrieval system, or translated into any language in any form or by any
means, except documentation kept by the purchaser for backup purposes, without the express written
permission of ASUSTeK COMPUTER INC. (“ASUS”).

Product warranty or service will not be extended if: (1) the product is repaired, modified or altered, unless
such repair, modification of alteration is authorized in writing by ASUS; or (2) the serial number of the
product is defaced or missing.

ASUS PROVIDES THIS MANUAL “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL ASUS, ITS
DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE LIABLE FOR ANY INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES (INCLUDING DAMAGES FOR LOSS OF PROFITS,
LOSS OF BUSINESS, LOSS OF USE OR DATA, INTERRUPTION OF BUSINESS AND THE LIKE),
EVEN IF ASUS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES ARISING FROM ANY
DEFECT OR ERROR IN THIS MANUAL OR PRODUCT.

SPECIFICATIONS AND INFORMATION CONTAINED IN THIS MANUAL ARE FURNISHED FOR
INFORMATIONAL USE ONLY, AND ARE SUBJECT TO CHANGE AT ANY TIME WITHOUT NOTICE,
AND SHOULD NOT BE CONSTRUED AS A COMMITMENT BY ASUS. ASUS ASSUMES NO
RESPONSIBILITY OR LIABILITY FOR ANY ERRORS OR INACCURACIES THAT MAY APPEAR IN THIS
MANUAL, INCLUDING THE PRODUCTS AND SOFTWARE DESCRIBED IN IT.

Products and corporate names appearing in this manual may or may not be registered trademarks or
copyrights of their respective companies, and are used only for identification or explanation and to the
owners’ benefit, without intent to infringe.

Offer to Provide Source Code of Certain Software

This product contains copyrighted software that is licensed under the General Public License (“GPL”),
under the Lesser General Public License Version (“LGPL”) and/or other Free Open Source Software
Licenses. Such software in this product is distributed without any warranty to the extent permitted by the
applicable law. Copies of these licenses are included in this product.

Where the applicable license entitles you to the source code of such software and/or other additional data,
you may obtain it for a period of three years after our last shipment of the product, either

(1) for free by downloading it from http:/support.asus.com/download

or

(2) for the cost of reproduction and shipment, which is dependent on the preferred carrier and the location
where you want to have it shipped to, by sending a request to:

ASUSTeK Computer Inc.
Legal Compliance Dept.
15 Li Te Rd.,

Beitou, Taipei 112
Taiwan

In your request please provide the name, model number and version, as stated in the About Box of the
product for which you wish to obtain the corresponding source code and your contact details so that we
can coordinate the terms and cost of shipment with you.

The source code will be distributed WITHOUT ANY WARRANTY and licensed under the same license as
the corresponding binary/object code.

This offer is valid to anyone in receipt of this information.

ASUSTeK is eager to duly provide complete source code as required under various Free Open Source
Software licenses. If however you encounter any problems in obtaining the full corresponding source
code we would be much obliged if you give us a notification to the email address gpl@asus.com, stating
the product and describing the problem (please DO NOT send large attachments such as source code
archives, etc. to this email address).
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Safety information

Electrical safety

To prevent electrical shock hazard, disconnect the power cable from the electrical outlet
before relocating the system.

When adding or removing devices to or from the system, ensure that the power cables
for the devices are unplugged before the signal cables are connected. If possible,
disconnect all power cables from the existing system before you add a device.

Before connecting or removing signal cables from the motherboard, ensure that all
power cables are unplugged.

Seek professional assistance before using an adapter or extension cord. These devices
could interrupt the grounding circuit.

Ensure that your power supply is set to the correct voltage in your area. If you are not
sure about the voltage of the electrical outlet you are using, contact your local power
company.

If the power supply is broken, do not try to fix it by yourself. Contact a qualified service
technician or your retailer.

Operation safety

Before installing the motherboard and adding devices on it, carefully read all the manuals
that came with the package.

Before using the product, ensure all cables are correctly connected and the power
cables are not damaged. If you detect any damage, contact your dealer immediately.

To avoid short circuits, keep paper clips, screws, and staples away from connectors,
slots, sockets and circuitry.

Avoid dust, humidity, and temperature extremes. Do not place the product in any area
where it may become wet.

Place the product on a stable surface.

If you encounter technical problems with the product, contact a qualified service
technician or your retailer.



About this guide

This user guide contains the information you need when installing and configuring the
motherboard.

How this guide is organized

This guide contains the following parts:

.

Chapter 1: Product introduction

This chapter describes the features of the motherboard and the new technology it
supports.

Chapter 2: Hardware information

This chapter lists the hardware setup procedures that you have to perform when
installing system components. It includes description of the switches, jumpers, and
connectors on the motherboard.

Chapter 3: BIOS setup

This chapter tells how to change system settings through the BIOS Setup menus.
Detailed descriptions of the BIOS parameters are also provided.

Chapter 4: Software support

This chapter describes the contents of the support DVD that comes with the
motherboard package and the software.

Chapter 5: Multiple GPU technology support

This chapter describes how to install and configure multiple ATI® CrossFireX™ and
NVIDIA® SLI™ graphics cards.

Where to find more information

Refer to the following sources for additional information and for product and software updates.

1.

ASUS websites

The ASUS website provides updated information on ASUS hardware and software
products. Refer to the ASUS contact information.

Optional documentation

Your product package may include optional documentation, such as warranty flyers,
that may have been added by your dealer. These documents are not part of the
standard package.

vii



Conventions used in this guide

To ensure that you perform certain tasks properly, take note of the following symbols used
throughout this manual.

g DANGER/WARNING: Information to prevent injury to yourself when trying to
complete a task.

CAUTION: Information to prevent damage to the components when trying to
complete a task

[T )

R IMPORTANT: Instructions that you MUST follow to complete a task..

? NOTE: Tips and additional information to help you complete a task.

Typography
Bold text Indicates a menu or an item to select.
Italics Used to emphasize a word or a phrase.
<Key> Keys enclosed in the less-than and greater-than sign means that you must
press the enclosed key.
Example: <Enter> means that you must press the Enter or Return key.
<Key1> + <Key2> + <Key3> If you must press two or more keys simultaneously, the key names are linked

with a plus sign (+).

viii



P9X79 LE specifications summary

Chipset

Memory

Expansion slots

Multi-GPU support

Storage

2nd Generation Intel® Core™ i7 Processor family for the LGA
2011 Socket

Supports Intel® Turbo Boost Technology 2.0

* Refer to www.asus.com for CPU support list

Intel® X79 Express Chipset

8 x DIMM, max. 64GB, DDR3 2400(0.C.) / 2133(0.C.) /
1866/ 1600 / 1333 / 1066 MHz, non-ECC, un-buffered
memory

Quad channel memory architecture

Supports Intel® Extreme Memory Profile (XMP)

** Hyper DIMM support is subject to the physical characteristics
of individual CPUs.

** Refer to www.asus.com for the Memory QVL (Qualified
Vendors Lists).

2 x PCI Express 3.0 x16 slots (Dual at x16/ x16 mode, Triple at
x16/ x16/ x8)

1 x PCI Express 3.0 x16 slot (PCle x16_3 at x8 mode)

2 x PCI Express 2.0 x1 slots

1 x PCl slot

* This motherboard is ready to support PCle 3.0 SPEC. Functions
will be available when using PCle 3.0-compliant devices. Please
refer to www.asus.com for updated details.

Supports NVIDIA® 3-Way SLI™ Technology
Supports AMD® Quad-GPU CrossFireX™ Technology

Intel® X79 Express Chipset
- 2 x SATA 6 Gb/s ports with RAID 0, 1, 5 and 10 support
- 4 x SATA 3 Gb/s ports with RAID 0, 1, 5 and 10 support

ASMedia® 1061 SATA controller
- 2xeSATA 6Gb/s ports

Realtek® 8111F Gigabit LAN Controller

2 x ASMedia® USB 3.0 controllers
- 2xUSB 3.0/2.0 ports at mid-board for front panel support
- 2xUSB 3.0/2.0 ports at back panel (Blue)
Intel® X79 Express Chipset
- 14 x USB 2.0/1.1 ports
(6 ports at mid-board; 8 ports at back panel)

Realtek® ALC892 8-channel High Definition Audio CODEC
- Support 192khz / 24bit BD Lossless Sound
- BD Audio Layer Content Protection
- Supports Jack-Detection, Multi-Streaming and
Front Panel Jack-Retasking
- Optical S/PDIF Out port at back I/0

(continued on the next page)



P9X79 LE specifications summary

ASUS exclusive Precision Tweaker 2:

overclocking features - vCore: Adjustable CPU voltage at 0.005V increment

- VTTCPU: Adjustable I/0 voltage at 0.00625V increment
- VCCSA: 255-step system agent voltage control

- vDRAM Bus: 160-step Memory voltage control

- vPCH: 96-step Chipset voltage control

- VCPU_PLL: 48-step CPU & PCH PLL voltage control

SFS (Stepless Frequency Selection):
- BCLK/PEG frequency tuning from 80MHz up to 300MHz at
0.1MHz increment

Overclocking Protection:
- ASUS C.P.R.(CPU Parameter Recall)

ASUS Unique Features ASUS Dual Intelligent Processors 3
with New DIGI+ Power Control:

CPU Power
- Industry leading Digital 6+2 Phase Power Design
- CPU Power Utility

DRAM Power
- Industry leading Digital 2+2 Phase Power Design
- DRAM Power Utility

ASUS TPU
- Auto Tuning, TurboV

ASUS EPU
- EPU Utility

ASUS Exclusive Features:
- ASUS UEFI BIOS EZ Mode featuring friendly graphics user
interface
- USB 3.0 Boost
- MemOK!
- Remote GO!
- Al Suite Il
- AiCharger

ASUS Quiet Thermal Solution:
- ASUS Fanless Design: Stylish Heat-sink solution
- ASUS Fan Xpert+

ASUS EZ DIY:
- USB BIOS Flashback with USB BIOS Flashback Wizard for
EZ BIOS download scheduling
- ASUS O.C. Profile
- ASUS MyLogo 2
- Percision Tweaker 2
- ASUS CrashFree BIOS 3
- ASUS EZ Flash 2
- DirectKey
- Multi-language BIOS

ASUS Q-Design:
- ASUS Q-Shield
- ASUS Q-Slot
- ASUS Q-DIMM
- ASUS Q-LED (CPU, DRAM, VGA, Boot Device LED)
- ASUS Q-Connector

(continued on the next page)



P9X79 LE specifications summary

Back panel I/O ports

Internal /0 connectors

BIOS features

Manageability

Support DVD contents

Form factor

1 x PS/2 Keyboard port

1 x PS/2 Mouse port

2 x USB 3.0/2.0 ports (blue)
8 x USB 2.0/1.1 ports

1 x LAN (RJ-45) port

1 x Optical S/PDIF Out port
2 x eSATA 6Gb/s ports (red)
8-channel Audio I/0O

3 x USB 2.0/1.1 connectors support additional 6 USB ports
2 x SATA 6Gb/s connectors

4 x SATA 3Gb/s connectors

1 x CPU Fan connector (4-pin)

1 x CPU Optional Fan connector (4-pin)
4 x Chassis Fan connectors (4-pin)

1 x Front panel audio connector (AAFP)
1 x COM connector

1 x TPM connector

1 x S/PDIF Out header

1 x Clear CMOS jumper

1 x 24-pin EATX Power connector

1 x 8-pin EATX 12V Power connector

1 x System Panel (Q-Connector)

1 x MemOK! button

1 x DirectKey button

1 x DRCT header

1 x USB BIOS Flashback button

64 Mb Flash ROM, UEFI BIOS, PnP, DMI 2.0, WfM 2.0,
SM BIOS 2.6, ACPI 2.0a, Multi-language BIOS,
ASUS EZ Flash 2, ASUS CrashFree BIOS 3

WfM 2.0, DMI 2.0, WOL by PME, WOR by PME, PXE

Drivers

ASUS Utilities

ASUS Update

Anti-virus software (OEM version)

ATX form factor: 12 in. x 9.6 in. (30.5 cm x 24.4 cm)

*Specifications are subject to change without notice.
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1.1 Welcome!
Thank you for buying an ASUS® P9X79 LE motherboard!

The motherboard delivers a host of new features and latest technologies, making it another
standout in the long line of ASUS quality motherboards!

Before you start installing the motherboard, and hardware devices on it, check the items in
your package with the list below.

1.2 Package contents

Check your motherboard package for the following items.

Support DVD

mﬂ‘/ m'/

2 x Serial ATA 6.0 Gb/s cables | 2 x Serial ATA 3.0 Gb/s cables 1 x ASUS Q-Shield

|

1 x ASUS SLI™ bridge . ]
connector 1 x 2-in-1 ASUS Q-Connector kit

% +  Ifany of the above items is damaged or missing, contact your retailer.
~— +  Theillustrated items above are for reference only. Actual product specifications may
vary with different models.

ASUS P9X79 LE



1.3 Special features
1.3.1 Product highlights

2nd Generation Intel® Core™ i7 Processor family for the LGA 2011 Socket

This motherboard supports the latest 2nd Generation Intel® Core™ i7 Processor Family in
LGA2011 package, with memory and PCI Express controllers integrated to quad-channel

(8 DIMMs) DDR3 memory and 40 PCI Express 3.0 lanes. This provides great graphics
performance. 2nd Generation Intel® Core™ i7 Processor Family is one of the most powerful
and energy efficient CPUs in the world.

Intel® X79 Express Chipset

The Intel® X79 Express Chipset is the latest single-chipset design that supports the new
socket 2011 2nd Generation Intel® Core™ i7 Processor Family. It improves performance by
utilizing serial point-to-point links, allowing for increased bandwidth and stability. Additionally,
the X79 comes with 2 SATA 6Gb/s and 4 SATA 3Gb/s ports for faster data retrieval, doubling
the bandwidth of current bus systems.

3-Way SLI™ and Quad-GPU CrossFireX™ Support

Both SLI and CrossfireX architectures work flawlessly on new ASUS X79 boards, with PCI
Express slots designed to accommodate the power of up to three current graphics cards.
Whether for professional graphics work, heavy duty multimedia or dedicated gaming, more
than ample graphics power can be applied whenever needed.

Quad-Channel DDR3 2400(0.C.)/2133(0.C.)/1866/1600/1333/1066 MHz Support

The motherboard supports DDR3 memory that features data transfer rates of 2400(O.
C.)/2133(0.C.)/1866/1600/1333/1066 MHz to meet the higher bandwidth requirements of

the latest operation system, 3D graphics, multimedia, and Internet applications. The quad-
channel DDRS3 architecture quadruple the bandwidth of your system memory to boost system
performance.

* Due to CPU behavior, DDR3 2200/2000/1800 MHz memory module will run at DDR3 2133/1866/1600
MHz frequency as default.

Complete USB 3.0 Integration

ASUS facilitates strategic USB 3.0 accessibility for both the front and rear panel — 4 USB 3.0
ports in total. Experience the latest plug & play connectivity at speeds up to 10 times faster
than USB 2.0. The P9X79 LE affords greater convenience to high speed connectivity.

PCle 3.0 Ready

The latest PCI Express bus standard delivers improved encoding for twice the performance
of current PCle 2.0. Total bandwidth for a x16 link reaches a maximum of 32GB/s, double
the 16GB/s of PCle 2.0 (in x16 mode). PCle 3.0 provides users unprecedented data speeds,
combined with the convenicnce and seamless transition offered by complete backward
compatibility with PCle 1.0 and PCle 2.0 devices. It is a must-have feature PC users aiming
to improve and optimize graphics performance, as well as have the latest, most future-proof
technology.

* This motherboard is ready to support PCle 3.0 SPEC. Functions will be available when using PCle
3.0-compliant devices. Please refer to www.asus.com for updated details.

Chapter 1: Product Introduction



1.3.2 Dual Intelligent Processors 3 with New DIGI+ Power Control

The world’s first Dual Intelligent Processors from ASUS pioneered twin onboard chips

- TPU (TurboV Processing Unit) and EPU (Energy Processing Unit). Third generation
Dual Intelligent Processors with New DIGI+ Power Control include two digital voltage
regulator modules (VRMs). An all-new digital controller now allows ultra-precise DRAM
tuning in addition to CPU voltage control. This evolution of innovative and industry-leading
ASUS technology provides super-accurate voltage tuning for better efficiency, stability and
performance.

New DIGI+ Power Control

All-New Digital Power Control for both CPU and DRAM

ASUS X79 motherboards include New DIGI+ Power Control with two digital voltage regulator
modules (VRMs), including an all-new DRAM controller that allows ultra-precise memory
tuning in addition to CPU voltage control. This evolution of innovative, industry-leading ASUS
technology provides super-accurate voltages for better efficiency, stability and performance.

Best in class power efficiency and stability

Two critical components work perfectly together to match digital power signal (SVID) requests
from the CPU, with ultra-fast sensing and response to efficiently deliver the right level of
power on demand. Accurate power reduces wasteful imprecision, and provides more stable
CPU Vcore voltages.

Increased CPU and DRAM overclocking range

With programmable digital controllers onboard, users can adjust CPU and DRAM PWM
voltages and frequencies for various overclocking scenarios, with accurate input through
UEFI BIOS tuning or the exclusive ASUS interface. System performance can also be
customized with specific CPU and DRAM power controls, including new VCCSA load line
calibration for increased voltage range, greater VCCSA current capability, and up to 30%
more capacitance. This proprietary design, with its precise yet flexible power adjustments,
increases overclocking headroom to push performance to its full potential.

TPU

Unleash your performance with ASUS’ simple onboard switch or Al Suite Il utility. The TPU
chip offers precise voltage control and advanced monitoring through Auto Tuning and TurboV
functions. Auto tuning offers a user friendly way to automatically optimize the system for fast,
yet stable clock speeds, while TurboV enables unlimited freedom to adjust CPU frequencies
and ratios for optimized performance in diverse situations.

EPU

Tap into the world’s first real-time PC power saving chip through a simple onboard switch or
Al Suite Il utility. Get total system-wide energy optimization by automatically detecting current
PC loadings and intelligently moderating power consumption. This also reduces fan noise
and extends component longevity.

ASUS P9X79 LE



1.3.3 ASUS Exclusive Features

USB BIOS Flashback

USB BIOS Flashback offers the most convenient way to flash the BIOS ever! It allows
overclockers to try new BIOS versions easily, without even entering their existing BIOS or
operating system. Just plug in USB storage and push the dedicated button for 3 seconds,
and the BIOS is automatically flashed using standby power. Worry-free overclocking for the
ultimate convenience!

USB 3.0 Boost

New ASUS USB 3.0 Boost technology supports UASP (USB Attached SCSI Protocol), the
latest USB 3.0 standard. With USB 3.0 Boost, USB device transmission speed is significantly
increased by up to 170%, adding to an already impressively fast USB 3.0 transfer speed.
USB 3.0 Boost provides a user-friendly graphical interface, which instantly accelerates the
transfer speeds for USB 3.0 peripherals with exclusive ASUS device auto-detect settings.

DirectKey

DirectKey allows you to conveniently go into the BIOS setup with the press of a button. With
this feature, you can enter the BIOS anytime without having to press the <Del> key during
POST. It also allows you to shut down or turn on your computer and directly enter the BIOS
during boot-up.

Remote GO!

Remote GO! links PCs, tablets, smartphones and TVs wirelessly together through an existing
LAN cable or router. It provides a seamless environment for a futuristic connected lifestyle
with three useful functions: DLNA Media Hub, Remote Desktop and File Transfer.

DLNA Media Hub: Enjoy HD video, music and photos stored in the PC streaming to your
DLNA devices via Wi-Fi connectivity.

Remote Desktop: Operate and control your PC in real-time from a smartphone or tablet for
complete comfort and convenience.

File Transfer: Send and share files between your PC and smart devices* with only a right
click on the mouse.

*iPad/iPhone can send, but not receive files from the PC.

Al Suite Il

With its user-friendly interface, ASUS Al Suite Il consolidates all exclusive ASUS features
into one simple-to-use package with an elegant design theme. It allows users to supervise
overclocking, energy management, fan speeds, voltage, and sensor readings. This all-in-
one software offers diverse and easy to use functions, with no need to switch back and forth
between different utilities.

MemOK!

MemOK! quickly ensures memory boot compatibility. This remarkable memory rescue tool
requires a mere push of a button to patch memory issues. MemOK! determines failsafe
settings and dramatically improves your system boot success.

Chapter 1: Product Introduction



1.34 ASUS Quiet Thermal Solution

ASUS Fanless Design—Heat-sink solution

The stylish heatsink offers 0dB cooling for a quiet PC environment. Attractive design
enhances the look of the board and case, while temperatures in the chipset and power phase
areas stay lower through high efficiency heat exchange. Combining usability and aesthetics,
the stylish ASUS heatsink gives users an extremely silent and cool experience with elegant
design.

ASUS Fan Xpert+

Hardware-level ASUS Fan Xpert+ allows users to independently adjust both CPU and case
fan speeds with multiple dedicated controllers based on different ambient temperatures,
climate conditions and system loads. Built-in profiles offer flexible automatic and manual fan
speed controls to achieve a quiet and cool computing environment.

1.3.5 ASUS EZ DIY

ASUS UEFI BIOS

ASUS UEFI BIOS offers the first mouse-controlled graphical BIOS designed with selectable
modes, providing a user-friendly interface that goes beyond traditional keyboard-only
controls. It also natively supports fully-utilized hard drives larger than 2.2TB in 64-bit
operating systems.

ASUS exclusive interface

EZ Mode displays frequently-accessed info. Users can choose system performance settings
and drag and drop boot priorities. Advanced Mode for performance enthusiasts includes
detailed DRAM settings via a dedicated memory info page for complete insight.

New upgrade! Quick and easy info for enhanced system control
- F12 BIOS snapshot hotkey for sharing UEFI setup info and troubleshooting

- New F3 Shortcut for most accessed info
- ASUS DRAM SPD (Serial Presence Detect) Information for accessing memory info,
detecting faulty DIMMs and helping with difficult POST situations.

ASUS Q-Design

ASUS Q-Design enhances your DIY experience. All of Q-LED, Q-Slot, and Q-DIMM design
speed up and simplify the DIY process!

ASUS Q-Shield

The specially designed ASUS Q-Shield does without the usual "fingers" - making it
convenient and easy to install. With better electric conductivity, it ideally protects your
motherboard against static electricity and shields it against Electronic Magnetic Interference
(EMI).

ASUS P9X79 LE



ASUS Q-Connector

ASUS Q-Connector allows you to easily connect or disconnect the chassis front panel cables
to the motherboard. This unique module eliminates the trouble of connecting the system
panel cables one at a time and avoiding wrong cable connections.

ASUS EZ-Flash 2

ASUS EZ Flash 2 is a user-friendly utility that allows you to update the BIOS without using a
bootable floppy disk or an OS-based utility.

1.3.6 Other special features

eSATA 6Gb/s Ready

eSATA 6Gb/s can let users enjoy 2X faster transfer rates on external SATA 6Gb/s devices.
ASUS provides two extra ports with enhanced scalability, faster data retrieval, and double the
bandwidth of current bus systems for extra speed and accessibility.

ErP Ready

The motherboard is European Union’s Energy-related Products (ErP) ready, and ErP requires
products to meet certain energy efficiency requirement in regards to energy consumptions.
This is in line with ASUS vision of creating environment-friendly and energy-efficient products
through product design and innovation to reduce carbon footprint of the product and thus
mitigate environmental impacts.

Chapter 1: Product Introduction



2.1 Before you proceed

Take note of the following precautions before you install motherboard components or change
any motherboard settings.

& + Unplug the power cord from the wall socket before touching any component.

+  Before handling components, use a grounded wrist strap or touch a safely grounded
object or a metal object, such as the power supply case, to avoid damaging them due
to static electricity.

Hold components by the edges to avoid touching the ICs on them.

+ Whenever you uninstall any component, place it on a grounded antistatic pad or in the
bag that came with the component.

+  Before you install or remove any component, ensure that the ATX power supply is
switched off or the power cord is detached from the power supply. Failure to do so
may cause severe damage to the motherboard, peripherals, or components.

ASUS P9X79 LE 2-1
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Refer to 2.2.8 Internal connectors and 2.3.11 Rear panel connection for more
information about rear panel connectors and internal connectors.
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Layout contents

Connectors/Jumpers/Slots Page

1. DDR3 DIMM slots 2-5
2 ATX power connectors (24-pin EATXPWR, 8-pin EATX12V) 2-29
3. LGA2011 CPU socket 2-4
4 CPU, CPU OPT, Chassis fan connectors (4-pin CPU_FAN, 2-27
4-pin CPU_OPT, 4-pin CHA_FAN1/2/3/4)
5. MemOK! 2-17
USB 3.0 connector (20-1 pin USB3_34) 2-25
Intel® X79 Serial ATA 6.0 Gb/s connectors 2-22
(7-pin SATA6G_1/2 [gray])
8. Intel® X79 Serial ATA 3.0 Gb/s connectors 2-23
(7-pin SATA3G_3-6 [blue])
9. Standby Power LED 2-19
10. Clear RTC RAM (3-pin CLRTC) 2-21
1. Direct Connector (2-pin DRCT) 2-28
12. System panel connector (20-8 pin PANEL) 2-30
13. TPM connector (20-1 pin TPM) 2-25
14. USB 2.0 connectors (10-1 pin USB910, USB1112, USB1314) 2-24
15. BIOS Flashback switch 2-19
16. Serial port connector (10-1 pin COM1) 2-26
17. DirectKey button 2-18
18. Front panel audio connector (10-1 pin AAFP) 2-28
19. Digital audio connector (4-1 pin SPDIF_OUT) 2-26
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2.2.2
The m

Central Processing Unit (CPU)

otherboard comes with a surface mount LGA2011 socket designed for the 2™

Generation Intel® Core™ i7 Processor Family.

A

o>

e ('8 ] COC] commmin

P9X79 LE CPU LGA2011

Ensure that all power cables are unplugged before installing the CPU.

. Upon purchase of the motherboard, ensure that the PnP cap is on the socket and
the socket contacts are not bent. Contact your retailer immediately if the PnP cap
is missing, or if you see any damage to the PnP cap/socket contacts/motherboard
components. ASUS will shoulder the cost of repair only if the damage is shipment/
transit-related.

Keep the cap after installing the motherboard. ASUS will process Return Merchandise
Authorization (RMA) requests only if the motherboard comes with the cap on the
LGA2011 socket.

The product warranty does not cover damage to the socket contacts resulting from
incorrect CPU installation/removal, or misplacement/loss/incorrect removal of the PnP
cap.

Chapter 2: Hardware information



223 System memory

The motherboard comes with eight Double Data Rate 3 (DDR3) Dual Inline Memory Modules
(DIMM) slots.

' A DDR3 module is notched differently from a DDR or DDR2 module. DO NOT install a DDR
SELE or DDR2 memory module to the DDR3 slot.
- o
35 I 29
sS=s S=s
S= S=
oo oo

e "8 [ COC] cmmmiin

P9X79 LE 240-pin DDR3 DIMM socket

Recommended memory configurations

ASUS P9X79 LE
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Memory configurations

You may install 1GB, 2GB, 4GB, and 8GB unbuffered, and non-ECC DDR3 DIMMs into the
DIMM sockets.

R +  You may install varying memory sizes in Channel A, B, C, and D. The system maps
the total size of the lower-sized channel for the dual-channel, triple-channel, or quad-
channel configuration. Any excess memory from the higher-sized channel is then
mapped for single-channel operation.

Due to CPU behavior, DDR3 2200/2000/1800 MHz memory module will run at DDR3
2133/1866/1600 MHz frequency as default.

According to Intel® spec, the max. 64GB memory capacity can be supported with
DIMMs of 8GB (or above). ASUS will update QVL once the DIMMs are available on
the market.

According to Intel CPU spec, DIMM voltage below 1.65V is recommended to protect
the CPU.

+ Always install DIMMs with the same CAS latency. For optimum compatibility, we
recommend that you obtain memory modules from the same vendor.

+  Due to the memory address limitation on 32-bit Windows OS, when you install 4GB
or more memory on the motherboard, the actual usable memory for the OS can be
about 3GB or less. For effective use of memory, we recommend that you do any of the
following:

- Use a maximum of 3GB system memory if you are using a 32-bit Windows OS.

- Install a 64-bit Windows OS when you want to install 4GB or more on the
motherboard.
However, there are differences in memory support specifications on 64-bit Windows
OS. Please visit www.Microsoft.com for more details.
For more details, refer to the Microsoft® support site at
http:/support.microsoft.com/kb/929605/en-us.

This motherboard does not support DIMMs made up of 512Mb (64MB) chips or less
(Memory chip capacity counts in Megabit, 8 Megabit/Mb = 1 Megabyte/MB).

(SPD), which is the standard way of accessing information from a memory module.
Under the default state, some memory modules for overclocking may operate at a
lower frequency than the vendor-marked value. To operate at the vendor-marked
or at a higher frequency, refer to section 3.4 Ai Tweaker menu for manual memory
frequency adjustment.

% +  The default memory operation frequency is dependent on its Serial Presence Detect

For system stability, use a more efficient memory cooling system to support a full
memory load (4 DIMMs or above) or overclocking condition.
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P9X79 LE Motherboard Qualified Vendors Lists (QVL)
DDR3 2400 MHz capability

(%MM sot;kel support
Chip Chip . ptional
Brand NO. Timing Voltage 4 6 8
DIMM DIMM DIMM DIMM
A-DATA AX3U2400GC4G10(XMP) 4GB DS - - 10-11-11-30  1.65 .
CORSAIR  CMGTX3(XMP) 2GB DS - - 9-11-9-27 1.65 .
CORSAIR  CMGTX8(XMP) 8GB SS - - 10-12-10-30  1.65 .
(4x2GB)
G.SKILL F3-19200CL10Q-32GBZHD(XMP) ~ 32GB DS - - 10-12-12-31  1.65 .
(4x8GB)
G.SKILL F3-19200CL11Q-16GBZHD(XMP)  16GB DS - - 1-11-11-31 165 . .
(4x4GB)
G.SKILL F3-19200CL11Q-16GBZHD(XMP)  16GB DS - - 11-11-11-31 165 .
(4x4GB)
G.SKILL F3-19200CL9D-4GBPIS(XMP) 4G DS - - 9-11-9-28 1.65 .
(2x2G)
G.SKILL F3-19200CL9Q-16GBZMD(XMP)  16GB DS - - 9-11-11-31  1.65 .
(4x4GB)
GEIL GOC316GB2400C10QC(XMP) 16GB DS - - 10-11-11-30  1.65 . .
(4x4GB)
Kingston KHX2400C11D3K4/8GX(XMP) 8GB SS - - 11-13-11-30  1.65 .
(4x2GB)
Patriot PVV34G2400C9K(XMP) 4GB DS - - 9-11-9-27 1.66 . .
(2x2GB)
Transcend ~ TX2400KLU-4GK (381850)(XMP)  2GB DS - - - 1.65 .
Transcend  TX2400KLU-4GK(374243)(XMP) 2GB DS - - - 1.65 . .

P9X79 LE Motherboard Qualified Vendors Lists (QVL)
DDR3 2200 MHz capability

DIMM socket support

i Optional]
Part No. S::gd Chip NO. Timing Voltage (Optional)

4 6 8
DIMM DIMM DIMM DIMM
G.SKILL  F3-17600CL7D-4GBFLS(XMP) 4G DS . . 7-10-10-28 165 -+
(2x2G)

GEIL GET34GB2200CIDC(XMP) 4GB DS - - 910928 165 -+ .
(2x2GB)

GEIL GET38GB2200CIADC(XMP)  8GB DS . . 9-11-928 165
(2x4GB)

KINGMAX ~ FLKES5F-B8KJAA-FEIS(XMP) 4GB
(2x2GB)

DS Kingmax N/A - - .

P9X79 LE Motherboard Qualified Vendors Lists (QVL)
DDR3 2133 MHz capability

DIMM socket support

Part No. sss SMiP chipNo. Timing  Voltage (O""°"2') I
DIMM_DIMM_DIMM_DIMM
A-DATA  8154A 1044(XMP) 2B S§ - - 99924 155175 + .+
ADATA  AX3U2133C2G9B(XMP) 268 ss - - 911927 155175 - - - -
ADATA  AX3U2133GC2GIB(XMP) 268 sS - - 99924 155175 -
ADATA  AX3U2133GC4GIB(XMP) lees oS - - 911927 165 .
(%)
Apacer  78.BAGE4.AFDOC(XMP) 8GB DS - - 99924 - B
&)
CORSAR  OMT4GXaMRAZICONP) 4GB DS - - 910924 165 . S
Sa8)
CORSAIR  CMT4GX3M2B2133C9 4 DS - - 99924 15 .
(Ver7.1)(XMP) (2x
2GB)
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P9X79 LE Motherboard Qualified Vendors Lists (QVL)
DDR3 2133 MHz capability

DIMM socket support
Part No. sss SNIP chipNO. Timing  Voltage (optcnsl)

4 6 8
DIMM DIMM DIMM DIMM

CORSAIR  CMT4GX3M2B2133C9(XMP) 4GB DS - . 910927 15
2x
2GB)

G.SKILL  F3-17000CL11Q2-64GBZLD(XMP) 64GB DS - - 11-11-11-30 1.5 . . . .
8

X
8GB)

G.SKILL F3-17000CL9Q-16GBXLD(XMP)  16GB DS - - 9-11-9-28 165 . . . .
(4x
4GB)
G.SKILL  F3-17000CL9Q-16GBZH(XMP) ZGGB DS - - 9-11-10-28  1.65 . . . .
4x
4GB)
G.SKILL F3-17066CL9D-8GBPID(XMP) 8GB DS - - 9-9-9-24 1.65 . . .
(2x
4GB)
KINGSTON  KHX2133C11D3K4/16GX(XMP) 13(38 DS - - 11-12-11-30 1.65
X
4GB)
Patriot PVV34G2133C9K(XMP) 4GB DS - - 9-11-9-27  1.66 . . . .
2X
2GB)
s

P9X79 LE Motherboard Qualified Vendors Lists (QVL)
DDR3 2000 MHz capability

DIMM socket support
e (Optional)
Timing Voltage
2 4 6 8
DIMM DIMM DIMM DIMM
A-DATA  AX3U2000GB2G9B(XMP) 2GB DS - - 9-11-9-27  1.55~1.75 - . . .
A-DATA  AX3U2000GC4G9B(XMP) 4GB DS - - 9-11-9-27  1.55~1.75 - . .
AEXEA  AXA3ES2G2000LG28V  2GB DS - - - 1.65 .
(XMP)
IAEXEA AXA3ES4GK2000LG28V 4GB DS - - - 1.65 . .
(XMP) (2x2GB)
Apacer 78.AAGD5.9KD(XMP) 6GB DS - - 9-9-9-27 - .
(3% 2GB)
Asint (SXLIGS?ZGOB-MLZHB 4GB DS Hynix H5TQ2G83BFRHIC 9-9-9-27 - . . . .
CORSAIR  CMT6GX3M3A2000C8 6GB DS - - 8-9-8-24 1.65 . . .
(XMP) (3x2GB)
CORSAIR  CMZ4GX3M2A2000C10 4GB 8S - - 10-10-10-27 1.5 .
(Ver 5.12)(XMP) (2x2GB)
G.SKILL  F3-16000CL9D-4GBRH 4GB DS - - 9-9-9-24 1.65 .
(XMP) (2x 2GB)
G.SKILL  F3-16000CL9D-4GBTD 4GB DS - - 9-9-9-24 1.65 .
(XMP) (2x 2GB)
GEIL GUP34GB2000C9DC 4GB DS - - 9-9-9-28 1.65 . . . .
(XMP) (2x2GB)
Patriot PV736G2000ELK 6GB DS - - 7-7-7-20 1.65 . . .
(XMP) (3x2GB)
Patriot PX7312G2000ELK 12GB DS - - 9-11-9-27  1.65 . . . .
(XMP) (3x4GB)
{Silicon SP002GBLYU200S02 2GB DS - - - - .
Power (XMP)
Team TXD32048M2000C9 2GB DS Team T3D1288RT-20 9-9-9-24 15 . . . .
(XMP)
Team ;I')z(’\?s)ZMBMZODOCQ-L 2GB DS Team T3D1288LT-20 9-9-9-24 15 .
Team TXD32048M2000C9-L 2GB DS Team T3D1288RT-20 9-9-9-24 1.6 . . . .
(XMP)
Transcend  TX2000KLN-8GK 4GB DS - - - 1.6 .

(388375)(XMP)
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P9X79 LE Motherboard Qualified Vendors Lists (QVL)
DDR3 1866 MHz capability

[gMM sufket support
X
Part No. Chip NO. Timing Voltage  (OPtional)

4 6 8
DIMM DIMM DIMM DIMM
A-DATA  AX3U1866GC2GIB(XMP) 2GB  SS - - 9-11-927  155~1.75 - . .
A-DATA  AX3U1866GC4GIB(XMP) 4GB DS - - 9-11-927  155~1.75 - . . .
CORSAIR CMT32GX3M4X1866C9 3GB DS - B 910927 15 . . . .
(Ver3.23)(XMP) (4x 8GB)
CORSAIR CMZ32GX3M4X1866C10 32GB DS - . 10-11-10-27 15 . . . .
(Ver3.23)(XMP) (4x 8GB)
CORSAIR CMZB8GX3M2A1866C9(XMP) 8GB DS - B 910927 15
(2x4GB)
Crucial =3LE4GSD1869DEIXTO.16FMD 4GB DS - - 99927 15 . . . .
(XMP)

G.SKILL r):?’:/ré)QOOCU 0Q2-64GBZLD  64GB DS 10-11-10-30 1.5 . . . .

(8x8GB)

G.SKILL ~ F3-14900CL9D-8GBSR 8GB DS - - 9-10-9-28 15 . . .
(XMP) (2x 4GB)
G.SKILL ~ F3-14900CL9Q-16GBXL 16GB DS - - 9-10-9-28 15
(XMP) (4x 4GB)
G.SKILL  F3-14900CL9Q-16GBZL 16GB_ DS - - 910928 15 . . . .
(XMP) (4x 4GB)
G.SKILL ~ F3-14900CL9Q-8GBFLD 8GB DS - - 9-9-9-24 1.6
(XMP) (2x 4GB)
Patriot  PXD34G1866ELK(XMP) 4GB SS - - 9-9-9-24 1.65 . . . .
(2x 2GB)
Patriot ~ PXD38G1866ELK(XMP) 8GB DS - - 9-11-9-27 165 . . . .
(2x 4GB)
Patriot ~ PXD38G1866ELK(XMP) 8GB DS - - 9-9-9-24 1.65 . . . .
(2x 4GB)

Team ;I;z(ﬁg;‘lO%MmGGHCQK-L 4GB DS Hynix H5TC2G83BFRHYA 9-11-9-27 1.65 . . . .

P9X79 LE Motherboard Qualified Vendors Lists (QVL)
DDR3 1800 MHz capability

DIMM socket support
(Optional)

Vendors Part No. sss SMP - chipNO. Timing Voltage PRI
DIMM DIMM DIMM DIMM
G.SKILL  F3-14400CLOD-4GBRL(XMP) 4GB (2x2GB) DS - - 99924 16 ..

P9X79 LE Motherboard Qualified Vendors Lists (QVL)
DDR3 1600 MHz capability

DIMM socket support
) . . _ (Optional)
Size SS/DS Chip Brand Chip NO. Timing  Voltage A 6 3
DIMM DIMM DIMM DIMM
A-DATA  AM2U16BC2P1 2GB SS A-DATA 3CCD-1509A - - . . . .
A-DATA  AM2U16BC4P2 4GB DS A-DATA 3CCD-1509A - - . . . .
A-DATA  AX3U1600GC4G9(XMP) 4GB DS - - - 1.55~1.75 -+
A-DATA  AX3U1600PC4G8(XMP) 4GB DS - - 8-8-8-24 1.55~1.75 - . . .
Asint SLA302G08-EGG1C(XMP) 4GB DS Asint 302G08-GG1C  9-9-9-27 - . . . .
Asint SLA302G08-EGJ1C(XMP) 4GB DS Asint 302G08-GJIC  9-9-9-27 - . . . .
Asint SLZ3128M8-EGJ1D(XMP) 2GB DS Asint 3128M8-GJ1D - - . . .
ATP AQ12_M64B8BKKOS 4G_B DS SA&SUNG K4BZG_08460 - NO . . . .
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P9X79 LE Motherboard Qualified Vendors Lists (QVL)
DDR3 1600 MHz capability (continued)

DIMM socket support

Part No. Chip NO. Timing  Voltage (0"""":') s s
DIMM DIMM DIMM DIMM
CORSAIR  CMG4GX3M2A1600C6 4GB DS - - 6-6-6-18 165 -+ . .
(2x2GB)

CORSAIR  CML16GX3M4X1600C8  16GB DS - - Heat-Sink 1.5 . . . .
(Ver 2.12)(XMP) (4x4GB) Package

CORSAIR  CMP6GX3M3A1600C8  6GB DS - - 8-8-824 165
(XMP) (3x2GB)

CORSAIR  CMP6GX3M3A1600C8  6GB DS - - 88824 165 . .
(XMP) (3x2GB)

CORSAIR  CMX6GX3M3C1600C7  6GB DS - - 7-8720 165 -+ . .
(XMP) (3x2GB)

CORSAIR  CMZ16GX3M4A1600C9  16GB DS - - 9-9-924 15 . . .
(XMP) (4x 4GB)

CORSAIR  CMZ32GX3M4X1600C10  32GB DS - - 10-10- 15 . . . .
(Ver2.2)(XMP) (4x8GB) 10-27

CORSAIR  CMZB8GX3M2A1600C8  8GB DS - - 88824 15 . .
(XMP) (2x4GB)

CORSAIR  CMZB8GX3M2A1600C9  8GB DS - - 9-9-924 15 . . . .
(XMP) (2x4GB)

CORSAIR  CMZB8GX3M4X1600C9  8GB Ss - - 9-9-924 15
(Ver 2.12)(XMP) (4x2GB)

CORSAIR  HX3X12G1600C9 12GB DS - - 9-9-924 1.6 . . .
(XMP) (6x2GB)

Crucial BL12864BN1608.8FF 2GB ss - - 8-8-824 1.65
(XMP) (2x1GB)

Crucial :3LT4()53D1608DT1TXD.16FM 4GB DS - - 88824 15 . . . .
(XMP)

EK Memory EKM324L28BP8-116 4GB DS - - 9 - . .
(XMP) (2x2GB)

EK Memory EKM324L28BP8-116 4GB DS - - 9 -
(XMP) (2 2GB)

Elixir :\II2X2)FBACBBBG7N-DG 2GB SS  Elixir N2CB2GBOGN-DG  9-9-9-28 - . . .
XMP)

Elixir x(ﬁs}emcasHesN-De 4GB DS Elixir N2CB2GBOGN-DG  9-9-9-28 -

G.SKILL ~ F3-12800CL7D-8GBRH  8GB DS - - 7-87-24 1.6 . . . .
(XMP) (2x4GB)

G.SKILL ~ F3-12800CL7Q-16GBXH  16GB DS - - 7-8724 1.6
(XMP) (4x4GB)

G.SKILL ~ F3-12800CL8D-8GBECO  8GB DS - - 88824 135 .
(XMP) (2x4GB)

G.SKILL ~ F3-12800CL9D-8GBRL  8GB DS - - 9-9-924 15
(XMP) (2x4GB)

G.SKILL ~ F3-12800CL9D-8GBSR2 ~ 8GB DS - - 99924 125 - . .
(XMP) (2x4GB)

G.Skill F3-12800CL9Q-16GBZL  16GB DS - - 9-9-924 15 . . . .
(XMP) (4x4GB)

GEIL GET316GB1600C9QC 16GB DS - - 9-9-928 1.6 . . .
(XMP) (4x 4GB)

GEIL GUP34GB1600C7DC 4GB DS - - 7-7-724 1.6 . . .
(XMP) (2x2GB)

GoodRam  GR1600D364L9/2G 2GB DS GoodRam GF1008KC-JN - - . . . .

KINGMAX  FLGESSF-CBKLOA(XMP)  2GB SS  KINGMAX N/A 9-9-9-28 - . . . .

KINGMAX ~ FLGF65F-C8KLIA(XMP) 4GB DS KINGMAX N/A 9-9-9-28 - . .

KINGSTON  KHX1600C9D3K2/4GX 4GB DS - - - 1.65
(XMP) (2x2GB)

KINGSTON  KHX1600C9D3K3/12GX  12GB DS - - 9 165
(XMP) (3x4GB)

KINGSTON  KHX1600C9D3K3/12GX ~ 12GB DS - - - 1.65
(XMP) (3x4GB)

KINGSTON  KHX1600C9D3K3/6GX ~ 6GB DS - - 9 165 ¢ . .
(XMP) (3x2GB)

KINGSTON  KHX1600C9D3K3/6GX  6GB DS - - 9 1.65
(XMP) (3x2GB)

Kingston ~ KHX1600C9D3K8/32GX  32GB DS - - 9-9-927 165 . . .
(XMP) (8x 4GB)

KINGSTON  KHX1600C9D3P1K2/8G ~ 8GB DS - - 9 15 . . .

(2x4GB)

KINGSTON ~ KHX1600C9D3T1BK3/ 12GB DS - - 9 165 ¢
12GX(XMP) (3x4GB)

KINGSTON  KHX1600COD3T1K3/6GX ~ 6GB DS - - 9 165 - . .
(XMP) (3x2GB)

KINGSTON  KHX1600C9D3X2K2/4GX 4GB DS - - 9 165 ¢ . .
(XMP) (2x2GB)

KINGTIGER_KTG2G1600PG3(XMP) _ 2GB DS - - - - . .
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P9X79 LE Motherboard Qualified Vendors Lists (QVL)
DDR3 1600 MHz capability (continued)

DIMM sufket support
Part No. Chip NO. Timing  Voltage _Pt"al

4 6 8
DIMM DIMM DIMM DIMM

Mushkin 996805(XMP) 4GB DS - - 6-8-6-24 1.65 . . .
(2x2GB)

Mushkin 998805(XMP) 6GB DS - - 6-8-6-24 1.65 . . .
(3x2GB)

0CczZ OCZ3BE1600C8LV4GK 4GB DS - - 8-8-8 1.65
(2x2GB)

Patriot AE32G1609U1-U 2GB SS AMD 23EY4587TMB6H - 1.5 .

Patriot AE34G1609U2-U 4GB DS AMD 23EY4587MB6H - 15 . .

Patriot PGD38G1600ELK(XMP)  8GB DS - - 9-9-9-24  1.65
(2x4GB)

Patriot PGS34G1600LLKA 4GB DS - - 7-7-720 1.7 . . .
(2x2GB)

Patriot PGS34G1600LLKA2 4GB DS - - 8-8-8-24 1.7 . . .
(2x2GB)

Patriot PVV38G1600LLK(XMP) 8GB DS - - 8-9-8-24 165 . . . .
(2x4GB)

Patriot PX7312G1600LLK(XMP) ~ 12GB DS - - 8-9-8-24 1.65 . . . .
(3x4GB)

SanMax SMD-4G68HP-16KZ 4GB DS Hynix H5TQ2G83BFRPBC - 15 . . . .

#SanMax SMD-4G68NG-16KK 4GB DS ELPIDA  J2108BDBG-GN-F - - . . . .

Silicon SP002GBLTU160V02 2GB SS S-POWER 20YT5NG 9-11- 15 . . .

Power (XMP) 11-28

Silicon SP004GBLTU160V02 4GB DS S-POWER 20YT5NG 9-9-9-24 15 . .

Power (XMP)

Team TED34096M1600HC11 4GB DS Team T3D2568ET-16 - - .

Team ;I;Z(NI‘DSJ 024M1600C8-D 1GB SS Team T3D1288RT-16 8-8-8-24 1.65

Team TXD3)2048M1 600C7-L 2GB DS Team T3D1288LT-16 7-7-7-24  1.65 .

(XMP,
Team B)((XD’\(;%()J48M1 B600HC8- 2GB DS Team T3D1288RT-16 8-8-8-24 1.65
Team TXD34096M1600HC9- 4GB DS Hynix H5TC2G83BFRHOA 9-9-9-24 1.5 . . . .
D(XMP)

Transcend ~ JM1600KLN-8GK 8GB DS Transcend TK483PCW3 - - . .
(2x4GB)

Transcend ~ TS256MLK64VEN 2GB SS Transcend K4B2G0846C - - . . . .

Transcend _ TS512MLK64V6N 4GB DS __ Transcend K4B2G0846C - - . . . .

P9X79 LE Motherboard Qualified Vendors Lists (QVL)
DDR3 1333 MHz capability

DIMM socket support
ss/ (Optional)
2

Vendors  Part No. Chip Brand Chip NO. Timing Voltage

4 6 8
DIMM DIMM DIMM DIMM

ACTICA ACT1GHU64B8F1333S  1GB  SS SAMSUNG K4B1G0846F - - . . .
ACTICA ACT1GHU72C8G1333S 1GB SS SAMSUNG K4B1G0846F(ECC) - - . . . .
ACTICA ACT2GHU64B8G1333M 2GB DS Micron DOKPT - - . . .
ACTICA ACT2GHU64B8G1333S 2GB DS SAMSUNG K4B1G0846F - - . . . .
ACTICA ACT2GHU72D8G1333M 2GB DS  Micron D9KPT(ECC) - - . . . .
ACTICA ACT2GHU72D8G1333S 2GB DS SAMSUNG K4B1G0846F(ECC) - - . . . .
ACTICA ACT4GHU64B8H1333H 4GB DS  Hynix H5TQ2G83AFR - -
ACTICA ACT4GHU72D8H1333H 4GB DS  Hynix H5TQ2G83AFR(ECC) - - . . . .
A-DATA AD6311B0823EV 2GB SS A-DATA 3CCA-1509A - - . . .
A-DATA AD63I11C1624EV 4GB DS A-DATA 3CCA-1509A - - . . . .
A-DATA AXDU1333GC2G9(XMP) 2GB SS - - 9-9-9-24 1.25~1.35 - . . .
A-DATA SU3U1333W8G9(XMP)  8GB DS ELPIDA J4208BASE-DJ-F - - . . . .
Apacer 78.A1GC6.9L1 2GB DS Apacer AMS5D5808FEQSBG 9 - . . . .
Apacer 78.B1GDE.9L10C 4GB DS  Apacer AM5D5908CEHSBG 9 -
ATP AQ12M72E8BKHIS 4GB DS SAMSUNG K4B2G0846C(ECC) - - . . . .
ATP AQ56M72E8BJHIS 2GB DS SAMSUNG K4B1G0846F(ECC) N N . . .
BUFFALO D3U1333-1G 1GB  SS Elpida J1108BFBG-DJ-F - - . . .
BUFFALO  D3U1333-2G 2GB DS Elpida J1108BFBG-DJ-F -
BUFFAL D3U1333-4 4SEB D§ NANYA NT5CBZ§§M§BN-9§ - . . .
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P9X79 LE Motherboard Qualified Vendors Lists (QVL)
DDR3 1333 MHz capability

DIMM socket support

Optional
Part No. Chip Brand Chip NO. Timing Voltage (Op 4) 5 s
DIMM DIMM DIMM DIMM
ICORSAIR  CMX8GX3M2A1333C9  8GB DS - - 9-9-9-24 15 . .
(XMP) (2x4GB)
CORSAIR  TW3X4G1333C9A 4GB DS - - 9-9-9-24 15 .
(2x2GB)
EK Memory EKM324L28BP8-113 4GB DS - - 9 - N .
(2x2GB)
Elixir M2F2G64CB88B7N-CG  2GB SS Elixir N2CB2G808N-CG - -
Elixir M2F2G64CB88D7N-CG  2GB SS Elixir M2CB2G8BDN-CG - - . . . .
Elixir M2F4G64CB8HB5N-CG 4GB DS Elixir N2CB2G808N-CG - - . . . .
G.SKILL F3-10600CLOD-4GBNT 4GB DS  G.SKILL D3 128M8CE9 2GB 9-9-9-24 15
(2x2GB)
G.SKILL F3-10666CL9D-8GBRL  8GB DS - - 9-9-9-24 15 . .
(2x 4GB)
G.SKILL F3-10666CL9D-8GBRL  8GB DS - - 9-9-9-24 15 . .
(2x4GB)
G.SKILL ~ F3-10666CLOD-8GBXL  8GB DS - - 9.9-9-24 15 . . . .
(2x4GB)
GEIL GB34GB1333C7DC 4GB DS GEIL GL1L128M88BA15FW 7-7-7-24 15 . . . .
(2x2GB)
GEIL GET316GB1333C9QC  16GB Ds - - 9-9-9-24 15
(4x4GB)
GEIL GG34GB1333C9DC 4GB DS GEIL GL1L128M88BA115SFW  9-9-9-24 1.3 . .
(2x2GB)
GEIL GG34GB1333C9DC 4GB DS GEIL GL1L128M88BA15B 9-9-9-24 13 . . .
(2x2GB)
GEIL GVP38GB1333C9DC 8GB Ds - - 9-9-9-24 15
(2x4GB)
GoodRam ~ GR1333D364L9/2G 2GB DS  Qimonda IDSH1G-03A1F1C-13H - - . . .
Hynix HMT125U6TFR8A-H9  2GB DS Hynix H5TC1G83TFR - - . . . .
INNODISK ~ M3UN-2GHJBC09 2GB SS  Hynix H5TQ2G83CFRHIC 9-9-9-24 - . . . .
INNODISK ~ M3UN-4GHJAC09 4GB DS Hynix H5TQ2G83CFRHIC 9-9-9-24 - N . . .
KINGMAX  FLFE85F-B8KL9 2GB DS KINGMAX KFBBFNLXL-BNF-15A - -
KINGMAX ~ FLFE85F-C8KL9 2GB SS  KINGMAX KFC8FNLBF-GXX-12A - - . . . .
KINGMAX  FLFE85F-C8KL9 2GB SS  KINGMAX KFC8FNLXF-DXX-15A - - . . . .
KINGMAX  FLFE85F-C8KM9 2GB SS  Kingmax KFC8FNMXF-BXX-15A - -
KINGMAX  FLFF65F-C8KL9 4GB DS  KINGMAX KFC8FNLBF-GXX-12A - - . . . .
KINGMAX  FLFF65F-C8KL9 4GB DS KINGMAX KFC8FNLXF-DXX-15A - - . . . .
KINGMAX  FLFF65F-C8KM9 4GB DS  Kingmax KFC8FNMXF-BXX-15A - -
KINGSTON ~ KVR1333D3E9S/4G 4GB DS  Elpida J2108ECSE-DJ-F 9 15 . . .
KINGSTON ~ KVR1333D3N9/2G 2GB DS  Kingston D1288JPNDPLD9U 9 15 . . . .
KINGSTON ~ KVR1333D3N9H/8G 8GB DS  ELPIDA J4208EASE-DJ-F 9-9-9-24 15
KINGSTON KVR1333D3N9K2/4G 4GB DS  KINGSTON D1288JEMFPGDOU - 15 . . .
(2x2GB)
KINGSTON ~ KVR1333D3S8N9/2G 2GB SS  Micron IFD77 DOLGK - 15
KINGTIGER F10DA2T1680 2GB DS  KINGTIGER KTG1333PS1208NST-C9 - - . .
KINGTIGER KTG2G1333PG3 2GB DS - - - - M M
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P9X79 LE Motherboard Qualified Vendors Lists (QVL)
DDR3 1333 MHz capability

Vendors

Mach Xtreme

Mach Xtreme
MICRON
0Cz

0CZ

0CZ

Patriot
Patriot
Patriot
Patriot

Patriot

RIiDATA
RIDATA
SAMSUNG
SAMSUNG
SAMSUNG
Silicon Power
Silicon Power
Silicon Power
Silicon Power
Team

Team

Team

Team

Transcend
Transcend
Transcend

Transcend
Transcend

Transcend

Transcend

Transcend

Transcend

Part No.

MXD3U133316GQ

MXD3V13332GS
MTBJTF25664AZ-1G4M1
0CZ3G1333LV4GK

0CZ3G1333LV8GK
(OCZ3RPR1333C9LV8GK

AE32G1339U1-U
AE34G1339U2-U
PG38G1333EL(XMP)
PGD316G1333ELK
(XMP)

PGS34G1333LLKA

C304627CB1AG22Fe
E304459CB1AG32Cf
M378B1G73AH0-CH9
M378B5273CH0-CH9
M378B5673FH0-CHY
SP001GBLTE133S01
SP001GBLTU133502
SP002GBLTE133S01
SP004GBLTU133V02
TED34096M1333HC9
TXD31024M1333C7
(XMP)
TXD31048M1333C7-D
(XMP)

TXD32048M1333C7-D
(XMP)

JM1333KLN-2G
JM1333KLN-4G

JM1333KLN-4G
(583782)

TS1GLK64V3H

TS256MLK64V3N
(585541)

TS256MLK64VIN
(566577)
TS256MLK64VIN
(57421
TS512MLK64V3N
(585538 )

TS512MLK64V3N
(574831)

16GB
(4x4GB)
2GB
2GB

4GB
(2x2GB)

8GB
(2x4GB)

8GB
(2x4GB)

2GB
4GB
8GB
16GB
(2x8GB)
4GB

(2% 2GB)
2GB
4GB
8GB
4GB
2GB

1GB

1GB
2GB
4GB
4GB

1GB

1GB
2GB

2GB
4GB
4GB

8GB
2GB

2GB
2GB
4GB

4GB

S8/
DS
DS

Ss
Ss
DS

DS
DS

Ss
DS
DS
DS

DS

DS
DS
DS
DS
DS
Ss
Ss
DS
DS
DS
Ss

Ss
DS

Ss
DS
DS

DS
Ss

Ss
SS
DS

DS

Chip Brand Chip NO.

Mach Xtreme C2846D30-D313

MICRON

AMD
AMD

RIDATA
RIiDATA
SAMSUNG
SAMSUNG
SAMSUNG
NANYA
S-POWER
NANYA
S-POWER
Team
Team

Team
Team

Transcend
Transcend
Transcend

MICRON
Micron

Hynix
Micron
Micron

Micron

D9PFJ

23EY4587MB3H
23EY4587MB3H

C304627CB1AG22Fe
E304459CB1AG32Cf
K4B4G0846A-HCH9
K4B2G0846C
K4B1G0846F
NT5CB128M8AN-CG
10YT3ES
NT5CB128M8AN-CG
20YT3NG
T3D2568LT-13
T3D1288LT-13

T3D1288LT-13

T3D1288LT-13

TK483PCW3
TK483PCW3
TK483PCW3

D9PBC
ICD77 DOLGK

H5TQ2G83BFR

DILGK

IED27 DILGK

DILGK

Timing

7-7-7-20

© ©

K4B2G0846C

9-9-9-24

7-7-7-21

7-7-7-21

7-7-7-21

Voltage

1.65
1.65
1.65

15
15
15
15

175
1.75

15-16

DIMM socket support
(Optional)

DIMM

4
DIMM

6
DIMM

ASUS P9X79 LE
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R For each DRAM channel (A,B,C,D), make sure to install the DRAM module to blue slot first.

+ 1 DIMM: Supports one (1) module inserted into any blue slot as Single-channel
memory configuration. Install the module into the D1 slot for better
compatibility.

2 DIMMs: Supports two (2) modules inserted into one pair of blue slots as one pair of
Dual-channel memory configuration. Install the modules into slots B1 and
D1 for better compatibility.

4 DIMMs: Supports four (4) modules inserted into four blue slots as two pairs of
Quad-channel memory configuration. Install the modules into slots A1/B1/
C1/D1 for better compatibility.

6 DIMMs: Supports four (6) modules inserted into four blue slots and one pair of black
slots as three pairs of Quad-channel memory configurations. Install the
modules into slots A1/B1/B2/C1/D1/D2 for better compatibility.

+ 8DIMMs: Supports four (8) modules inserted into all the slots as fully-loaded
Quad-channel memory configurations.

R + Wheninstalling total memory of 4GB capacity or more, Windows 32-bit operation system
may only recognize less than 3GB. Hence, a total installed memory of less than 3GB is
recommended.

+  The default DIMM frequency depends on its Serial Presence Detect (SPD), which is
the standard way of accessing information from a memory module. Under the default
state, some memory modules for overclocking may operate at a lower frequency than
the vendor-marked value

R +  ASUS exclusively provides hyper DIMM support function.
Hyper DIMM support is subject to the physical characteristics of individual CPUs. Load
the X.M.P. or D.O.C.P. settings in the BIOS for the hyper DIMM support.

Visit the ASUS website for the latest QVL.
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224 Expansion slots

/ Ensure to unplug the power cord before adding or removing expansion cards. Failure to do
\ S0 may cause you physical injury and damage motherboard components.

TR
O O
[H
O
i
i
H
o o=
eﬁ P9X79 LE @
foma
&F«E’—H =gl
e =]
W Em O
O S [ EEET e

Slot No. Slot Description

PCle 3.0 x16_1 slot (single at x16; dual at x16/x16; triple at x16/x16/x8 mode)
PCle 2.0 x1_1 slot

PCle 2.0 x1_2 slot

PCle 3.0 x16_2 slot (single at x16; dual at x16/x16; triple at x16/x16/x8 mode)
PCl slot 1

PCle 3.0 x16_3 slot (at x8 mode)

o OB W NN =

PCI Express operating mode

VGA configuration

x16 (Recommend for
single VGA)

Dual VGA/PCle card x16 | x16

Single VGA/PCle card | N/A

Triple VGA/PCle card [R3[d] x16 x8

ASUS P9X79 LE 2-15



R + Insingle VGA card mode, use the PCle 3.0 x16_1 slot (blue) for a PCI Express x16
graphics card to get better performance.

+  InCrossFireX™ or SLI™ mode, use the PCle 3.0 x16_1 and PCle 3.0 x16_2 slots for
PCI Express x16 graphics cards to get better performance.

We recommend that you provide sufficient power when running CrossFireX™ or SLI™
mode. Refer to page 2-29 for details.

In 3-way SLI mode, use the PCle 3.0 x16_1 and PCle 3.0 x16_2 and PCle 3.0 x16_3
slots for PCI Express x16 graphics cards to get better performance.

+ Connect a chassis fan to the motherboard connector labeled CHA_FAN1/2/3/4 when
using multiple graphics cards for better thermal environment. See page 2-27 for details.

IRQ assignments for this motherboard
A B C D E F G H
PCIEX16_1 shared - - - - - — _
PCIEX16_2 shared - - - - - - -
PCIEX16_3 shared - - - - - - -
PCIEX1_1 shared - - - - - - -
PCIEX1_2 - - — shared - - - -
PCl slot shared - - - - - - -
USB 3.0 #1 - - — shared - - - -
USB 3.0 #2 - — shared - - - - -
e-SATA shared - - - - - - -
On Chip USB1 - - - - - - -  shared
On Chip USB2 - - - - - - -  shared
HD Audio - - - - - — shared -
On Chip SATA - - -
LAN shared

|
(2]
>
Q
=
@D
o

|
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2.2.5 Onboard buttons and switches

Onboard switches allow you to fine-tune performance when working on a bare or open-
case system. This is ideal for overclockers and gamers who continually change settings to
enhance system performance.

1. MemOK! switch

Installing DIMMs that are incompatible with the motherboard may cause system
boot failure, and the DRAM_LED near the MemOK! switch lights continuously. Press
and hold the MemOK! switch until the DRAM_LED starts blinking to begin automatic
memory compatibility tuning for successful boot.

:
I
= .00 1

—]

M@ C"® ] COC] o

mn o

P9X79 LE MemOK! button

W

ASUS P9X79 LE

Refer to section 2.2.6 Onboard LEDs for the exact location of the DRAM_LED.

The DRAM_LED also lights when the DIMM is not properly installed. Turn off the
system and reinstall the DIMM before using the MemOK! function.

The MemOK! switch does not function under Windows™ OS environment.

During the tuning process, the system loads and tests failsafe memory settings. It
takes about 30 seconds for the system to test one set of failsafe settings. If the test
fails, the system reboots and test the next set of failsafe settings. The blinking speed
of the DRAM_LED increases, indicating different test processes.

Due to memory tuning requirement, the system automatically reboots when each
timing set is tested. If the installed DIMMs still fail to boot after the whole tuning
process, the DRAM_LED lights continuously. Replace the DIMMs with ones
recommended in the Memory QVL (Qualified Vendors Lists) in this user manual or on
the ASUS website at www.asus.com.

If you turn off the computer and replace DIMMs during the tuning process, the system
continues memory tuning after turning on the computer. To stop memory tuning, turn
off the computer and unplug the power cord for about 5-10 seconds.

If your system fail to boot due to BIOS overclocking, press the MemOK! switch to boot
and load BIOS default settings. A messgae will appear during POST reminding you
that the BIOS has been restored to its default settings.

We recommend that you download and update to the latest BIOS version from the
ASUS website at www.asus.com after using the MemOK! function.
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2.  DirectKey button

This feature allows your system to go to the BIOS Setup program with the press of
a button. With DirectKey, you can enter the BIOS anytime without having to press
the <Del> key during POST. It also allows you to turn on or turn off your system and
conveniently enter the BIOS during boot-up.

DirectKey

—————
T N

P9X79 LE DirectKey button

Ensure to save your data before using the DirectKey button.

[ )

4& + When the system is on and you press the DirectKey button, your system will shut
down. Press the DirectKey button again or the Power-on button to reboot and enter
the BIOS directly.

+ Turn off your system using the power-on button to allow your system to go through
POST (without entering the BIOS) when you reboot your system.

Refer to section 3.7 Boot Menu for details about setting the DirectKey default
function.
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3. BIOS Flashback switch

USB BIOS Flashback allows you to easily update the BIOS without entering the
BIOS or operating system. Just connect the USB storage device containing the BIOS
file to the USB port, press the BIOS Flashback switch, and the BIOS is updated
automatically.

BIOS_FLBK

= =

POX79 LE BIOS_FLBK button

R Refer to section 2.3.10 USB BIOS Flashback for more information about BIOS_FLBK
switch.

2.2.6 Onboard LEDs

1.  Standby Power LED
The Standby Power LED will light up once the system is connected to a power source.

SB_PWR

€

ON OFF
Standy Power  Powered Off

P9X79 LE Onboard LED
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2. Q-LEDs

These ID LEDs of CPU, DRAM, VGA card, and HDD indicate key component status
during POST (Power-on Self Test), providing an elegant embellishment to the
motherboard design. The LED lights will flash sequentially during system bootup. If an
error is found, the LED next to the error device will continue lighting until the problem is
solved. This user-friendly design provides an intuitional way to locate the root problem
within a second.

CPU_LED

)—>BOOT_DEVICE_LED
VGA_LED

P9X79 LE CPU/ DRANW/
BOOT_DEVICE/ VGA LED

3. FLBKLED
The FLBK LED lights up when the USB Flashback switch is pressed for three seconds.

— FLBK_LED

P9X79 LE FLBK_LED
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2.2.7 Jumper

1. Clear RTC RAM (3-pin CLRTC)

This jumper allows you to clear the Real Time Clock (RTC) RAM in CMOS. You can
clear the CMOS memory of date, time, and system setup parameters by erasing
the CMOS RTC RAM data. The onboard button cell battery powers the RAM data in
CMOS, which include system setup information such as system passwords.

CLRTC
12 2 3
(= = CIREE] = =]
J— Normal Clear RTC
- (Default)

P9X79 LE Clear RTC RAM

To erase the RTC RAM:

1. Turn OFF the computer and unplug the power cord.

2. Move the jumper cap from pins 1-2 (default) to pins 2-3. Keep the cap on pins 2-3 for
about 5-10 seconds, then move the cap back to pins 1-2.
Plug the power cord and turn ON the computer.

Hold down the <Del> key during the boot process and enter BIOS setup to re-enter
data.

’ Except when clearing the RTC RAM, never remove the cap on CLRTC jumper default
H position. Removing the cap will cause system boot failure!

/ +  Ifthe steps above do not help, remove the onboard battery and move the jumper
again to clear the CMOS RTC RAM data. After the CMOS clearance, reinstall the
battery.

You do not need to clear the RTC when the system hangs due to overclocking. For
system failure due to overclocking, use the C.P.R. (CPU Parameter Recall) feature.
Shut down and reboot the system so the BIOS can automatically reset parameter
settings to default values.

Due to the chipset behavior, AC power off is required to enable C.P.R. function. You
must turn off and on the power supply or unplug and plug the power cord before
rebooting the system.
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2.2.8 Internal connectors

1. Intel® Serial ATA 6.0 Gb/s connectors (7-pin SATA6G_1/2 [gray])
These connectors connect to Serial ATA 6.0 Gb/s hard disk drives via Serial ATA 6.0
Gbl/s signal cables.
If you installed Serial ATA hard disk drives, you can create a RAID 0, 1, 5, and 10
configuration with the Intel® Rapid Storage Technology through the onboard Intel® X79
chipset.

RSATA_RXN1
RSATA_RXP1
RSATA_TXN1
RSATA_TXP1
GND
GND
RSATA_RXN2
RSATA_RXP2
GND
RSATA_TXN2
RSATA_TXP2

I
I

SATA6G_1 SATA6G_2

P9X79 LE Intel® SATA 6.0 Gb/s connectors

S~

right-angle side  NOTE: Connect the right-angle side of
SATA signal cable to SATA device.

You may also connect the right-angle
¢ side of SATA cable to the onboard SATA
% port to avoid mechanical conflict with

huge graphics cards.
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2. Intel® X79 Serial ATA 3.0 Gb/s connectors (7-pin SATA3G_3-6 [blue])

These connectors connect to Serial ATA 3.0 Gb/s hard disk drives and optical disc
drives via Serial ATA 3.0 Gb/s signal cables.

If you installed Serial ATA hard disk drives, you can create a RAID 0, 1, 5, and 10
configuration with the Intel® Rapid Storage Technology through the onboard Intel® X79
chipset.

SATA3G_3 SATA3G_4

RSATA_RXNS
RSATA_RXP3
RSATA_TXN3
RSATA_TXP3
RSATA_RXN4
RSATA_RXP4
RSATA_TXNA
RSATA_TXP4

GND
GND
GND
GND
GND

I
I

RSATA_RXNS
RSATA_RXPS
RSATA_TXNS
RSATA_TXP5

SATA3G_5 SATA3G_6

P9X79 LE Intel® SATA 3.0 Gb/s connectors

R +  These connectors are set to [AHCI Mode] by default. If you intend to create a Serial
ATA RAID set using these connectors, set the SATA Mode item in the BIOS to [RAID
Mode]. Refer to section 3.5.4 SATA Configuration for details.

Before creating a RAID set, refer to section 4.4 RAID configurations or the manual
bundled in the motherboard support DVD.

+ When using NCQ, set the SATA Mode in the BIOS to [AHCI Mode]. Refer to section
3.5.4 SATA Configuration for details.

You must install Windows® XP Service Pack 3 or later versions before using Serial
ATA hard disk drives. The Serial ATA RAID feature is available only if you are using
Windows® XP SP3 or later versions.

% IRST driver note for OS installation
+  Windows XP:

32 bit: Intel IRST driver for X79 platform will NOT support Windows XP 32 bit. Please
set to [IDE Mode] for OS installation.

64 bit: When [SATA Mode] is set to [AHCI Mode][RAID Mode], it is necessary to load
IRST Driver from driver disk during OS Windows XP 64 bit installation for the system
to detect the storage devices. For details, please refer to the section "4.5 Create a
RAID driver disk".

Windows 7 & Vista:

When [SATA Mode] is set to [RAID Mode], you must load IRST Driver during Windows
7 or Vista installation for the system to detect the Optical Disk Drive (the ODD should
be connected to the Intel SATA ports), or else the ODD will not run. We strongly
recommend you save the IRST Driver from SCD to the USB Flash Drive before OS
installation.
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USB 2.0 connectors (10-1 pin USB910; USB1112; USB1314)

These connectors are for USB 2.0 ports. Connect the USB module cable to any of
these connectors, then install the module to a slot opening at the back of the system
chassis. These USB connectors comply with USB 2.0 specification that supports up to
480 Mbps connection

speed.

&3 ad +3
3Ea BEa 3ia
daoo & o o domo
28352 EEES 28352

PIN 1 ‘T PIN 1 L PIN 1 T
3832 52 3949
mm\m‘o mﬂ-‘n.‘w 50.‘50
= —— 333 EF P o
== ElS 322
P9X79 LE USB2.0 connectors
’ Never connect a 1394 cable to the USB connectors. Doing so will damage the motherboard!

front panel USB

ports.

The USB 2.0 module is purchased separately.

You can connect the front panel USB cable to the ASUS Q-Connector (USB, blue) first, and
then install the Q-Connector (USB) to the USB connector onboard if your chassis supports
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4.  USB 3.0 connector (20-1 pin USB3_34)
This connector is for the additional USB 3.0 ports, and complies with the USB 3.0
specificaton that supports up to 480 MBps connection speed. If the USB 3.0 front panel
cable is available from your system chassis, with this USB 3.0 connector, you can have
a front panel USB 3.0 solution.
— - Fvus
e E IntA_P2, s;:‘;: }:::'::'222?;
[ IntA P2 SSRX+ GND
[ 2@ ot s e
——[] A A P1_D-
o = w o AT D A
i) ) 1 0] o
P9X79 LE USB3.0 connector
R Due to Intel® limitations, USB3_34connector ports run at USB 3.0 speed rate under
Windows® 7 or later versions.

% The USB 3.0 module is purchased separately.

5.  TPM connector (20-1 pin TPM)

This connector supports a Trusted Platform Module (TPM) system, which can securely
store keys, digital certificates, passwords, and data. A TPM system also helps enhance

network security, protects digital identities, and ensures platform integrity.

[

—— -
m® 1 ® 1] @—)
P9X79 LE TPM connector

mn_o

ASUS P9X79 LE

q
I
s TPM

SB_SUS_SATA
GND

+3VSB
SMBSCL
LADO
+3V
LAD3
PCIRST#
FRAME
PCICLK

PIN1

I

RESET
GPIO
SERIRQ
SMBSDA
GND
LAD1
LAD2
PWROWN
GND
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6.  Serial port connector (10-1 pin COM1)

This connector is for a serial (COM) port. Connect the serial port module cable to this
connector, then install the module to a slot opening at the back of the system chassis.

COM1 %?i%%

—>
nector

O_RXD1
O_DTR1
0O_DSR1
0O_CTs1

GND—=
O_RTS1

0_DCD1
O_TXD1
O_RI1

7.  Digital audio connector (4-1 pin SPDIF_OUT)

This connector is for an additional Sony/Philips Digital Interface (S/PDIF) port(s).
Connect the S/PDIF Out module cable to this connector, then install the module to a
slot opening at the back of the system chassis.

SPDIF_OUT
' =
[} E 8 c:
L
a

e

mm O
&e CTw C3 Cor ] o

P9X79 LE Digital audio connector

% The S/PDIF module is purchased separately.
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8. CPU, CPU OPT, Chassis fan connectors
(4-pin CPU_FAN; 4-pin CPU_OPT; 4-pin CHA_FAN1/2/3/4)

Connect the fan cables to the fan connectors on the motherboard, ensuring that the
black wire of each cable matches the ground pin of the connector.

9 @O CPU_OPT © CHA_FAN3 @ CPU_FAN

+5V
CHAFAN IN
CHAFAN F'WR

H
H

CPU FAN PWM
CPU FAN IN
CPU FAN PWR
GND

CPU FAN PWM
CPU FAN IN
CPU FAN PWR
GND

. @ ©CHAFAN4 @CHAFANT @ CHA FAN2
+5V +5V
| |
0 20 H CHi“;:m% CHi“;:\mg
GND GND

[m}
—»

P9X79 LE Fan conectors

CPU FAN PWR
CPU FAN IN

GND
+5V

i

' Do not forget to connect the fan cables to the fan connectors. Insufficient air flow inside the
o | system may damage the motherboard components. These are not jumpers! Do not place
jumper caps on the fan connectors!

/ + The CPU_FAN connector supports the CPU fan of maximum 1A (12 W) fan power.

- + Only the CPU_FAN and CHA_FAN1/2/3/4 connectors support the ASUS Fan Xpert+
feature.

If you install two VGA cards, we recommend that you plug the rear chassis fan cable
to the motherboard connector labeled CHA_FAN1 or CHA_FAN2 for better thermal
environment.
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9.  Front panel audio connector (10-1 pin AAFP)

This connector is for a chassis-mounted front panel audio I/O module that supports
either HD Audio or legacy AC'97 audio standard. Connect one end of the front panel
audio I/0 module cable to this connector.

PRESENCE#
SENSE1_RETUR
SENSE2_RETUR

AGND
NC
NC

C

>
>
M
o
%N

GND

PINY PIN 1

PORT1L
PORT1R
PORT2R
ENSE_SEND
PORT2L
Mic2
MICPWR
Line out_R
NC

Line out_L

7]
HD-audio-compliant Legacy AC'97
—> pin definition compliant definition

P9X79 LE Analog front panel connector

R + We recommend that you connect a high-definition front panel audio module to this
connector to avail of the motherboard’s high-definition audio capability.

+  If you want to connect a high-definition front panel audio module to this connector, set
the Front Panel Type item in the BIOS setup to [HD]; if you want to connect an AC'97
front panel audio module to this connector, set the item to [AC97]. By default, this
connector is set to [HD].

10. Direct Connector (2-pin DRCT)

This connector is for the chassis-mounted button that supports the DirectKey function.
Connect the button cable that supports DirectKey, from the chassis to this connector on
the motherboard.

P9X79 LE DRCT connector

4& Ensure that your chassis comes with the button cable that supports the DirectKey feature.
Refer to the technical documentation that came with the chassis for details.
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11.  ATX power connectors (24-pin EATXPWR; 8-pin EATX12V)

These connectors are for ATX power supply plugs. The power supply plugs are
designed to fit these connectors in only one orientation. Find the proper orientation and
push down firmly until the connectors completely fit.

OEATX12V  @EATXPWR
00O
N +3 Volts GND
J33A +12 Volts +5 Volts
TEE Y +12 Volts +5 Volts
+5V Standby +5 Volts
Power OK -5 Volts
Sana ™ +5Volts GND
zZ2zzz GND GND
©ooo +5 Volts PSON#
GND GND
+3 Volts -12 Volts
+3 Volts +3 Volts

PIN T

P9X79 LE ATX power connectors

AN

ASUS P9X79 LE

For a fully configured system, we recommend that you use a power supply unit
(PSU) that complies with ATX 12 V Specification 2.0 (or later version) and provides a
minimum power of 450 W.

Do not forget to connect the 4-pin/8-pin EATX12 V power plug; otherwise, the system
will not boot.

Use of a PSU with a higher power output is recommended when configuring a system
with more power-consuming devices. The system may become unstable or may not
boot up if the power is inadequate.

If you want to use two or more high-end PCI Express x16 cards, use a PSU with
1000W power or above to ensure the system stability.

If you are uncertain about the minimum power supply requirement for your system,
refer to the Recommended Power Supply Wattage Calculator at http:/support.asus.
com/PowerSupplyCalculator/PSCalculator.aspx?SLanguage=en-us for details.
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12. System panel connector (20-8 pin PANEL)

This connector supports several chassis-mounted functions.

System power LED (2-pin PLED)
This 2-pin connector is for the system power LED. Connect the chassis power LED
cable to this connector. The system power LED lights up when you turn on the system
power, and blinks when the system is in sleep mode.

. Hard disk drive activity LED (2-pin IDE_LED)
This 2-pin connector is for the HDD Activity LED. Connect the HDD Activity LED cable
to this connector. The IDE LED lights up or flashes when data is read from or written to
the HDD.
System warning speaker (4-pin SPEAKER)
This 4-pin connector is for the chassis-mounted system warning speaker. The speaker
allows you to hear system beeps and warnings.
ATX power button/soft-off button (2-pin PWRSW)

This connector is for the system power button. Pressing the power button turns the
system on or puts the system in sleep or soft-off mode depending on the BIOS settings.
Pressing the power switch for more than four seconds while the system is ON turns the
system OFF.

Reset button (2-pin RESET)

This 2-pin connector is for the chassis-mounted reset button for system reboot without
turning off the system power.
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2.3 Building your computer system

2.3.1 Additional tools and components to build a PC system

1 bag of screws

Philips (cross) screwdriver

PC chassis

Power supply unit

L

\ "

e
\\\H Il

GO
o

Intel LGA 2011 CPU

Intel LGA 2011 compatible CPU Fan

SATA optical disc drive (optional)

Graphics card (optional)

% The tools and components in the table above are not included in the motherboard package.
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2.3.2 CPU installation

Please note the order in opening/ closing the double latch. Follow the instructions printed
on the metal sealing hatch or the illustrations shown below in this manual. The plastic cap
will pop up automatically once the CPU is in place and the hatch properly sealed down.

2-32 Chapter 2: Hardware information



ASUS P9X79 LE

2-33



2-34

2.3.3 CPU heatsink and fan assembly installation

Apply the Thermal Interface Material
to the CPU heatsink and CPU
before you install the heatsink and
fan if necessary.
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23.4 DIMM installation




2.3.5 Motherboard installation

models, but the installation steps remain the same.

/ The diagrams in this section are for reference only. The motherboard layout may vary with
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' DO NOT overtighten the screws! Doing so can damage the motherboard.

ASUS P9X79 LE
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2.3.6 ATX Power connection
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2.3.7 SATA device connection
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2.3.8 Front I/0 Connector

To install ASUS Q-Connector

—~——

POWER SW

7 |RESET sw

PWR

Ground
Reset
Ground

To install USB 2.0 Connector To install front panel audio connector

L

To install USB 3.0 Connector
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23.9 Expansion Card installation

To install PCle x16 cards
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23.10 USB BIOS Flashback

USB BIOS Flashback allows you to easily update the BIOS without entering the BIOS or
operating system. Just connect the USB storage device containing the BIOS file to the USB
port, press the BIOS Flashback button, and the BIOS is updated automatically.

BIOS_FLBK

_. [9]

P9X79 LE BIOS_FLBK button

1. Download the BIOS CAP file from the ASUS website at www.asus.com and save it to
the root directory of your USB flash drive. Rename the CAP file to POX79LE.CAP

Connect the USB flash drive to the bottom USB12 port at the rear panel.

Press the USB Flashback button for three seconds until the FLBK_LED flashes. The
FLBK_LED goes out when the BIOS update is completed.

' 1. Do not disconnect the USB flash drive or power system, or move the CLRTC jumper
M during the BIOS updating process. Doing so will interrupt the BIOS updating process.
In case of interruption, follow the steps again to update the BIOS.

2. If FLBK_LED flashes for five seconds and turns into a stable light, this indicates
that USB BIOS Flashback is not working properly due to improper USB flash drive
connection, BIOS file name error, or incompatible BIOS file format. If this happens,
restart the syetem.

3. BIOS updating poses some risks. If the BIOS program is damaged during the updating
process and the system fails to reboot, please contact your local ASUS Service Center
for assistance
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2.3.11 Rear panel connection

Rear panel connectors

1. PS/2 mouse port 7. Optical S/PDIF Out port
2. USB 2.0 ports 5 and 6 8. External SATA port

3. USB 2.0 ports 3 and 4 9. External SATA port

4. LAN (RJ-45) port* 10. USB 2.0 ports 1 and 2
5. PS/2 keyboard port 11. USB 3.0 ports 1 and 2
6. USB 2.0 ports 7 and 8 12. Audio /O ports**

* and **: Refer to the tables on the next page for LAN port LED and audio port definitions.
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Use Clear RTC RAM jumper to clear CMOS switch to clear BIOS setup information
only when the system hangs due to overclocking.

+ DO NOT insert a different connector to the external SATA port.

DO NOT connect a keyboard/mouse to any USB3.0 port when installing Windows
operating system.

Due to USB 3.0 controller limitation, USB 3.0 devices can only be used under
Windows® OS environment and after the USB 3.0 driver installation.
+ USB 3.0 devices can only be used as data storage only.

+ We strongly recommend that you connect USB 3.0 devices to USB 3.0 ports for faster
and better performance for your USB 3.0 devices.

If you want to use the hot-plug function of the external SATA ports, you have to set the
ASMedia® 1061 SATA controllers item in the BIOS setting to [AHCI Mode] and install
the ASMedia® SATA Controller Driver from the motherboard support DVD. Refer to
section 3.5.6 Onboard Devices Configuration for details.

*LAN ports LED indications

Speed LED ACT/LINK SPEED
LED  LED
| |
OFF | No link | OFF | 10 Mbps connection & &
ORANGE | Linked | ORANGE | 100 Mbps connection ﬂ
BLINKING | Dataactivity | GREEN | 1 Gbps connection LAN port

** Audio 2, 4, 6, or 8-channel configuration

Headset 8-channel
2-channel
Light Blue [Line In Line In Line In Line In
Lime Line Out Front Speaker Out  |Front Speaker Out  |Front Speaker Out
Pink Mic In Mic In Mic In Mic In
Orange - - Center/Subwoofer  |Center/Subwoofer
Black - Rear Speaker Out |Rear Speaker Out  |Rear Speaker Out
Gray - — — Side Speaker Out
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2.3.12 Audio I/0 connections

Audio I/O ports
0 light blue
black @ time

IIE
0
ol®

@ © gray o O pink

(Il _TT}

Connect to Stereo Speakers

@ =mJm .7@
'::/SI'OS_J ‘E} =
' ©e®
© ©
© ©
[ [
Connect to 2.1 channel Speakers
® =mJm ‘7@
'::/‘.m_J ‘E} = BN
' ©e®

3
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Connect to 4.1 channel Speakers

P,
.Nms o

[T ] 0= MBI ®®
u\,‘"’_‘) M )= | @ @ |

@
EE

Connect to 5.1 channel Speakers

IS ==
IS ==

AUDIO  AUDIO  AUDIO
INPUTS INPUTS INPUTS

(ONONO)

Rear  Front Center
Subwoofer

coo

v
e E=3 [
®| lo)
() ()

Connect to 7.1 channel Speakers
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2.4
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2.5

Starting up for the first time

After making all the connections, replace the system case cover.

Be sure that all switches are off.

Connect the power cord to the power connector at the back of the system chassis.
Connect the power cord to a power outlet that is equipped with a surge protector.
Turn on the devices in the following order:

a.  Monitor

b.  External SCSI devices (starting with the last device on the chain)

c.  System power

After applying power, the system power LED on the system front panel case lights up.
For systems with ATX power supplies, the system LED lights up when you press the
ATX power button. If your monitor complies with the “green” standards or if it has a
“power standby” feature, the monitor LED may light up or change from orange to green
after the system LED turns on.

The system then runs the power-on self tests or POST. While the tests are running, the
BIOS beeps (refer to the BIOS beep codes table below) or additional messages appear
on the screen. If you do not see anything within 30 seconds from the time you turned
on the power, the system may have failed a power-on test. Check the jumper settings
and connections or call your retailer for assistance.

BIOS Beep Description

One short beep VGA detected
Quick boot set to disabled
No keyboard detected
One continuous beep followed by two No memory detected

short beeps then a pause (repeated)
One continuous beep followed by three | No VGA detected
short beeps

One continuous beep followed by four Hardware component failure
short beeps

At power on, hold down the <Delete> key to enter the BIOS Setup. Follow the
instructions in Chapter 3.

Turning off the computer

While the system is ON, pressing the power switch for less than four seconds puts the
system on sleep mode or soft-off mode, depending on the BIOS setting. Pressing the power
switch for more than four seconds lets the system enter the soft-off mode regardless of the
BIOS setting.

ASUS P9X79 LE
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3.1 Knowing BIOS

The new ASUS UEFI BIOS is an Unified Extensible Firmware Interface that complies with

UEFI architecture, offering a user-friendly interface that goes beyond traditional keyboard-
only BIOS controls to enable more flexible and convenient mouse input. Users can easily
navigate the new UEFI BIOS with the same smoothness as their operating system. The
term “BIOS” in this user manual refers to “UEFI BIOS” unless otherwise specified.

BIOS (Basic Input and Output System) stores system hardware settings such as storage
device configuration, overclocking settings, advanced power management, and boot device
configuration that are needed for system startup in the motherboard CMOS. In normal
circumstances, the default BIOS settings apply to most conditions to ensure optimum
performance. We recommend that you not change the default BIOS settings except in
the following circumstances:

+  An error message appears on the screen during the system bootup and requests you to
run the BIOS Setup.

+  You have installed a new system component that requires further BIOS settings or
update.

Inappropriate settings of the BIOS may result to instability or failure to boot. We strongly
recommend that you change the BIOS settings only with the help of a trained service
personnel.¢

3.2 BIOS setup program

A BIOS setup program is provided for BIOS item modification. When you start up the
computer, the system provides you with the opportunity to run this program. Press <Del>
during the Power-On Self-Test (POST) to enter the Setup utility. Otherwise, POST continues
with its test routines.

If you wish to enter Setup after POST, press <Ctrl> + <Alt> + <Delete>, or press the reset
button on the system chassis to restart the system. You can also turn the system off and then
turn it back on to restart the system. Do this last option only if the first two failed.

R +  The BIOS setup screens shown in this section are for reference purposes only, and
may not exactly match what you see on your screen.
Ensure that a USB mouse is connected to your motherboard if you want to use the
mouse to control the BIOS setup program.
If the system becomes unstable after changing any BIOS setting, load the default
settings to ensure system compatibility and stability. Select the Load Optimized
Defaults item under the Exit menu. See section 3.9 Exit Menu for details.
If the system fails to boot after changing any BIOS setting, try to clear the CMOS and
reset the motherboard to the default value. See section 2.2.7 Jumper for information
on how to erase the RTC RAM.

The BIOS setup program does not support the bluetooth devices.
The BIOS setup program is designed to make it as easy to use as possible. Being a

menu-driven program, it lets you scroll through the various submenus and select from the
available options using a keyboard or a USB mouse.

The BIOS setup program can be used under two modes: EZ Mode and Advanced Mode.
You can change modes from the Exit menu or from the Exit/Advanced Mode button in the
EZ Mode/Advanced Mode screen.

ASUS P9X79 LE
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3.21 EZ Mode

By default, the EZ Mode screen appears when you enter the BIOS setup program. The EZ
Mode provides you an overview of the basic system information, and allows you to select
the display language, system performance mode and boot device priority. To access the
Advanced Mode, click Exit/Advanced Mode, then select Advanced Mode.

% The default screen for entering the BIOS setup program can be changed. Refer to the
= Setup Mode item in section 3.7 Boot memu for details.

Selects the display language of Clicks to display all fan

the BIOS setup program speeds if available
Displays the CPU/motherboard temperature, Exits the BIOS setup program without saving
CPU/5V/3.3V/12V voltage output, the changes, saves the changes and resets
CPU/CPU_OPT/Chassis fan speed the system, or enters the Advanced Mode

[J Exit/Advanced Mode

l -| 2 ' -l P9KI9 LE English ¥
' |. -' -' BIDS Version : 0211

-— CPU Type : Intel(R) Core(TH) i?-3820 CPU @ 3.60GHz Speed : 3600 Mhz
Friday[02/11/20051 Total Memory : 2048 MB (DDR3 1333MHz)

i # Uoltage
P H CPU_OPT_FAN

Pem—— 1 i 1 1
MB 5 CHA_FAN1 CHA_FAN2
e —— 1 —

Ci

Lili Systen Perfornance

Quiet

Performance Energy Saving
Normal

) Boot Priority

Use the mouse to drag or keyooard to navigate to decide the boot priority.

Shorteut (F3) Advanced Mode (F7) Boot Henu (F8) Default (F5)

Quick switch to frequently
used menus.

Selects the boot device priority Normal mode ASUS Optimal mode

Power Saving mode Loads optimized default

Displays the system properties of the Selec_ts the_bo_ot
selected mode on the right hand side device priority

/ +  The boot device options vary depending on the devices you installed to the system.

~ +  The Boot Menu(F8) button is available only when the boot device is installed to the
system.
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3.2.2 Advanced Mode

The Advanced Mode provides advanced options for experienced end-users to configure
the BIOS settings. The figure below shows an example of the Advanced Mode. Refer to the
following sections for the detailed configurations.

% To access the EZ Mode, click Exit, then select ASUS EZ Mode.

Menu items  Menu bar Configuration fields General help

L 3

Ai Tueaker

Target CPU Turbo-Hode Speed : 3800MHz

Target DRAF Speed : 1333MHz

Ai Overclock Tuner
Turbo Ratio
CPU Clock Gen Filter
Memory Frequency
fAuto
EPU Power Saving Hode Hanual
> 0C Tuner
> DRAM Tining Control
> DIGI+ Power Control

> CPU Performance Settings

CPU UCORE Unltage

Offset Mode Sim
F12: Print Screen

Submenu item Pop-up window Scroll bar Navigation keys

Menu bar
The menu bar on top of the screen has the following main items:

For changing the basic system configuration

Ai Tweaker For changing the overclocking settings

Advanced For changing the advanced system settings

Monitor For displaying the system temperature, power status, and changing the fan settings.
For changing the system boot configuration

For configuring options for special functions

For selecting the exit options and loading default settings
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Menu items
The highlighted item on the menu bar displays the specific items for that menu. For example,
selecting Main shows the Main menu items.

The other items (Ai Tweaker, Advanced, Monitor, Boot, Tool, and Exit) on the menu bar have
their respective menu items.

Back button

This button appears when entering a submenu. Press <Esc> or use the USB mouse to click
this button to return to the previous menu screen.

Submenu items

A greater than sign (>) before each item on any menu screen means that the item has a
submenu. To display the submenu, select the item and press <Enter>.

Pop-up window

Select a menu item and press <Enter> to display a pop-up window with the configuration
options for that item.

Scroll bar

A scroll bar appears on the right side of a menu screen when there are items that do not fit on
the screen. Press the Up/Down arrow keys or <Page Up> / <Page Down> keys to display the
other items on the screen.

Navigation keys

At the bottom right corner of the menu screen are the navigation keys for the BIOS setup
program. Use the navigation keys to select items in the menu and change the settings.
Press <F12> key to capture the BIOS screen and save it to the removeable storage device.
Press <F3> key for BIOS option shortcut.

General help
At the top right corner of the menu screen is a brief description of the selected item.

Configuration fields

These fields show the values for the menu items. If an item is user-configurable, you can
change the value of the field opposite the item. You cannot select an item that is not
user-configurable.

A configurable field is highlighted when selected. To change the value of a field, select it and
press <Enter> to display a list of options.
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3.3 Main menu

The Main menu screen appears when you enter the Advanced Mode of the BIOS Setup
program. The Main menu provides you an overview of the basic system information, and
allows you to set the system date, time, language, and security settings.

System Language L Engl fsh

System Date
System Time

> Security

F12: Print Screen

3.3.1 System Language [English]
Allows you to choose the BIOS language version from the options. Configuration options:
[English] [Francais] [Espafiol] [Deutsch] [Pycekuii] [H ASE | (Bt ] [Frikohi]

3.3.2 System Date [Day xx/xx/xxxx]

Allows you to set the system date.

3.3.3 System Time [xx:xx:xx]

Allows you to set the system time.
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3.3.4  Security

The Security menu items allow you to change the system security settings.

Security >

Adninistrator Password
User Password

+  If you have forgotten your BIOS password, erase the CMOS Real Time Clock (RTC)
RAM to clear the BIOS password. See section 2.2.7 Jumper for information on how to
erase the RTC RAM.

The Administrator or User Password items on top of the screen show the default Not
Installed. After you set a password, these items show Installed.

Administrator Password

If you have set an administrator password, we recommend that you enter the administrator
password for accessing the system. Otherwise, you might be able to see or change only
selected fields in the BIOS setup program.

To set an administrator password:

1. Select the Administrator Password item and press <Enter>.

2. From the Create New Password box, key in a password, then press <Enter>.
3. Confirm the password when prompted.

To change an administrator password:
1. Select the Administrator Password item and press <Enter>.

2. From the Enter Current Password box, key in the current password, then press
<Enter>.

3. From the Create New Password box, key in a new password, then press <Enter>.
4. Confirm the password when prompted.
To clear the administrator password, follow the same steps as in changing an administrator

password, but press <Enter> when prompted to create/confirm the password. After you clear
the password, the Administrator Password item on top of the screen shows Not Installed.
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User Password

If you have set a user password, you must enter the user password for accessing the system.

The User Password item on top of the screen shows the default Not Installed. After you set
a password, this item shows Installed.

To set a user password:

1. Select the User Password item and press <Enter>.

2. From the Create New Password box, key in a password, then press <Enter>.
3. Confirm the password when prompted.

To change a user password:
1. Select the User Password item and press <Enter>.

2. From the Enter Current Password box, key in the current password, then press
<Enter>.

3. From the Create New Password box, key in a new password, then press <Enter>.
4. Confirm the password when prompted.
To clear the user password, follow the same steps as in changing a user password, but press

<Enter> when prompted to create/confirm the password. After you clear the password, the
User Password item on top of the screen shows Not Installed.
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3.4 Ai Tweaker menu

The Ai Tweaker menu items allow you to configure overclocking-related items.

’.\ Be cautious when changing the settings of the Ai Tweaker menu items. Incorrect field
/ v\ values can cause the system to malfunction.

The configuration options for this section vary depending on the CPU and DIMM model you
installed on the motherboard.

[

Ai Tweaker

Target CPU Turbo-Mode Speed : 3800MHz

Target DRAM Speed : 1333MHz

Ai Overclock Tuner
Turbo Ratio

U Clock Gen Filter
Memory Freguency
EPU Pouer Saving Mode
> 0C Tuner

> DRAM Timing Cont:

> DIGI+ Power Control

> CPU Performance Settings

U UCORE Uoltage

Offset Mode Sign
F12: Print Screen

Scroll down to display the following items:

CPU UCORE Dffset Uoltage
CPU UCCSA Uoltage
Offset Mode Sign

CPU UCCSA Dffset Uoltage
DRAM Upltage (CHA. CHB)
DRAM Upltage (CHC. CHD)

CPU PLL Uoltage

UTTCPU Uoltage

PCH 1.5v Uoltage

UITDDR Uoltage (CHA, CHE)
UITDDR Uoltage (CHC, CHD)
DRAM CIRL REF Uoltage on CHA

DRAM DATA REF Uoltage on CHA

HE HEEEEEEEB =
o
g

DRAM CIRL REF Uoltage on CHB
F12: Print Screen
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Scroll down to display the following items:

DRAH DATA REF Uoltage on CHB
DRAM CTRL REF Uoltage on CHC
DRAM DATA REF Uoltage on CHC
DRAM CTRL REF Uoltage on CHD
DRAM DATA REF Uoltage on CHD
DRAM Read REF Uoltage on CHA
DRAM Read REF Uoltage on CHB

DRAM Read REF Uoltage on CHC

DRAM Read REF Uoltage on CHD
CPU Spread Spectrum

PCIE Spread Spectrum
F12: Print Screen

Ai Overclock Tuner [Auto]

Allows you to select the CPU overclocking options to achieve the desired CPU internal
frequency. Select any of these preset overclocking configuration options:

[Auto] Loads the optimal settings for the system.
[Manual] Allows you to individually set overclocking parameters.
[X.M.P] If you install memory modules supporting the eXtreme Memory Profile

(X.M.P.) Technology, choose this item to set the profiles supported by your
memory modules for optimizing the system performance.

/ The following three items appear only when you set the Ai Overclocking Tuner item to
[Manual].

BCLK Frequency [XXX]

Allows you to adjust the CPU and VGA frequency to enhance the system performance.

Use the <+> and <-> keys to adjust the value. You can also key in the desired value
using the numeric keypad. The values range from 80.0MHz to 300.0MHz.

PU Strap [A
Configuration options: [Auto] [100MHz] [125MHz] [166MHz] [250MHz]

ClockGen Full Reset [Enabled]

[Enabled] Enabled for better overclocking.
[Disabled] To skip system shutdown at BCLK frequency adjustment.

ASUS P9X79 LE
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Turbo Ratio [Auto]
Allows you to manually adjust the Trubo CPU ratio.

[Auto] All Turbo ratio are set by Intel CPU default settings

[By ALL Cores (Can Adjust in OS)]  All numbers of active cores will be set to one single
Turbo ratio in OS

[By Per Core (Cannot Adjust in OS)]  All numbers of active cores can be set to an individual
Turbo ratio in BIOS.

CPU Clock Gen Filter [Auto]

Configuration options: [Auto] [Enabled] [Disabled] [10UF]

Memory Frequency [Auto]

Forces a DDRS3 frequency slower than the common tCK detected via SPD.
Configuration options: [Auto] [DDR3-800MHz] [DDR3-1066MHz] [DDR3_1333MHz]
[DDR3-1600MHz] [DDR3-1866MHz] [DDR3_2133MHz] [DDR3_2400MHz] [DDR3_2666MHz]

' Selecting a very high memory frequency may cause the system to become unstable! If this
. happens, revert to the default setting.

EPU Power Saving Mode [Disabled]

Allows you to enable or disable the EPU power saving function.
Configuration options: [Disabled] [Enabled]

EPU Setting [Auto]

This item appears only when you set the EPU Power Saving Mode item to [Enabled.] and
allows you to select the EPU power saving mode.

Configuration options: [Auto] [Light Power Saving Mode] [Medium Power Saving Mode] [Max
Power Saving Mode]

OC Tuner
OC Tuner automatically overclocks the frequency and voltage of CPU and DRAM for
enhancing the system performance. Configuration options: [OK] [Cancel]

DRAM Timing Control

The sub-items in this menu allow you to set the DRAM timing control features. Use the <+>
and <-> keys to adjust the value. To restore the default setting, type [auto] using the keyboard
and press the <Enter> key.

Changing the values in this menu may cause the system to become unstable! If this
happens, revert to the default settings.
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Ai Tueaker
DRAM Timing Control >
CHD
CASk Latency 9
RASE to CASH Delay 9

RASE PRE Time &l

RASE ACT Time 24

COMMAND Mode 1

=
=
=1

RASE to RASH Delay

= B
=
=1
=1

REF Cycle Time

URITE Recovery Time

=
=
=1

READ to PRE Time

FOUR ACT WIN Time

URITE to READ Delay

=
=1
g

Urite Latency

F12: Print Screen

=
g

DRAM RTL (CHA DO RO)

DRAM IO0L (CHA DO RO)
F12: Print Screen
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Scroll down to display the following items:

DRAM RTL (CHA DO R1
DRAM IOL (CHA DO R1)
DRAM RTL (CHA D1 RO
DRAM IOL (CHA D1 RO
DRAM RTL (CHA D1 RD
DRAM TOL (CHA D1 RD

DRAM RTL (CHB DO RO

DRAM TOL (CHB DO RO

DRAM RTL (CHB DO R1

DRAM TOL (CHB DO R1

DRAM RTL (CHB D1 RO

DRAM TOL (CHB D1 RO

DRAM RTL (CHB D1 RD

F12: Print Screen

Scroll down to display the following items:

DRAM TOL (CHB D1 RD

DRAM RTL (CHC DO RO}
DRAM IOL (CHC DO RO)
DRAM RTL (CHC DO R
DRAM IOL (CHC DO R1)
DRAM RTL (CHC D1 RO}
DRAM IOL (CHC D1 R®)
DRAM RTL (CHC D1 RD

DRAM IOL (CHC D1 RD

DRAM RTL (CHD DO RO)
DRAM IOL (CHD DO R)

DRAM RTL (CHD DO R1)

DRAM IOL (CHD DO R1)

F12: Print Screen
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Scroll down to display the following items:

DRAH RIL (CHD D1 RO}
DRAM IOL (CHD D1 RO}
DRAH RTL (CHD D1 R1y
DRAH TOL (CHD D1 R1y

DRAM CLK Period

Enhanced Training (CHAX

Enhanced Training (CHBY

Enhanced Training (CHC)
Enhanced Training (CHD)
MCH Duty Sense (CHAY
MCH Duty Sense (CHBY
MCH Duty Sense (CHCY
MCH Duty Sense (CHD}

F12: Print Screen

Scroll down to display the following items:

Receiver Slew
Transmitter Slew

MCH Recheck

F12: Print Screen

Primary Timings

DRAM CAS# Latency [Auto]

Configuration options: [Auto] [3 DRAM Clock] — [15 DRAM Clock]
DRAM RAS# to CAS# Delay [A

Configuration options: [Auto] [4 DRAM Clock] — [15 DRAM Clock]

DRAM RAS# PRE Time [Auto]
Configuration options: [Auto] [4 DRAM Clock] — [15 DRAM Clock]

DRAM RAS# ACT Time [Auto]
Configuration options: [Auto] [4 DRAM Clock] — [40 DRAM Clock]

DRAM COMMAND Mode [Auto]
Configuration options: [Auto] [1 DRAM Clock] [2 DRAM Clock] [3 DRAM Clock]

Secondary Timings

DRAM RAS# to RAS# Delay [Auto]
Configuration options: [Auto] [4 DRAM Clock] — [7 DRAM Clock]

DRAM REF Cycle Time [Aut
Configuration options: [Auto] [48 DRAM Clock] — [511 DRAM Clock]
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DRAM WRITE Recovery Time [Auto]
Configuration options: [Auto] [5 DRAM Clock] — [31 DRAM Clock]

DRAM READ to PRE Time [Auto]
Configuration options: [Auto] [4 DRAM Clock] — [15 DRAM Clock]

DRAM FOUR ACT WIN Time [Auto]
Configuration options: [Auto] [16 DRAM Clock] — [63 DRAM Clock]

DRAM WRITE to READ Delay [Auto]
Configuration options: [Auto] [4 DRAM Clock] — [15 DRAM Clock]

DRAM WRITE Latency [Auto]
Configuration options: [Auto] [1 DRAM Clock] — [15 DRAM Clock]

Third Timings

tRRDR [Auto]
Configuration options: [Auto] [0 DRAM Clock] — [7 DRAM Clock]

tRRDD [Auto]
Configuration options: [Auto] [0 DRAM Clock] — [7 DRAM Clock]

tWWDR [Auto]
Configuration options: [Auto] [0 DRAM Clock] — [7 DRAM Clock]

tWWDD [Auto]
Configuration options: [Auto] [0 DRAM Clock] — [7 DRAM Clock]

tRWDR [Auto]
Configuration options: [Auto] [0 DRAM Clock] — [15 DRAM Clock]

tRWDD [Auto]
Configuration options: [Auto] [0 DRAM Clock] — [15 DRAM Clock]

tWRDR [Auto]
Configuration options: [Auto] [0 DRAM Clock] — [7 DRAM Clock]

tWRDD [Auto]
Configuration options: [Auto] [0 DRAM Clock] — [7 DRAM Clock]

tRWSR [Auto]
Configuration options: [Auto] [0 DRAM Clock] — [15 DRAM Clock]

tCCD [Auto]
Configuration options: [Auto] [0 DRAM Clock] — [7 DRAM Clock]

Latency Timings

DRAM RTL (CHA DO RO) [Auto]

Configuration options: [Auto] [Advance 14 Clock] [Advance 12 Clock] [Advance 10
Clock] [Advance 8 Clock] [Advance 6 Clock] [Advance 4 Clock] [Advance 2 Clock]
[Normal] [Delay 2 Clock] [Delay 4 Clock] [Delay 6 Clock] [Delay 8 Clock] [Delay 10
Clock] [Delay 12 Clock] [Delay 14 Clock]
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DRAM IOL (CHA D0 R0) [Auto]

Configuration options: [Auto] [Advance 14 Clock] [Advance 13 Clock] [Advance 12
Clock] [Advance 11 Clock] [Advance 10 Clock] [Advance 9 Clock] [Advance 8 Clock]
[Advance 7 Clock] [Advance 6 Clock] [Advance 5 Clock] [Advance 4 Clock] [Advance
3 Clock] [Advance 2 Clock] [Advance 1 Clock] [Normal] [Delay 1 Clock] [Delay 2 Clock]
[Delay 3 Clock] [Delay 4 Clock] [Delay 5 Clock] [Delay 6 Clock] [Delay 7 Clock] [Delay
8 Clock] [Delay 9 Clock] [Delay 10 Clock] [Delay 11 Clock] [Delay 12 Clock] [Delay 13
Clock] [Delay 14 Clock]

DRAM RTL (CHA DO R1) [Auto]

Configuration options: [Auto] [Advance 14 Clock] [Advance 12 Clock] [Advance 10
Clock] [Advance 8 Clock] [Advance 6 Clock] [Advance 4 Clock] [Advance 2 Clock]
[Normal] [Delay 2 Clock] [Delay 4 Clock] [Delay 6 Clock] [Delay 8 Clock] [Delay 10
Clock] [Delay 12 Clock] [Delay 14 Clock]

DRAM IOL (CHA D0 R1) [Auto]

Configuration options: [Auto] [Advance 14 Clock] [Advance 13 Clock] [Advance 12
Clock] [Advance 11 Clock] [Advance 10 Clock] [Advance 9 Clock] [Advance 8 Clock]
[Advance 7 Clock] [Advance 6 Clock] [Advance 5 Clock] [Advance 4 Clock] [Advance
3 Clock] [Advance 2 Clock] [Advance 1 Clock] [Normal] [Delay 1 Clock] [Delay 2 Clock]
[Delay 3 Clock] [Delay 4 Clock] [Delay 5 Clock] [Delay 6 Clock] [Delay 7 Clock] [Delay
8 Clock] [Delay 9 Clock] [Delay 10 Clock] [Delay 11 Clock] [Delay 12 Clock] [Delay 13
Clock] [Delay 14 Clock]

DRAM RTL (CHA D1 R0) [Auto]

Configuration options: [Auto] [Advance 14 Clock] [Advance 12 Clock] [Advance 10
Clock] [Advance 8 Clock] [Advance 6 Clock] [Advance 4 Clock] [Advance 2 Clock]
[Normal] [Delay 2 Clock] [Delay 4 Clock] [Delay 6 Clock] [Delay 8 Clock] [Delay 10
Clock] [Delay 12 Clock] [Delay 14 Clock]

DRAM IOL (CHA D1 R0) [Auto]

[Auto] [Advance 14 Clock] [Advance 13 Clock] [Advance 12 Clock] [Advance 11 Clock]
[Advance 10 Clock] [Advance 9 Clock] [Advance 8 Clock] [Advance 7 Clock] [Advance
6 Clock] [Advance 5 Clock] [Advance 4 Clock] [Advance 3 Clock] [Advance 2 Clock]
[Advance 1 Clock] [Normal] [Delay 1 Clock] [Delay 2 Clock] [Delay 3 Clock] [Delay 4
Clock] [Delay 5 Clock] [Delay 6 Clock] [Delay 7 Clock] [Delay 8 Clock] [Delay 9 Clock]
[Delay 10 Clock] [Delay 11 Clock] [Delay 12 Clock] [Delay 13 Clock] [Delay 14 Clock]

DRAM RTL (CHA D1 R1) [Auto]

Configuration options: [Auto] [Advance 14 Clock] [Advance 12 Clock] [Advance 10
Clock] [Advance 8 Clock] [Advance 6 Clock] [Advance 4 Clock] [Advance 2 Clock]
[Normal] [Delay 2 Clock] [Delay 4 Clock] [Delay 6 Clock] [Delay 8 Clock] [Delay 10
Clock] [Delay 12 Clock] [Delay 14 Clock]

DRAM IOL (CHA D1 R1) [Auto]

[Auto] [Advance 14 Clock] [Advance 13 Clock] [Advance 12 Clock] [Advance 11 Clock]
[Advance 10 Clock] [Advance 9 Clock] [Advance 8 Clock] [Advance 7 Clock] [Advance
6 Clock] [Advance 5 Clock] [Advance 4 Clock] [Advance 3 Clock] [Advance 2 Clock]
[Advance 1 Clock] [Normal] [Delay 1 Clock] [Delay 2 Clock] [Delay 3 Clock] [Delay 4
Clock] [Delay 5 Clock] [Delay 6 Clock] [Delay 7 Clock] [Delay 8 Clock] [Delay 9 Clock]
[Delay 10 Clock] [Delay 11 Clock] [Delay 12 Clock] [Delay 13 Clock] [Delay 14 Clock]
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DRAM RTL (CHB D0 R0) [Auto]

Configuration options: [Auto] [Advance 14 Clock] [Advance 12 Clock] [Advance 10
Clock] [Advance 8 Clock] [Advance 6 Clock] [Advance 4 Clock] [Advance 2 Clock]
[Normal] [Delay 2 Clock] [Delay 4 Clock] [Delay 6 Clock] [Delay 8 Clock] [Delay 10
Clock] [Delay 12 Clock] [Delay 14 Clock]

DRAM IOL (CHB D0 R0) [Auto]

[Auto] [Advance 14 Clock] [Advance 13 Clock] [Advance 12 Clock] [Advance 11 Clock]
[Advance 10 Clock] [Advance 9 Clock] [Advance 8 Clock] [Advance 7 Clock] [Advance
6 Clock] [Advance 5 Clock] [Advance 4 Clock] [Advance 3 Clock] [Advance 2 Clock]
[Advance 1 Clock] [Normal] [Delay 1 Clock] [Delay 2 Clock] [Delay 3 Clock] [Delay 4
Clock] [Delay 5 Clock] [Delay 6 Clock] [Delay 7 Clock] [Delay 8 Clock] [Delay 9 Clock]
[Delay 10 Clock] [Delay 11 Clock] [Delay 12 Clock] [Delay 13 Clock] [Delay 14 Clock]

DRAM RTL (CHB D0 R1) [Auto]

Configuration options: [Auto] [Advance 14 Clock] [Advance 12 Clock] [Advance 10
Clock] [Advance 8 Clock] [Advance 6 Clock] [Advance 4 Clock] [Advance 2 Clock]
[Normal] [Delay 2 Clock] [Delay 4 Clock] [Delay 6 Clock] [Delay 8 Clock] [Delay 10
Clock] [Delay 12 Clock] [Delay 14 Clock]

DRAM IOL (CHB D0 R1) [Auto]

[Auto] [Advance 14 Clock] [Advance 13 Clock] [Advance 12 Clock] [Advance 11 Clock]
[Advance 10 Clock] [Advance 9 Clock] [Advance 8 Clock] [Advance 7 Clock] [Advance
6 Clock] [Advance 5 Clock] [Advance 4 Clock] [Advance 3 Clock] [Advance 2 Clock]
[Advance 1 Clock] [Normal] [Delay 1 Clock] [Delay 2 Clock] [Delay 3 Clock] [Delay 4
Clock] [Delay 5 Clock] [Delay 6 Clock] [Delay 7 Clock] [Delay 8 Clock] [Delay 9 Clock]
[Delay 10 Clock] [Delay 11 Clock] [Delay 12 Clock] [Delay 13 Clock] [Delay 14 Clock]

DRAM RTL (CHB D1 RO) [Auto]

Configuration options: [Auto] [Advance 14 Clock] [Advance 12 Clock] [Advance 10
Clock] [Advance 8 Clock] [Advance 6 Clock] [Advance 4 Clock] [Advance 2 Clock]
[Normal] [Delay 2 Clock] [Delay 4 Clock] [Delay 6 Clock] [Delay 8 Clock] [Delay 10
Clock] [Delay 12 Clock] [Delay 14 Clock]

DRAM IOL (CHB D1 RO) [Auto]

[Auto] [Advance 14 Clock] [Advance 13 Clock] [Advance 12 Clock] [Advance 11 Clock]
[Advance 10 Clock] [Advance 9 Clock] [Advance 8 Clock] [Advance 7 Clock] [Advance
6 Clock] [Advance 5 Clock] [Advance 4 Clock] [Advance 3 Clock] [Advance 2 Clock]
[Advance 1 Clock] [Normal] [Delay 1 Clock] [Delay 2 Clock] [Delay 3 Clock] [Delay 4
Clock] [Delay 5 Clock] [Delay 6 Clock] [Delay 7 Clock] [Delay 8 Clock] [Delay 9 Clock]
[Delay 10 Clock] [Delay 11 Clock] [Delay 12 Clock] [Delay 13 Clock] [Delay 14 Clock]

DRAM RTL (CHB D1 R1) [Auto]

Configuration options: [Auto] [Advance 14 Clock] [Advance 12 Clock] [Advance 10
Clock] [Advance 8 Clock] [Advance 6 Clock] [Advance 4 Clock] [Advance 2 Clock]
[Normal] [Delay 2 Clock] [Delay 4 Clock] [Delay 6 Clock] [Delay 8 Clock] [Delay 10
Clock] [Delay 12 Clock] [Delay 14 Clock]
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DRAM IOL (CHB D1 R1) [Auto]

[Auto] [Advance 14 Clock] [Advance 13 Clock] [Advance 12 Clock] [Advance 11 Clock]
[Advance 10 Clock] [Advance 9 Clock] [Advance 8 Clock] [Advance 7 Clock] [Advance
6 Clock] [Advance 5 Clock] [Advance 4 Clock] [Advance 3 Clock] [Advance 2 Clock]
[Advance 1 Clock] [Normal] [Delay 1 Clock] [Delay 2 Clock] [Delay 3 Clock] [Delay 4
Clock] [Delay 5 Clock] [Delay 6 Clock] [Delay 7 Clock] [Delay 8 Clock] [Delay 9 Clock]
[Delay 10 Clock] [Delay 11 Clock] [Delay 12 Clock] [Delay 13 Clock] [Delay 14 Clock]

DRAM RTL (CHC D0 R0) [Auto]

Configuration options: [Auto] [Advance 14 Clock] [Advance 12 Clock] [Advance 10
Clock] [Advance 8 Clock] [Advance 6 Clock] [Advance 4 Clock] [Advance 2 Clock]
[Normal] [Delay 2 Clock] [Delay 4 Clock] [Delay 6 Clock] [Delay 8 Clock] [Delay 10
Clock] [Delay 12 Clock] [Delay 14 Clock]

DRAM IOL (CHC D0 RO) [Auto]

[Auto] [Advance 14 Clock] [Advance 13 Clock] [Advance 12 Clock] [Advance 11 Clock]
[Advance 10 Clock] [Advance 9 Clock] [Advance 8 Clock] [Advance 7 Clock] [Advance
6 Clock] [Advance 5 Clock] [Advance 4 Clock] [Advance 3 Clock] [Advance 2 Clock]
[Advance 1 Clock] [Normal] [Delay 1 Clock] [Delay 2 Clock] [Delay 3 Clock] [Delay 4
Clock] [Delay 5 Clock] [Delay 6 Clock] [Delay 7 Clock] [Delay 8 Clock] [Delay 9 Clock]
[Delay 10 Clock] [Delay 11 Clock] [Delay 12 Clock] [Delay 13 Clock] [Delay 14 Clock]

DRAM RTL (CHC D0 R1) [Auto]

Configuration options: [Auto] [Advance 14 Clock] [Advance 12 Clock] [Advance 10
Clock] [Advance 8 Clock] [Advance 6 Clock] [Advance 4 Clock] [Advance 2 Clock]
[Normal] [Delay 2 Clock] [Delay 4 Clock] [Delay 6 Clock] [Delay 8 Clock] [Delay 10
Clock] [Delay 12 Clock] [Delay 14 Clock]

DRAM IOL (CHC D0 R1) [Auto]

[Auto] [Advance 14 Clock] [Advance 13 Clock] [Advance 12 Clock] [Advance 11 Clock]
[Advance 10 Clock] [Advance 9 Clock] [Advance 8 Clock] [Advance 7 Clock] [Advance
6 Clock] [Advance 5 Clock] [Advance 4 Clock] [Advance 3 Clock] [Advance 2 Clock]
[Advance 1 Clock] [Normal] [Delay 1 Clock] [Delay 2 Clock] [Delay 3 Clock] [Delay 4
Clock] [Delay 5 Clock] [Delay 6 Clock] [Delay 7 Clock] [Delay 8 Clock] [Delay 9 Clock]
[Delay 10 Clock] [Delay 11 Clock] [Delay 12 Clock] [Delay 13 Clock] [Delay 14 Clock]

DRAM RTL (CHC D1 RO) [Auto]

Configuration options: [Auto] [Advance 14 Clock] [Advance 12 Clock] [Advance 10
Clock] [Advance 8 Clock] [Advance 6 Clock] [Advance 4 Clock] [Advance 2 Clock]
[Normal] [Delay 2 Clock] [Delay 4 Clock] [Delay 6 Clock] [Delay 8 Clock] [Delay 10
Clock] [Delay 12 Clock] [Delay 14 Clock]

DRAM IOL (CHC D1 RO) [Auto]

[Auto] [Advance 14 Clock] [Advance 13 Clock] [Advance 12 Clock] [Advance 11 Clock]
[Advance 10 Clock] [Advance 9 Clock] [Advance 8 Clock] [Advance 7 Clock] [Advance
6 Clock] [Advance 5 Clock] [Advance 4 Clock] [Advance 3 Clock] [Advance 2 Clock]
[Advance 1 Clock] [Normal] [Delay 1 Clock] [Delay 2 Clock] [Delay 3 Clock] [Delay 4
Clock] [Delay 5 Clock] [Delay 6 Clock] [Delay 7 Clock] [Delay 8 Clock] [Delay 9 Clock]
[Delay 10 Clock] [Delay 11 Clock] [Delay 12 Clock] [Delay 13 Clock] [Delay 14 Clock]
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DRAM RTL (CHC D1 R1) [Auto]

Configuration options: [Auto] [Advance 14 Clock] [Advance 12 Clock] [Advance 10
Clock] [Advance 8 Clock] [Advance 6 Clock] [Advance 4 Clock] [Advance 2 Clock]
[Normal] [Delay 2 Clock] [Delay 4 Clock] [Delay 6 Clock] [Delay 8 Clock] [Delay 10
Clock] [Delay 12 Clock] [Delay 14 Clock]

DRAM IOL (CHC D1 R1) [Auto]

[Auto] [Advance 14 Clock] [Advance 13 Clock] [Advance 12 Clock] [Advance 11 Clock]
[Advance 10 Clock] [Advance 9 Clock] [Advance 8 Clock] [Advance 7 Clock] [Advance
6 Clock] [Advance 5 Clock] [Advance 4 Clock] [Advance 3 Clock] [Advance 2 Clock]
[Advance 1 Clock] [Normal] [Delay 1 Clock] [Delay 2 Clock] [Delay 3 Clock] [Delay 4
Clock] [Delay 5 Clock] [Delay 6 Clock] [Delay 7 Clock] [Delay 8 Clock] [Delay 9 Clock]
[Delay 10 Clock] [Delay 11 Clock] [Delay 12 Clock] [Delay 13 Clock] [Delay 14 Clock]

DRAM RTL (CHD DO R0) [Auto]

Configuration options: [Auto] [Advance 14 Clock] [Advance 12 Clock] [Advance 10
Clock] [Advance 8 Clock] [Advance 6 Clock] [Advance 4 Clock] [Advance 2 Clock]
[Normal] [Delay 2 Clock] [Delay 4 Clock] [Delay 6 Clock] [Delay 8 Clock] [Delay 10
Clock] [Delay 12 Clock] [Delay 14 Clock]

DRAM IOL (CHD DO RO) [Auto]

[Auto] [Advance 14 Clock] [Advance 13 Clock] [Advance 12 Clock] [Advance 11 Clock]
[Advance 10 Clock] [Advance 9 Clock] [Advance 8 Clock] [Advance 7 Clock] [Advance
6 Clock] [Advance 5 Clock] [Advance 4 Clock] [Advance 3 Clock] [Advance 2 Clock]
[Advance 1 Clock] [Normal] [Delay 1 Clock] [Delay 2 Clock] [Delay 3 Clock] [Delay 4
Clock] [Delay 5 Clock] [Delay 6 Clock] [Delay 7 Clock] [Delay 8 Clock] [Delay 9 Clock]
[Delay 10 Clock] [Delay 11 Clock] [Delay 12 Clock] [Delay 13 Clock] [Delay 14 Clock]

DRAM RTL (CHD DO R1) [Auto]

Configuration options: [Auto] [Advance 14 Clock] [Advance 12 Clock] [Advance 10
Clock] [Advance 8 Clock] [Advance 6 Clock] [Advance 4 Clock] [Advance 2 Clock]
[Normal] [Delay 2 Clock] [Delay 4 Clock] [Delay 6 Clock] [Delay 8 Clock] [Delay 10
Clock] [Delay 12 Clock] [Delay 14 Clock]

DRAM IOL (CHD D0 R1) [Auto]

[Auto] [Advance 14 Clock] [Advance 13 Clock] [Advance 12 Clock] [Advance 11 Clock]
[Advance 10 Clock] [Advance 9 Clock] [Advance 8 Clock] [Advance 7 Clock] [Advance
6 Clock] [Advance 5 Clock] [Advance 4 Clock] [Advance 3 Clock] [Advance 2 Clock]
[Advance 1 Clock] [Normal] [Delay 1 Clock] [Delay 2 Clock] [Delay 3 Clock] [Delay 4
Clock] [Delay 5 Clock] [Delay 6 Clock] [Delay 7 Clock] [Delay 8 Clock] [Delay 9 Clock]
[Delay 10 Clock] [Delay 11 Clock] [Delay 12 Clock] [Delay 13 Clock] [Delay 14 Clock]

DRAM RTL (CHD D1 R0) [Auto]

Configuration options: [Auto] [Advance 14 Clock] [Advance 12 Clock] [Advance 10
Clock] [Advance 8 Clock] [Advance 6 Clock] [Advance 4 Clock] [Advance 2 Clock]
[Normal] [Delay 2 Clock] [Delay 4 Clock] [Delay 6 Clock] [Delay 8 Clock] [Delay 10
Clock] [Delay 12 Clock] [Delay 14 Clock]
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DRAM IOL (CHD D1 RO) [Auto]

[Auto] [Advance 14 Clock] [Advance 13 Clock] [Advance 12 Clock] [Advance 11 Clock]
[Advance 10 Clock] [Advance 9 Clock] [Advance 8 Clock] [Advance 7 Clock] [Advance
6 Clock] [Advance 5 Clock] [Advance 4 Clock] [Advance 3 Clock] [Advance 2 Clock]
[Advance 1 Clock] [Normal] [Delay 1 Clock] [Delay 2 Clock] [Delay 3 Clock] [Delay 4
Clock] [Delay 5 Clock] [Delay 6 Clock] [Delay 7 Clock] [Delay 8 Clock] [Delay 9 Clock]
[Delay 10 Clock] [Delay 11 Clock] [Delay 12 Clock] [Delay 13 Clock] [Delay 14 Clock]

DRAM RTL (CHD D1 R1) [Auto]

Configuration options: [Auto] [Advance 14 Clock] [Advance 12 Clock] [Advance 10
Clock] [Advance 8 Clock] [Advance 6 Clock] [Advance 4 Clock] [Advance 2 Clock]
[Normal] [Delay 2 Clock] [Delay 4 Clock] [Delay 6 Clock] [Delay 8 Clock] [Delay 10
Clock] [Delay 12 Clock] [Delay 14 Clock]

DRAM IOL (CHD D1 R1) [Auto]

[Auto] [Advance 14 Clock] [Advance 13 Clock] [Advance 12 Clock] [Advance 11 Clock]
[Advance 10 Clock] [Advance 9 Clock] [Advance 8 Clock] [Advance 7 Clock] [Advance
6 Clock] [Advance 5 Clock] [Advance 4 Clock] [Advance 3 Clock] [Advance 2 Clock]
[Advance 1 Clock] [Normal] [Delay 1 Clock] [Delay 2 Clock] [Delay 3 Clock] [Delay 4
Clock] [Delay 5 Clock] [Delay 6 Clock] [Delay 7 Clock] [Delay 8 Clock] [Delay 9 Clock]
[Delay 10 Clock] [Delay 11 Clock] [Delay 12 Clock] [Delay 13 Clock] [Delay 14 Clock]

Others

DRAM CLK Period [Auto]

Configuration options: [Auto] [1] [2] [3] [4] [5] [6] [7] [8]
Enhanced Training (CHA) [Auto]

Configuration options: [Auto] [Disabled] [Enabled]

Enhanced Training (CHB) [Auto]
Configuration options: [Auto] [Disabled] [Enabled]

Enhanced Training (CHC) [Auto]
Configuration options: [Auto] [Disabled] [Enabled]

Enhanced Training (CHD) [Auto]
Configuration options: [Auto] [Disabled] [Enabled]

MCH Duty Sense (CHA) [Auto]

Use the <+> and <-> keys to adjust the value. The values range from 0 to 31 with 1
interval.

MCH Duty Sense (CHB) [Auto]

Use the <+> and <-> keys to adjust the value. The values range from 0 to 31 with 1
interval.

MCH Duty Sense (CHC) [Auto]

Use the <+> and <-> keys to adjust the value. The values range from 0 to 31 with 1
interval.

MCH Duty Sense (CHD) [Auto]

Use the <+> and <-> keys to adjust the value. The values range from 0 to 31 with 1
interval.
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3-20

Receiver Slew [Auto]

Configuration options: [Auto] [Normal] [More]

Transmitter Slew [Aut
Configuration options: [Auto] [Normal] [More]

MCH Recheck [Auto]
Configuration options: [Auto] [Disabled] [Enabled]

DIGI+ Power Control

Ai Tweaker

« a DIGI+ Power Control >

CPU Load-line Calibration
CPU Current Capability

CPU UCORE Boot Up Uoltage
UCCSA Load-live Calibration
UCC3A Current Capability
CPU UCCSA Boot Up Voltage
CPU Unltage Frequency

CPU Spread Spectrum

CPU Pouer Duty Control

CPU Pover Phase Control
DRAM-AB Current Capability
DRAM-AB Voltage Freguency
DRAM-AB Power Phase Control
DRAM-CD Current Capability 5C: [
F12: Print Screen

Scroll down to display the following items:

DRAN-CD Uoltage Fregquency

DRAN-CD Pouer Phase Control

Fi2: Print Screen

CPU Load-Line Calibration [Auto]

CPU Load-line is defined by Intel VRM spec and affects CPU voltage. The CPU working
voltage will decrease proportionally to CPU loading. Higher load-line calibration would get
higher voltage and better overclocking performance, but increase the CPU and VRM thermal.
This item allows you to adjust the voltage range from the following percentages to boost the
system performance: 0% (Regular), 25% (Medium), 50% (High), 75% (Ultra High) and 100%
(Extreme).

Configuration options: [Auto] [Regular] [Medium] [High] [Ultra High] [Extreme]

% The actual performance boost may vary depending on your CPU specifiation.
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CPU Current Capability [Auto]

This item provides wider total power range for overclocking. A higher value brings a wider
total power range and extends the overclocking frequency range simultaneously.
Configuration options: [Auto] [100%] [110%] [120%)] [130%)] [140%)

' Do not remove the thermal module while changing the DIGI+ Power Control related
M parameters . The thermal conditions should be monitored.

Some of the following items are adjusted by typing the desired values using the numeric
keypad and press the <Enter> key. You can also use the <+> and <-> keys to adjust the

— value. To restore the default setting, type [auto] using the keyboard and press the <Enter>
key.

CPU VCORE Boot Up Voltage [Auto]

Use the <+> and <-> keys to adjust the value. The values range from 0.800 to 1.700 with
0.005 interval.

VCCSA Load-line calibration [Auto]

The behavior of the DRAM controller is decided by VCCSA Load-Line. Set to a higher value
for system performance, or to a lower value for better thermal solution.
Configuration options: [Auto] [Regular] [High] [Extreme]

% The actual performance boost may vary depending on your CPU and DRAM specification.

' Do not remove the thermal module. The thermal conditions should be monitored.
L]

VCCSA Current Capability [100%]
Configuration options: [100%)] [110%)] [120%)] [130%)]

CPU VCCSA Boot Up Voltage [Auto]

Use the <+> and <-> keys to adjust the value. The values range from 0.8 to 1.7 with 0.005
interval.

CPU Voltage Frequency [Auto]
Switching frequency will affect the VRM transient response and component thermal. Setting a
higher frequency gets faster transient response.

[Auto] Allows you to enable or disable the Spread Spectrum item.
[Manual] Allows you to manually set the frequency with a 10k Hz interval.
CPU Fixed Frequency [xxx]

Use the <+> and <-> keys to adjust the value. The values range from 300kHz to 500kHz with
10kHz interval.

CPU Spread Spectrum [Disabled]

This item helps enhance system stability.
Configuration options: [Enabled)] [Disabled]
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CPU Power Duty Control [T.Probe]
[T.Probe] Maintains the VRM thermal balance.
[Extreme] Maintains the VRM current balance.

CPU Power Phase Control [Auto]

Phase number is the number of woorking VRM phase. Increasing phase number under
heavy system loading to get more transient and better thermal performance. Reducing phase
number under light system loading to increase VRM efficiency

[Standard] Proceeds phase control depending on the CPU loading.
[Auto] Allows you to set the Auto mode.

[Optimized] Loads the ASUS optimized phase tuning profile.
[Extreme] Proceeds the full phase mode.

[Manual Adjustment]  Allows manual adjustment.

DRAM-AB Current Capability [100%)]

Setting a higher value brings a wider total power range and extends the overclocking
frequency range simultaneously.
Configuration options: [100%)] [110%)] [120%)] [130%]

DRAM-AB Voltage Frequency [Auto]

This item allows you to adjust the DRAM switching frequency. Assign a fixed high DRAM
frequency to increase O.C range or a lower DRAM frequency for better system stability.
Configuration options: [Auto] [manual]

DRAM-AB Power Phase control [Auto]

[Auto] Allows you to set the Auto mode.
[Optimized] Allows you to set ASUS optimized phase tuning profile.
[Extreme] Allows you to set the Full phase mode.

DRAM-CD Current Capability [100%)]

Setting a higher value brings a wider total power range and extends the overclocking
frequency range simultaneously.
Configuration options: [100%)] [110%)] [120%)] [130%]

DRAM-CD Voltage Frequency [Auto]

This item allows you to adjust the DRAM switching frequency. Assign a fixed high DRAM
frequency to increase O.C range or a lower DRAM frequency for better system stability.
Configuration options: [Auto] [manual]

DRAM-CD Power Phase control [Auto]

[Auto] Allows you to set the Auto mode.
[Optimized] Allows you to set ASUS optimized phase tuning profile.
[Extreme] Allows you to set the Full phase mode.
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CPU Performance Settings
The items in this menu is setting for CPU Ratio/Features.

Ai Tueaker
4 da CPU Performance Settings >
CPU Ratio
Enhanced Intel SpeedStep Technology

Turbo Hode

Long Duration Power Limit
Long Duration Maintained
Short Duration Power Linit
fdditional Turbo Uoltage

CPU Core Current Limit

F12: Print Screen

CPU Ratio [Auto]

This item allows user manually adjust the maximum non-turbo CPU ratio, The value will be
limit to CPU base or factory setting.

Enhanced Intel SpeedStep Technology [Enabled]

Enhanced Intel SpeedStep Technology, allows the system operation system to dynamically
adjust processor voltage and cores frequency, which can result in decreased average power
consumption and decreased average heat production.

Configuration options: [Disabled] [Enabled]

Turbo Mode [Enabled]

It automatically allows processors cores to run faster than the base operating frequency if it's
operating below power, current and temperature specification limit.
Configuration options: [Disabled] [Enabled]

% The following items appear only when you set the Turbo Mode items to [Enabled].

Turbo Mode Parameters

Long Duration Power Limit [Autt

The default setting of this item will be TDP (130W). For Sandy Bridge-E, Turbo Ratio
can be kept a time duration exceed TDP for maximum performance. Any value under
255 can be programmed. Use the <+> and <-> keys to adjust the value.
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Long Duration Maintained [Auto]

This value can vary from 1 to 32, which indicates the time window for Turbo Ratio over
TDP should be maintained. Use the <+> and <-> keys to adjust the value.

Short Duration Power Limit [Auto]

This is the second power limit to provide rapid protection when package power
exceeds Power Limit 1. Default setting is 1.25 times Power Limit 1. For Intel
recommend, platform must be capable of supporting over Power Limit 2 for up to 10
msec. ASUS board can support over Power Limit 2 for a long duration. Use the <+>
and <-> keys to adjust the value.

Additional Turbo Voltage [Auto]

This item allows user to set the maximum additional voltage applies to the CPU when
Turbo Boost is engaged. Use <+> and <-> key to adjust the value.

CPU Core Current Limit [Auto]

This item allows user to enter CPU Current Limit, unit in 0.125A. Use the <+> and <->
keys to adjust the value.

CPU VCORE Voltage [Offset Mode]
[Manual Mode]  Allows you to set a fixed CPU VCORE voltage.
[Offset Mode]  Allows you to set the CPU VCORE Offset voltage.

CPU VCORE Manual Voltage [Auto]

This item appears only when you set the CPU VCORE Voltage item to [Manual Mode]
and allows you to set a fixed CPU voltage. The values range from 0.800V to 1.700V
with a 0.005V interval.

CPU VCCSA Voltage [Offset Mode]
[Manual Mode]  Allows you to set a fixed CPU VCCSA voltage.
[Offset Mode]  Allows you to set the CPU VCCSA Offset voltage.
CPU VCCSA Manual Voltage [Auto]
This item appears only when you set the CPU VCCSA Voltage item to [Manual Mode]

and allows you to set a fixed CPU voltage. The values range from 0.800V to 1.700V
with a 0.005V interval.

Offset Mode Sign [+]
This item appears only when you set the CPU VCORE/VCCSA Voltage item to [Offset

Mode].
[+] To offset the voltage by a positive value.
[-] To offset the voltage by a negative value.

CPU VCORE/VCCSA Offset Voltage [Auto]

This item allows you to set the Offset voltage. The values range from 0.005V to 0.635V
with a 0.005V interval.

Refer to the CPU documentation before setting the CPU voltage. Setting a high voltage
D) may damage the CPU permanently, and setting a low voltage may make the system
unstable.
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DRAM Voltage (CHA, CHB) [Auto]

Allows you to set the DRAM voltage. The values range from 1.20V to 1.99V with a 0.005V
interval.

DRAM Voltage (CHC, CHD) [Auto]

Allows you to set the DRAM voltage. The values range from 1.20V to 1.99V with a 0.005V
interval.

' According to Intel CPU spec, DIMMs with voltage requirement over 1.65V may damage
. the CPU permanently. We recommend you install the DIMMs with the voltage requirement
below 1.65V.

CPU PLL Voltage [Auto]

Allows you to set the CPU and PCH PLL voltage. The values range from 1.80V to 2.10V with
a 0.00625V interval.

VTTCPU Voltage [Auto]

Allows you to set the VTTCPU voltage. The values range from 1.10V to 1.70V with a
0.00625V interval.

PCH 1.5v Voltage [Auto]

Allows you to set the 1.5v Platform Controller Hub voltage. The values range from 1.50V to
1.80V with a 0.00625V interval.

' The system may need better cooling system to work stably under high voltage settings.

VTTDDR Voltage (CHA, CHB) [Auto]

Allows you to set the CHA, CHB VTTDDR voltage. The values range from 0.6250V to 1.10V
with a 0.00625V interval.

VTTDDR Voltage (CHC, CHD) [Auto]

Allows you to set the CHC, CHD VTTDDR voltage. The values range from 0.6250V to 1.10V
with a 0.00625V interval.

DRAM CTRL REF Voltage on CHA [Auto]

Allows you to set the DRAM CTRL REF Voltage on CHA. The values range from 0.3950x to
0.6300x with a 0.005x interval.

DRAM DATA REF Voltage on CHA [Auto]

Allows you to set the DRAM DATA REF Voltage on CHA. The values range from 0.3950x to
0.6300x with a 0.005x interval.
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DRAM CTRL REF Voltage on CHB [Auto]

Allows you to set the DRAM CTRL REF Voltage on CHB. The values range from 0.3950x to
0.6300x with a 0.005x interval.

DRAM DATA REF Voltage on CHB [Auto]

Allows you to set the DRAM DATA REF Voltage on CHB. The values range from 0.3950x to
0.6300x with a 0.005x interval.

DRAM CTRL REF Voltage on CHC [Auto]

Allows you to set the DRAM CTRL REF Voltage on CHC. The values range from 0.3950x to
0.6300x with a 0.005x interval.

DRAM DATA REF Voltage on CHC [Auto]

Allows you to set the DRAM DATA REF Voltage on CHC. The values range from 0.3950x to
0.6300x with a 0.005x interval.

DRAM CTRL REF Voltage on CHD [Auto]

Allows you to set the DRAM CTRL REF Voltage on CHD. The values range from 0.3950x to
0.6300x with a 0.005x interval.

DRAM DATA REF Voltage on CHD [Auto]

Allows you to set the DRAM DATA REF Voltage on CHD. The values range from 0.3950x to
0.6300x with a 0.005x interval.

DRAM Read REF Voltage on CHA [Auto]

Allows you to set the DRAM Read Reference Voltage on Channel A. The values range from
0.3850x to 0.6150x with a 0.005x interval. Different ratio might enhance DRAM overclocking
ability.

DRAM Read REF Voltage on CHB [Auto]

Allows you to set the DRAM Read Reference Voltage on Channel B. The values range from
0.3850x to 0.6150x with a 0.005x interval. Different ratio might enhance DRAM overclocking
ability.

DRAM Read REF Voltage on CHC [Auto]

Allows you to set the DRAM Read Reference Voltage on Channel C. The values range from
0.3850x to 0.6150x with a 0.005x interval. Different ratio might enhance DRAM overclocking
ability.

DRAM Read REF Voltage on CHD [Auto]

Allows you to set the DRAM Read Reference Voltage on Channel D. The values range from
0.3850x to 0.6150x with a 0.005x interval. Different ratio might enhance DRAM overclocking
ability.
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CPU Spread Spectrum [Auto]

[Auto] Sets to Auto mode.

[Disabled] Enhances the BCLK overclocking ability.
[Enabled] Sets to [Enabled] for EMI control.

PCIE Spread Spectrum [Auto]

[Auto] Sets to Auto mode.

[Disabled] Enhances the PCIE overclocking ability.
[Enabled] Sets to [Enabled] for EMI control.

3.5 Advanced menu

The Advanced menu items allow you to change the settings for the CPU and other system
devices.

/a\
/ ' \ Be cautious when changing the settings of the Advanced menu items. Incorrect field values
[GELES can cause the system to malfunction.

Ee

Advanced

>"CPU Configuration

> Systen fgent Configuration

> PCH Configuration

> SATA Configuration

> Intel () Thunderbolt

> USB Configuration

> Onboard Devices Configuration
> APH

> Network Stack

Fi2: Print Screen
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3.5.1 CPU Configuration

The items in this menu show the CPU-related information that the BIOS automatically
detects.

R The items shown in this screen may be different due to the CPU you installed.

C¢

fAdvanced

CPU Configuration >

Intel Adaptive Thermal Monitor “Enabled
Hyper-threading

fActive Processor Cores

Linit CPUID Maxinum

Execute Disable Bit
F12: Print Screen

Scroll down to display the following items:

Intel Virtualization Technology

>"CPU Power Mamagement Configuration

F12: Print Screen

Intel Adaptive Thermal Monitor [Enabled]
[Disabled] Disables the CPU thermal monitor function.
[Enabled] Enables the overheated CPU to throttle its clock speed to cool down.

Hyper-threading [Enabled]

The Intel Hyper-Threading Technology allows a hyper-threading processor to appear as two
logical processors to the operating system, allowing the operating system to schedule two
threads or processes simultaneously.

[Disabled] Only one thread per activated core is enabled.
[Enabled] Two threads per activated core are enabled.
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Active Processor Cores [All]

Allows you to choose the number of CPU cores to activate in each processor package. The
configuration options will be vary with CPU specification.
Configuration options: [All]

Limit CPUID Maximum [Disabled]

[Enabled] Allows legacy operating systems to boot even without support for CPUs
with extended CPUID functions.

[Disabled] Disables this function.

Execute Disable Bit [Enabled]

[Enabled] Enables the No-Execution Page Protection Technology.

[Disabled] Forces the XD feature flag to always return to zero (0).

Intel Virtualization Technology [Enabled]

[Enabled] Allows a hardware platform to run multiple operating systems separately
and simultaneously, enabling one system to virtually function as several
systems.

[Disabled] Disables this function.

CPU Power Management Configuration

Co
fAdvanced

\ CPU Power Management Configuration >

CPU Ratio

Enhanced Intel SpeedStep Technology
Turbo Hode

CPU CIE

CPU C3 Report

CPU C6 Report

CPU C? Report

CPU Ratio [Auto]

Allows you to set the ratio between the CPU Core Clock and the BCLK Frequency. Use <+>
and <-> keys to adjust the ratio. The valid value ranges vary according to your CPU model.
Enhanced Intel SpeedStep Technology [Enabled]

Allows you to enable or disable the Enhanced Intel® SpeedStep Technology (EIST).

[Disabled] The CPU runs at its default speed.

[Enabled] The operating system controls the CPU speed.

Turbo Mode [Enabled]

[Disabled] Disables this function.

[Enabled] Allows processor cores to run faster than marked frequency in specific
condition.

ASUS P9X79 LE 3-29



3-30

CPU C1E [Auto]

[Auto] Set this function in Auto mode.
[Disabled] Disables this function.
[Enabled] Enables the C1E support function. This item should be enabled in order to

enable the Enhanced Halt State.
CPU C3 Report [Auto]

Allows you to disable or enable the CPU C3 report to OS.
Configuration options: [Enabled)] [Disabled] [Auto]

CPU C6 Report [Auto]

Allows you to disable or enable the CPU C6 report to OS.
Configuration options: [Enabled)] [Disabled] [Auto]

CPU C7 Report [Auto]

Allows you to disable or enable the CPU C7 report to OS.
Configuration options: [Enabled] [Disabled] [Auto]

3.5.2 System Agent Configuration

=]
Advanced

« B dy System Agent Configuration >

Intel (B UT-d T Dizabled

PCIEX16_1 Link Speed
PCIEX16_2 Link Speed

PCIEX16_3 Link Speed

Intel(R) VT-d [Disabled]
[Enabled] Enables the function.
[Disabled] Disables this function.

PCIEX16_1 Link Speed [GEN3]

Allows you to configure the PCIEX16_1 speed.
Configuration options: [GEN1] [GEN2] [GEN3]

PCIEX16_2 Link Speed [GEN3]

Allows you to configure PCIEX16_2 speed.
Configuration options: [GEN1] [GEN2] [GEN3]

PCIEX16_3 Link Speed [GEN3]

Allows you to configure PCIEX16_3 speed.
Configuration options: [GEN1] [GEN2] [GEN3]
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3.5.3 PCH Configuration

Ce

Advanced

PCH Configuration >

High Precision Timer Enabled

High Precision Timer [Enabled]

Allows you to enable or disable the High Precision Event Timer.
Configuration options: [Disabled] [Enabled]

3.5.4 SATA Configuration

While entering Setup, the BIOS automatically detects the presence of SATA devices. The SATA
Port items show Not Present if no SATA device is installed to the corresponding SATA port.

Ce

Advanced

SATA Configuration >

SATA Mode AHCT Hode
S.M.A.R.T. Status Check

Hot Plug

Hot Plug

Hot Plug

Hot Plug

Hot Plug

Hot Plug

Fi2: Print Screen
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SATA Mode [AHCI Mode]
Allows you to set the SATA configuration.

[Disabled] Disables the SATA function.
[IDE Mode] Set to [IDE Mode] when you want to use the Serial ATA hard disk drives as
Parallel ATA physical storage devices.

[AHCI Mode] Set to [AHCI Mode] when you want the SATA hard disk drives to use the
AHCI (Advanced Host Controller Interface). The AHCI allows the onboard
storage driver to enable advanced Serial ATA features that increases
storage performance on random workloads by allowing the drive to
internally optimize the order of commands.

[RAID Mode] Set to [RAID Mode] when you want to create a RAID configuration from the
SATA hard disk drives.

% The following items appear only when you set the previous item to [IDE Mode].

Serial-ATA Controller 0 [Enhanced]

Allows you to enabled/disabled the Serial-ATA Controller 0.
Configuration options: [Disabled] [Enhanced] [Compatible]

Serial-ATA Controller 1 [Enhanced]

Allows you to enabled/disabled the Serial-ATA Controller 1.
Configuration options: [Disabled] [Enhanced]

S.M.A.R.T. Status Check [Enabled]

S.M.A.R.T. (Self-Monitoring, Analysis and Reporting Technology) is a monitor system. When
read/write of your hard disk errors occur, this feature allows the hard disk to report warning
messages during the POST.

Configuration options: [Disabled] [Enabled]

SATA6G_1 (Gray)
Hot Plug [Disabled]
This item appear only when you set the previous item to [AHCI Mode] and [RAID Mode].

It's allow user to enabled/disabled SATA Hot Plug Support. Configuration options: [Disabled]
[Enabled].

SATA6G_2 (Gray)
Hot Plug [Disabled]

This item appear only when you set the previous item to [AHCI Mode] and [RAID Mode].
It's allow user to enabled/disabled SATA Hot Plug Support. Configuration options: [Disabled)]
[Enabled].
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SATA3G_3 (Blue)

Hot Plug [Disabled]

This item appear only when you set the previous item to [AHCI Mode] and [RAID Mode].

It's allow user to enabled/disabled SATA Hot Plug Support. Configuration options: [Disabled]
[Enabled].

SATA3G_4 (Blue)

Hot Plug [Disabled]

This item appear only when you set the previous item to [AHCI Mode] and [RAID Mode].

It's allow user to enabled/disabled SATA Hot Plug Support. Configuration options: [Disabled]
[Enabled].

SATA3G_5 (Blue)

Hot Plug [Disabled]

This item appear only when you set the previous item to [AHCI Mode] and [RAID Mode]. It's
allow user to enabled/disabled SATA Hot Plug Support. Configuration options: [Disabled)]
[Enabled].

SATA3G_6 (Blue)

Hot Plug [Disabled]

This item appear only when you set the previous item to [AHCI Mode] and [RAID Mode]. It's

allow user to enabled/disabled SATA Hot Plug Support. Configuration options: [Disabled)]
[Enabled].

3.5.5 USB Configuration

The items in this menu allow you to change the USB-related features.

Ca

fAdvanced

USB Configuration >

Legacy USB Support Enabled
Legacy USB3.0 Support

EHCT Hand-off

JetFlashTranscend 46B 8.07

> SB USB Configuration
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/ The USB Devices item shows the auto-detected values. If no USB device is detected, the
A8 item shows None.

Legacy USB Support [Enabled]

[Disabled] The USB devices can be used only for the BIOS setup program.
[Enabled] Enables the support for USB devices on legacy operating systems (OS).
[Auto] Allows the system to detect the presence of USB devices at startup. If

detected, the USB controller legacy mode is enabled. If no USB device is
detected, the legacy USB support is disabled.

Legacy USB3.0 Support [Enabled]

[Disabled] Disables the function.

[Enabled] Enables the support for USB 3.0 devices on legacy operating systems
(0S).

EHCI Hand-off [Disabled]

[Disabled] Disables the function.

[Enabled] Enables the support for operating systems without an EHCI hand-off
feature.

SB USB Configuration

Co
fAdvanced

SB USB Configuration >

All USB Devices Enabled

EHCT Controller 1

EHCT Controller 2

All USB Devices [Enable

Allows you to enable or disable all USB devices.
Configuration options: [Disabled][Enabled]
EHCI Controller 1 [Enabled;

Allows you to enable or disable EHCI Controller 1.
Configuration options: [Disabled][Enabled]

EHCI Controller 2 [Enabl

Allows you to enable or disable EHCI Controller 2.
Configuration options: [Disabled][Enabled]
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3.5.6 Onboard Devices Configuraton

1=

fAdvanced

« il 1\ Onboard Devices Configuration >

fAzalia HD fudio T Enabled
Front Panel Type

SPDIF Out Tupe

Realtek LAN Controller

Realtek PKE OPROM
fAsnedia USB 3.0 Controller

ASM1061 Storage Controller

ASH1061 Storage OPROM

> Serial Port Configuration

F12: Print Screen

Azalia HD Audio [Enabled]

[Disabled] Disables the controller.

[Enabled] Enables the High Definition Audio Controller.

% The following two items appear only when you set the HD Audio Controller item to
— [Enabled].

Front Panel Type [HD]

Allows you to set the front panel audio connector (AAFP) mode to legacy AC’97 or high-

definition audio depending on the audio standard that the front panel audio module supports.

[HD] Sets the front panel audio connector (AAFP) mode to high definition audio.
[AC97] Sets the front panel audio connector (AAFP) mode to legacy AC'97
SPDIF Out Type [SPDIF]

[SPDIF] Sets to [SPDIF] for SPDIF audio output.

[HDMI] Sets to [HDMI] for HDMI audio output.

Realtek LAN Controller [Enabled]
[Enabled] Enables the Realtek LAN controller.
[Disabled] Disables the controller.
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Realtek PXE OPROM [Disabled]

This item appears only when you set the previous item to [Enabled] and allows you to enable
or disable the PXE OptionRom of the Realtek LAN controller.
Configuration options: [Enabled] [Disabled]

Asmedia USB 3.0 Controller [Enabled]

This item allows user to enabled/disabled Asmedia USB 3.0.
Configuration options: [Disabled] [Enabled]

ASM1061 Storage Controller [AHCI Mode]

Allows you to enable or disable the ASM1061 storage controller.
Configuration options: [Disabled] [IDE Mode] [AHCI Mode]

If you want to use the full functin of the ASM1061 storage contorller (ex. AHCI), we
recommend that you set this item to [AHCI Mode] and install the ASM1061 Controller
Driver from the motherboard support DVD.

ASM1061 Storage OPROM [Enabled]

This item appears only when you set the previous item to [IDE Mode] or [AHCI Mode] and
allows you to enable or disable the OptionRom of the ASM1061 storage controller.
Configuration options: [Disabled] [Enabled]

Serial Port Configuration
Co

Advanced

Serial Port Configuration >

Serial Port Enabled

Change Settings

Serial Port [Enabled]
Allows you to enable or disable the serial port (COM).
Configuration options: [Enabled][Disabled]
han ttin, =3F8h; IRQ=4
Allows you to select the Serial Port base address.
Configuration options: [[0=3F8h; IRQ=4][|0=2F8h; IRQ=3][I0=3E8h; IRQ=4][|0=2E8h;
IRQ=3]
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3.5.7 APM

1=
Advanced

L)

Restore AC Power Loss Pouer OfF

Pouer On By Keyboard
Pouer On By Mouse
Pouer On By PCIE/PCT
Pouer On By Ring
Pouer On By RIC

ErP Ready

Restore AC Power Loss [Power Off]

[Power On] The system goes into on state after an AC power loss.
[Power Off] The system goes into off state after an AC power loss.
[Last State] The system goes into either off or on state, whatever the system state was

before the AC power loss.

Power On By Keyboard [Disabled]

[Disabled] Disables the keyboard device from generating a wake event.
Configuration options to Enable keyboard to generate a wake event:

[Space Bar] [Ctrl-Esc] [Power Key]

Power On By Mouse [Disabled]

[Disabled] Disables the mouse device from generating a wake event.
[Enabled] Enables the mouse device to generate a wake event:

Power On By PCIE/PCI [Disabled]

[Disabled] Disables the PCIE/PCI devices from generating a wake event.
[Enabled] Enables the PCIE/PCI devices to generate a wake event.
Power On By Ring [Disabled]

[Disabled] Disables the Ring device from generating a wake event.
[Enabled] Enables the Ring device to generate a wake event.

Power On By RTC [Disabled]

[Disabled] Disables RTC from generating a wake event.

[Enabled] When set to [Enabled], the items RTC Alarm Date (Days) and Hour/

Minute/Second will become user-configurable with set values. Use <+>
and <-> keys to adjust the values.

ErP Ready [Disabled]

This item allows user to switch off some power at S5 to get the system ready for ErP
requirement. When set to Enabled, all other PME options will be switched off.
Configuration options: [Disabled] [Enabled]
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3.5.8 Network Stack

Co
fAdvanced

o) dua Netuork Stack >

Netuork stack “Disable Link

Network Stack [Disable Link]

This item allows user to disable or enable the UEFI network stack.
Configuration options: [Disable Link] [Enabled]

%{ The following items appears only when you set the Network Stack to [Enabled].

Ipv4 PXE Support [Enable]

This item allows user to disable or enable the Ipv4 PXE Support.
Configuration options: [Disable Link] [Enabled]

Ipvé PXE Support [Enable]

This item allows user to disable or enable the Ipv6 PXE Support.
Configuration options: [Disable Link] [Enabled]
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3.6 Monitor menu

The Monitor menu displays the system temperature/power status, and allows you to change
the fan settings.

<k

Honitor

CPU Temperature

MB Temperature

CPU Fan Speed

CPU OPT Speed

Chassis Fan 1 Speed
Chassis Fan 2 Speed
Chassis Fan 3 Speed
Chassis Fan 4 Speed
CPU Q-Fan Control

CPU Fan Speed Low Linit
CPU Fan Profile
Chassis 1 Q-Fan Control
Chassis 1 Fan Speed Low Linit

Chassis 1 Fan Profile
F12: Print Screen

Scroll down to display the following items:

=

Honitor

Chassis 2 Fan Speed Low Linit
Chassis 2 Fan Profile

Chassis 3 (-Fan Control

Chapter 3

Chassis 3 Fan Speed Low Linit
Chassis 3 Fan Profile
Chassis 4 (-Fan Control
Chassis 4 Fan Speed Low Linit
Chassis 4 Fan Profile

CPU Voltage

3.3V Upltage

5U Uoltage

12V Vpltage

Anti Surge Support T Enabled
F12: Print Screen
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CPU Temperature [xxx°C/xxx°F]

The onboard hardware monitor automatically detects and displays the CPU temperatures.
Select Ignore if you do not wish to display the detected temperatures.

MB Temperature [xxx°C/xxx°F]

The onboard hardware monitor automatically detects and displays the motherboard
temperatures. Select Ignore if you do not wish to display the detected temperatures.

CPU Fan Speed [xxxx RPM] or [Ignore] / [N/A]

CPU OPT Fan Speed [xxxx RPM] or [Ignore] / [N/A]

Chassis Fan 1/2/3/4 Speed [xxxx RPM] or [Ignore] / [N/A]

The onboard hardware monitor automatically detects and displays the CPU, CPU OPT,
and chassis fan speed in rotations per minute (RPM). If the fan is not connected to the

motherboard, the field shows N/A. Select Ignore if you do not wish to display the detected
speed.

CPU Q-Fan Control [Enabled]
[Disabled] Disables the CPU Q-Fan control feature.
[Enabled] Enables the CPU Q-Fan control feature.

CPU Fan Speed Low Limit [600 RPM]

This item appears only when you enable the CPU Q-Fan Control feature and allows you to
disable or set the CPU fan warning speed.
Configuration options: [Ignore] [200 RPM] [300 RPM] [400 RPM] [500 RPM] [600 RPM]

CPU Fan Profile [Standard]

This item appears only when you enable the CPU Q-Fan Control feature and allows

you to set the appropriate performance level of the CPU fan.

[Standard] Sets to [Standard] to make the CPU fan automatically adjust depending on
the CPU temperature.

[Silent] Sets to [Silent] to minimize the fan speed for quiet CPU fan operation.

[Turbo] Sets to [Turbo] to achieve maximum CPU fan speed.

[Manual]  Sets to [Manual] to assign detailed fan speed control parameters.

/ The following four items appear only when you set CPU Fan Profile to [Manual].
CPU Upper Temperature [70]

Use the <+> and <-> keys to adjust the upper limit of the CPU temperature. The values range
from 20°C to 75°C.

CPU Fan Max. Duty Cycle(%) [100]

Use the <+> and <-> keys to adjust the maximum CPU fan duty cycle. The values range from
0% to 100%. The minimum value can not lower than the setting of Min duty cycle.

CPU Lower Temperature [20]
Displays the lower limit of the CPU temperature.

Chapter 3: BIOS setup



CPU Fan Min. Duty Cycle(%) [20]

Use the <+> and <-> keys to adjust the minimum CPU fan duty cycle. The values range from 0%
to 100%. When the CPU temperature is under 40°C, the CPU fan will operate at the minimum
duty cycle.

Chassis 1/2/3/4 Q-Fan Control [Enabled]
[Disabled] Disables the Chassis Q-Fan control feature.
[Enabled] Enables the Chassis Q-Fan control feature.

Chassis 1/2/3/4 Fan Speed Low Limit [600 RPM]

This item appears only when you enable the Chassis 1/2/3/4 Q-Fan Control feature and
allows you to disable or set the chassis fan warning speed.
Configuration options: [Ignore] [200 RPM] [300 RPM] [400 RPM] [500 RPM] [600 RPM]

Chassis 1/2/3/4 Fan Profile [Standard

This item appears only when you enable the Chassis Q-Fan Control feature and
allows you to set the appropriate performance level of the chassis fan.

[Standard] Sets to [Standard] to make the chassis fan automatically adjust depending
on the chassis temperature.

[Silent] Sets to [Silent] to minimize the fan speed for quiet chassis fan operation.
[Turbo] Sets to [Turbo] to achieve maximum chassis fan speed.
[Manual]  Sets to [Manual] to assign detailed fan speed control parameters.

% The following four items appear only when you set Chassis 1/2/3/4 Fan Profile to
[Manual].

Chassis 1/2/3/4 Upper Temperature [70]

Use the <+> and <-> keys to adjust the upper limit of the CPU temperature. The values range
from 40°C to 90°C.

Chassis 1/2/3/4 Fan Max. Duty Cycle(%) [100]

Use the <+> and <-> keys to adjust the maximum chassis fan duty cycle. The values range from
60% to 100%. The minimum value can not lower than the setting of Min duty cycle.

Chassis 1/2/3/4 Lower Temperature [40]

Displays the lower limit of the chassis temperature.

Chassis 1/2/3/4 Fan Min. Duty Cycle(%) [60]

Use the <+> and <-> keys to adjust the minimum chassis fan duty cycle. The values range from
60% to 100%. When the chassis temperature is under 40°C, the chassis fan will operate at the
minimum duty cycle.

CPU Voltage, 3.3V Voltage, 5V Voltage, 12V Voltage

The onboard hardware monitor automatically detects the voltage output through the onboard
voltage regulators. Select Ignore if you do not want to detect this item.

Anti Surge Support [Enabled]

This item allows you to enable or disable the Anti Surge function.
Configuration options: [Disabled] [Enabled]
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3.7 Boot menu

The Boot menu items allow you to change the system boot options.

Bootup NunLock State
Full Screen Logo
Uait For 'F1’ If Error
DirectKey Enable

Option ROM Messages

Setup Mode

Boot Option #1

> Hard Drive BBS Priorities

> PO: FUJITSU MHU2200BT PL (190782MB)

Bootup NumLock State [On]

[On] Sets the power-on state of the NumLock to [On].
[Off] Sets the power-on state of the NumLock to [Off].
Full Screen Logo [Enabled]

[Enabled] Enables the full screen logo display feature.
[Disabled] Disables the full screen logo display feature.

% Set this item to [Enabled] to use the ASUS MyLogo 2™ feature.

Wait For ‘F1’ If Error [Enabled]

[Disabled] Disables this function.

[Enabled] The system waits for the <F1> key to be pressed when error occurs.

DirectKey Enable [Go to BIOS Setup]

[Go to BIOS Setup] ~ Enables the DirectKey function and allows you to go to the BIOS
setup when you press the DirectKey button.

[Disable] Disables the DirectKey function. When set to [Disable], the DirectKey
button will only allow you to turn on or shut down your computer
without going into the BIOS setup.

When set to [Go to BIOS Setup] and the computer is on, the system will shut down when
you press the DirectKey button. Press the DirectKey button again or the power button to
reboot and go directly into the BIOS setup.
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Option ROM Messages [Force BIOS]

[Force BIOS] The third-party ROM messages will be forced to display during the boot
sequence.

[Keep Current]  The third-party ROM messages will be displayed only if the third-party
manufacturer had set the add-on device to do so.

Setup Mode [EZ Mode]

[Advanced Mode] Sets Advanced Mode as the default screen for entering the BIOS setup
program.

[EZ Mode] Sets EZ Mode as the default screen for entering the BIOS setup program.

Boot Option Priorities

These items specify the boot device priority sequence from the available devices. The
number of device items that appears on the screen depends on the number of devices
installed in the system.

% +  To select the boot device during system startup, press <F8> when ASUS Logo appears.
/- To access Windows OS in Safe Mode, press <F8> after POST.
Boot Override

These items displays the available devices. The number of device items that appears on
the screen depends on the number of devices installed in the system. Click an item to start
booting from the selected device.

3.8 Tools menu

The Tools menu items allow you to configure options for special functions. Select an item
then press <Enter> to display the submenu.

S"ASUS EZ Flash 2 Utility

> ASUS DRAM SFD Information

> ASUS 0.C. Profile
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3.8.1 ASUS EZ Flash 2 Utility

Allows you to run ASUS EZ Flash 2 Utility. When you press <Enter>, a confirmation message
appears. Use the left/right arrow key to select between [Yes] or [No], then press <Enter> to
confirm your choice.

% For more details, refer to section 3.10.2 ASUS EZ Flash 2 utility.

3.8.2 ASUS DRAM SPD Information

This menu showed the DIMM slot related informations.

« ASUS DRAM SPD Information >
ST DINM_AL
> DIMH_A2
> DIMM_B1
> DIMM_B2
> DIMM_C1
> DIMM_C2
> DIMM_D1

> DIMM_D2

F12: Print Screen
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3.8.3 ASUS 0.C. Profile

This item allows you to store or load multiple BIOS settings.

ASUS D.C. Profile >

Label

Save to Profile

Load fron Profile

% The Setup Profile Status items show Not Installed if no profile is created.
Label
Allows you to input the label of setup profile.

Save to Profile

Allows you to save the current BIOS settings to the BIOS Flash, and create a profile. Key in a
profile number from one to eight, press <Enter>, and then select Yes.

Load from Profile

Allows you to load the previous BIOS settings saved in the BIOS Flash. Key in the profile
number that saved your BIOS settings, press <Enter>, and then select Yes.

+ DO NOT shut down or reset the system while updating the BIOS to prevent the
system boot failure!

+ We recommend that you update the BIOS file only coming from the same memory/CPU
configuration and BIOS version.
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3.9 Exit menu

The Exit menu items allow you to load the optimal default values for the BIOS items, and
save or discard your changes to the BIOS items. You can access the EZ Mode from the Exit
menu.

0ad Optinized Defaults

Load Optimized Defaults

This option allows you to load the default values for each of the parameters on the Setup
menus. When you select this option or if you press <F5>, a confirmation window appears.
Select Yes to load the default values.

Save Changes & Reset

Once you are finished making your selections, choose this option from the Exit menu to
ensure the values you selected are saved. When you select this option or if you press <F10>,
a confirmation window appears. Select Yes to save changes and exit.

Discard Changes & Exit

This option allows you to exit the Setup program without saving your changes. When you
select this option or if you press <Esc>, a confirmation window appears. Select Yes to
discard changes and exit.

ASUS EZ Mode
This option allows you to enter the EZ Mode screen.

Launch UEFI Shell from filesystem device

This option allows you to attempt to launch the UEFI Shell application (shellx64.¢efi) from one
of the available filesystem devices.
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3.10 Updating BIOS

The ASUS website publishes the latest BIOS versions to provide enhancements on system
stability, compatibility, or performance. However, BIOS updating is potentially risky. If there
is no problem using the current version of BIOS, DO NOT manually update the BIOS.
Inappropriate BIOS updating may result in the system’s failure to boot. Carefully follow the
instructions of this chapter to update your BIOS if necessary.

R Visit the ASUS website (www.asus.com) to download the latest BIOS file for this
motherboard.

The following utilities allow you to manage and update the motherboard BIOS setup program.

1. ASUS Update: Updates the BIOS in Windows® environment.
2. ASUS EZ Flash 2: Updates the BIOS using a USB flash drive.

3. ASUS CrashFree BIOS 3: Restores the BIOS using the motherboard support DVD or
a USB flash drive when the BIOS file fails or gets corrupted.

4. ASUS BIOS Updater: Updates and backups the BIOS in DOS environment using the
motherboard support DVD and a USB flash disk drive.

Refer to the corresponding sections for details on these utilities.

R Save a copy of the original motherboard BIOS file to a USB flash disk in case you need
to restore the BIOS in the future. Copy the original motherboard BIOS using the ASUS
Update or BIOS Updater utilities.

3.10.1 ASUS Update utility

The ASUS Update is a utility that allows you to manage, save, and update the motherboard
BIOS in Windows® environment. The ASUS Update utility allows you to:

Update the BIOS directly from the Internet
Download the latest BIOS file from the Internet
Update the BIOS from an updated BIOS file
Save the current BIOS file
View the BIOS version information
This utility is available in the support DVD that comes with the motherboard package.

% ASUS Update requires an Internet connection either through a network or an Internet
Service Provider (ISP).

Launching ASUS Update

After installing Al Suite Il from the motherboard support DVD, launch ASUS Update by
clicking Update > ASUS Update on the Al Suite || main menu bar.

% Quit all Windows® applications before you update the BIOS using this utility.
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Updating the BIOS through the Internet

To update the BIOS through the Internet:

1. From the ASUS Update screen,
select Update BIOS from Internet,
and then click Next.

2. Select the ASUS FTP site nearest
you to avoid network traffic.

If you want to enable the BIOS
downgradable function and auto
BIOS backup function, check the
checkboxs before the two items on
the screen.

3. Select the BIOS version that you
want to download. Click Next.

4. You can decide whether to change
the BIOS boot logo, which is the
image appearing on screen during
the Power-On Self-Tests (POST).
Click Yes if you want to change the
boot logo or No to continue.

5. Follow the onscreen instructions to
complete the update process.
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Updating the BIOS through a BIOS file

To update the BIOS through a BIOS file:
1. From the ASUS Update screen,

select Update BIOS from file, and
then click Next.

2. Locate the BIOS file from the Open
window, click Open, and click Next.

3. You can decide whether to change
the BIOS boot logo. Click Yes if you
want to change the boot logo or No to
continue.

4, Follow the onscreen instructions to
complete the update process.

% +  The screenshots in this section are for reference only. The actual BIOS information
vary by models.

Refer to the software manual in the support DVD or visit the ASUS website at
www.asus.com for detailed software configuration.
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3.10.2  ASUS EZ Flash 2 utility

The ASUS EZ Flash 2 feature allows you to update the BIOS without having to use a
bootable floppy disk or an OS-based utility.

/ Before you start using this utility, download the latest BIOS from the ASUS website
at www.asus.com.

To update the BIOS using EZ Flash 2:
1. Insert the USB flash disk that contains the latest BIOS file to the USB port.

2. Enter the Advanced Mode of the BIOS setup program. Go to the Tool menu to select
ASUS EZ Flash Utility and press <Enter> to enable it.

M File Path:

Drive Info Folder Info

f50:\ (BARBARA) 06/08/11 10:3% -Trashes
12/23/10  03:08p HiSnap
09/29/11 03:55p -Temporaryltens

d File Info
MODEL :

O Help Info

[Enter] Select or Load [Tabl Switch [Up/Down/Pagelp/PageDown/Hone/End] Move  [Escl Exit

3. Press <Tab> to switch to the Drive field.

4. Press the Up/Down arrow keys to find the USB flash disk that contains the latest BIOS,
and then press <Enter>.

Press <Tab> to switch to the Folder Info field.

Press the Up/Down arrow keys to find the BIOS file, and then press <Enter> to perform
the BIOS update process. Reboot the system when the update process is done.
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This function can support devices such as a USB flash disk with FAT 32/16 format and
single partition only.

+ DO NOT shut down or reset the system while updating the BIOS to prevent system
boot failure!

R Ensure to load the BIOS default settings to ensure system compatibility and stability. Select

the Load Optimized Defaults item under the Exit menu. See section 3.9 Exit Menu for
details.

3.10.3  ASUS CrashFree BIOS 3 utility

The ASUS CrashFree BIOS 3 utility is an auto recovery tool that allows you to restore the
BIOS file when it fails or gets corrupted during the updating process. You can restore a
corrupted BIOS file using the motherboard support DVD or a USB flash drive that contains
the BIOS file.

R The BIOS file in the motherboard support DVD may be older than the BIOS file published

on the ASUS official website. If you want to use the newer BIOS file, download the file at
support.asus.com and save it to a USB flash drive.

Recovering the BIOS

To recover the BIOS:

1.
2.

Turn on the system.

Insert the motherboard support DVD to the optical drive, or the USB flash drive
containing the BIOS file to the USB port.

The utility automatically checks the devices for the BIOS file. When found, the utility
reads the BIOS file and enters ASUS EZ Flash 2 utility automatically.

The system requires you to enter BIOS Setup to recover BIOS setting. To ensure
system compatibility and stability, we recommend that you press <F5> to load default
BIOS values.

DO NOT shut down or reset the system while updating the BIOS! Doing so can cause
system boot failure!
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3.10.4  ASUS BIOS Updater

The ASUS BIOS Updater allows you to update BIOS in DOS environment. This utility also
allows you to copy the current BIOS file that you can use as a backup when the BIOS fails or
gets corrupted during the updating process.

/ The succeeding utility screens are for reference only. The actual utility screen displays may
not be same as shown.

Before updating BIOS

1. Prepare the motherboard support DVD and a USB flash drive in FAT32/16 format and
single partition.

2. Download the latest BIOS file and BIOS Updater from the ASUS website at http:/
support.asus.com and save them on the USB flash drive.

R + NTFS s not supported under DOS environment. Do not save the BIOS file and BIOS
Updater to a hard disk drive or USB flash drive in NTFS format.

+ Do not save the BIOS file to a floppy disk due to low disk capacity.

3. Turn off the computer and disconnect all SATA hard disk drives (optional).

Booting the system in DOS environment

1. Insert the USB flash drive with the latest BIOS file and BIOS Updater to the USB port.

2. Boot your computer. When the ASUS Logo appears, press <F8> to show the BIOS
Boot Device Select Menu. Insert the support DVD into the optical drive and select the
optical drive as the boot device.

Please select boot device

USB XXXXXXXXXXXXXXXXX
UEFL: XXXXXXXXXXXXXXXX
Enter Setup

1 and | to move selection
ENTER to select boot device
ESC to boot using defaults

3. When the Make Disk menu appears, select the FreeDOS command prompt item by
pressing the item number.

4. Atthe FreeDOS prompt, type d: and press <Enter> to switch the disk from
Drive C (optical drive) to Drive D (USB flash drive).

Welcome to FreeDOS (http://www.freedos.org)!
c:\>d:

D:\>
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Backing up the current BIOS
To backup the current BIOS file using the BIOS Updater

R Ensure that the USB flash drive is not write-protected and has enough free space to save
the file.

1. Atthe FreeDOS prompt, type bupdater /o[filename] and press <Enter>.

D:\>bupdater /oOLDBIOS1.rom

Filename Extension

The [filename] is any user-assigned filename with no more than eight alphanumeric
characters for the filename and three alphanumeric characters for the extension.

2. The BIOS Updater backup screen appears indicating the BIOS backup process. When
BIOS backup is done, press any key to return to the DOS prompt.

ASUSTek BIOS Updater for DOS V1.18 [2011/04/29]

Current ROM Update ROM

BOARD: BOARD:
VER: VER:
DATE: DATE:

BIOS backup is done! Press any key to continue.
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Updating the BIOS file
To update the BIOS file using BIOS Updater

1. Atthe FreeDOS prompt, type bupdater /pc /g and press <Enter>.

D:\>bupdater /pc /g

2. The BIOS Updater screen appears as below.
ASUSTek BIOS Updater for DOS V1.18 [2011/04/29]
Current ROM Update ROM

BOARD: BOARD:
VER: VER:
DATE:

P8P67D.ROM 4194304 2011-08-05 17:30:48

Note
[Enter] Select or Load [Tab] Switch [V] Drive Info
[Up/Down/Home/End] Move [B] Backup [Esc] Exit

3. Press <Tab> to switch between screen fields and use the <Up/Down/Home/End> keys
to select the BIOS file and press <Enter>. BIOS Updater checks the selected BIOS file
and prompts you to confirm BIOS update.

Are you sure to update BIOS?

4. Select Yes and press <Enter>. When BIOS update is done, press <ESC> to exit BIOS
Updater. Restart your computer.

2\
'\ DO NOT shut down or reset the system while updating the BIOS to prevent system boot
L failure!

(™

R +  For BIOS Updater version 1.04 or later, the utility automatically exits to the DOS
prompt after updating BIOS.

Ensure to load the BIOS default settings to ensure system compatibility and stability.
Select the Load Optimized Defaults item under the Exit BIOS menu. See Chaper 3
of your motherboard user manual for details.

+  Ensure to connect all SATA hard disk drives after updating the BIOS file if you have
disconnected them.
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Chapter 4

4.1 Installing an operating system

This motherboard supports Windows® XP/ 64-bit XP/ Vista / 64-bit Vista / 7 / 64-bit 7
operating systems (OS). Always install the latest OS version and corresponding updates to
maximize the features of your hardware.

% +  Motherboard settings and hardware options vary. Use the setup procedures presented
in this chapter for reference only. Refer to your OS documentation for detailed
information.

+  Ensure that you install the Windows® XP Service Pack 3 or later versions before
installing the drivers for better compatibility and system stability.

4.2 Support DVD information

The support DVD that comes with the motherboard package contains the drivers, software
applications, and utilities that you can install to avail all motherboard features.

/ The contents of the support DVD are subject to change at any time without notice. Visit the
ASUS website at www.asus.com for updates.

4.2.1 Running the support DVD

Place the support DVD into the optical drive. The DVD automatically displays the Drivers menu if
Autorun is enabled in your computer. Click each menu tab and select the items you want to install.

The Drivers menu shows the available The Make Disk menu The Manual menu contains
device drivers if the sy d ins items to the list of supplementary user
installed devices. Install the necessary create the RAID/AHCI  manuals. Click an item to open
drivers to use the devices. driver disk. the folder of the user manual.

The Utilities Click the Contact
menu shows the ? tab to display the
applications and = ASUS contact

other software that v, ASUS InstAll 1 & information.
the motherboard

Goaogle Toolbar
supports. Click an icon
to display DVD/
motherboard

Intel Chipset Driver, 3 ¥ information

Google Chrome Browser,

Norton Internet Security,Solution

Intel Rapid Storage iTechnologylenterpridas
Click an item Y. M
. | Realtek Audio Driver, \
to install
Management Engine Interface

Asmadia SATA Controller, Driver

Realtek LAN Driver

Asmedia USB 3.0 Driver

% If Autorun is NOT enabled in your computer, browse the contents of the support DVD to
locate the file ASSETUP.EXE from the BIN folder. Double-click the ASSETUP.EXE to run
the DVD.
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4.2.2 Obtaining the software manuals

The software manuals are included in the support DVD. Follow the instructions below to get
the necessary software manuals.

% The software manual files are in Portable Document Format (PDF). Install the Adobe®
Acrobat® Reader from the Utilities menu before opening the files.

1. Click on the Manual tab. Click
on ASUS Motherboard Utility
Guide from the manual list on the

left. ASUS Motherboard Uiy Guids

ASUS Motherboard Installation|Guide ~ Show MotherBoar

NIS 2011 Subscription/RenewallGuide)

Realtek HD Audio|Useris\Manual
Disk Unlocker User!s/Manu:
Marvell MSU User's Manual|

ASUS WebStorage User's Manual

2. The Manual folder of the support
DVD appears. Double-click the
folder of your selected software.

3. Some software manuals are
provided in different languages.
Double-click the language to
show the software manual.

0
=2
Q)
o
-+
o
=
F

The screenshots in this section are for reference only. The actual software manuals
containing in the support DVD vary by models.
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4.3 Software information

Most of the applications in the support DVD have wizards that will conveniently guide you
through the installation. View the online help or readme file that came with the software
application for more information.

4.31 Al Suite Il

Al Suite Il is an all-in-one interface that integrates several ASUS utilities and allows users to
launch and operate these utilities simultaneously.

Installing Al Suite Il

To install Al Suite Il on your computer

1. Place the support DVD to the optical drive. The Drivers installation tab appears if your
computer has enabled the Autorun feature.

2. Click on the Utilities tab, then click Al Suite II.
3. Follow the onscreen instructions to complete installation.

Using Al Suite Il

Al Suite Il automatically starts when you enter the Windows® operating system (OS). The Al
Suite Il icon appears in the Windows® notification area. Click on the icon to open the Al Suite
Il main menu bar.

Click on each button to select and launch a utility, to monitor the system, to update the
motherboard BIOS, to display the system information, and to customize the settings of Al Suite I1.

Click to customize
the interface settings

Click to show the

system information

Click to update the motherboard BIOS

Click to monitor sensors
or CPU frequency

Click to select a utility

—Shortcut to the Auto Tuning
Mode under TurboV EVO

R +  The Auto Tuning button appears only on models with the TurboV EVO function.
+  The applications in the Tool menu vary with models.

+  The screenshots of Al Suite Il in this user manual are for reference only. The actual
screenshots vary with models.

Refer to the software manual in the support DVD or visit the ASUS website
at www.asus.com for detailed software configuration.
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4.3.2 TurboV EVO

ASUS TurboV EVO introduces TurboV that allows you to manually adjust the CPU frequency
and related voltages as well as Auto Tuning function that offers automatic and easy
overclocking and system level up. After installing Al Suite Il from the motherboard support
DVD, launch TurboV EVO by clicking Tool > TurboV EVO on the Al Suite Il main menu bar.

/ Refer to the software manual in the support DVD or visit the ASUS website at
www.asus.com for detailed software configuration.

TurboV

TurboV allows you to overclock the BCLK frequency, CPU voltage, IMC voltage, and DRAM
Bus voltage in Windows® environment and takes effect in real-time without exiting and
rebooting the OS.

Refer to the CPU documentation before adjusting CPU voltage settings. Setting a high
voltage may damage the CPU permanently, and setting a low voltage may make the
system unstable.

L)

R For system stability, all changes made in TurboV will not be saved to BIOS settings and
will not be kept on the next system boot. Use the Save Profile function to save your
customized overclocking settings and manually load the profile after Windows starts.

LIS TurboV EVO Po

Click to select

mode Manual Mode
Load profile Save the current
Target values settings as a
new profile
Current values Volt.
oltage
Click to show Adjustment
settings bars

Undoes all changes
without applying
Applies all changes
immediately

Click to restore
all start-up
settings
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Using Advanced Mode
Click on the Advanced Mode tab to adjust the advanced voltage settings.

Advanced mode Abancedode) Voltage
Target values Adjustment
bars

Undoes all changes
ithout applying

all start-up f\pplie§ all changes
immediately

settings Monitor

CPU Ratio
Allows you to manually adjust the CPU ratio.

1. Click on the CPU Ratio tab.

2. Click ON to activate the CPU Ratio function. The system automatically reboots for the
changes to take effect.

3. After system reboot, launch Turbo EVO again, and then click the CPU ratio tab. Drag
the adjustment bar upwards or downwards to the desired value.

4. Click on Apply to make the change take effect.

SIS TurboV EVO Powered by TPU

Manual Mode

Undoes all changes

Click ithout applying
N a:::;;ﬂz: Applies all changes
settings W7/ immediately

R +  Set the CPU Ratio Setting item in BIOS to [Auto] before using the CPU Ratio function
in TurboV. Refer to Chapter 3 of your motherboard user manual for details.

+  The CPU Ratio bars show the status of the CPU cores, which vary with your CPU
model.
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CPU Strap
Allows you to manually adjust CPU Strap.

1. Click on the CPU Strap tab.

2. Click on the adjustment bar to the desired value. The graph on the right will change
value accordingly.

3. Click on Apply to make the change take effect.

SSUS TurboV EVO Powered

Manual Mode

Undoes all changes
ithout applying

Applies all changes

immediately

all start-up |

settings 177/

R + Apply settings in CPU Ratio affect CPU Strap results.
+  The value on the CPU Strap diagram varies with your CPU model.

Auto Tuning

ASUS TurboV EVO includes two auto tuning modes, providing the most flexible auto-tuning
options.

R +  The overclocking result varies with the CPU model and the system configuration.
To prevent overheating from damaging the motherboard, a better thermal environment
is strongly recommended.

+  Fast Tuning: fast CPU overclocking
+  Extreme Tuning: extreme overclocking for CPU and memory

Using Fast Tuning

1. Click the Auto Tuning tab and
then click Fast.

2. Read through the warning ; =
messages and click OK to start g it
auto-overclocking. Z]
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Using Extreme Tuning
1.

TurboV automatically overclocks
the CPU, saves BIOS settings
and restarts the system. After
re-entering Windows, a message r 2575w

appears indicating auto tuning iosaxes 1 119
success. Click OK to exit.

Auto Tuning Successfull

2011/08/18

Click the Auto Tuning tab and then
click Extreme.

Read through the warning
messages and click OK to start
auto-overclocking.

TurboV automatically overclocks
the CPU and memory and restarts
the system. After re-entering
Windows, a message appears
indicating the current overclocking
result. To keep the result, click
Stop.

If you did not click Stop in
the previous step, TurboV
automatically starts further system ; 3502
overclocking and stability test. RO
An animation appears indicating
the overclocking process. Click
Stop if you want to cancel the
Overclocking process.

tE52%

TurboV automatically adjusts and A T Sucoesnl
saves BIOS settings and restarts
the system. After re-entering
er)doyvs, amessage appears IEDEECE"Z(M;; 109
indicating auto tuning success.

Click OK to exit.

2011/08/18
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4.3.3 DIGI+ Power Control

DIGI+ PowerControl allows you to adjust VRM voltage and frequency modulation to enhance
reliability and stability. It also provides the highest power efficiency, generating less heat to
longer component lifespan and minimize power loss.

After installing Al Suite Il from the motherboard support DVD, launch DIGI+ Power Control
by clicking Tool > DIGI+ Power Control on the Al Suite || main menu bar.

Select CPU Power or DRAM Power to adjust the power control settings.

CPU Power

Application aids

Apply all changes
immediately

Undo all changes
without applying

Function no. Function descri

1 CPU Load-line Calibration

It allows you to adjust the voltage settings and control the system temperature.
Higher load-line calibration could get higher voltage and good overclocking
performance but increases the CPU and VRM thermal.

2 CPU Current Capability
CPU Current Capability provides wider total power range for overclocking. A higher
value setting gets higher VRM power consumption delivery.

3 CPU Voltage Frequency
Switching frequency will affect the VRM transient response and component thermal.
Higher frequency gets quicker transient response.

4 VCCSA Load-line Calibration
The behavior of the DRAM Controller is decided by the VCCSA Load-line. Set to a
higher value for system performance, or to a lower value for better thermal solution.

5 VCCSA Current Capability
A higher value brings wider total DRAM Controller power range and extends the
overclocking frequency range simultaneously.

6 CPU Power Phase Control

Increase phase number under heavy system loading to get more transient and
better thermal performance. Reduce phase number under light system loading to
increase VRM efficiency.

7 CPU Power Duty Control
CPU Power Duty Control adjusts the current of every VRM phase and the thermal of
every phase component.
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DRAM Power

Application aids

Apply all changes
immediately

Undo all changes
without applying

Function no. Function descript

1

DRAM Current Capability

A higher value brings a wider total power range and extends the overclocking

frequency range simultaneously.

DRAM Voltage Frequency

Allows you to adjust the DRAM switching frequency for system stability or to

increase OC Range.

DRAM Power Phase Control

Select Extreme for full phase mode to increase system performance or select
Optimized for ASUS optimized phase tuning profile to increase DRAM power

efficiency.

ASUS P9X79 LE

The actual performance boost may vary depending on your CPU and DRAM

specification.

Do not remove the thermal module. The thermal conditions should be monitored.
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EPU

EPU is an energy-efficient tool that satisfies different computing needs. This utility provides
several modes that you can select to save system power. Selecting Auto mode will have the
system shift modes automatically according to current system status. You can also customize
each mode by configuring settings like CPU frequency, GPU frequency, vCore Voltage, and
Fan Control.

Launching EPU

After installing Al Suite Il from the motherboard support DVD, launch EPU by clicking
Tool > EPU on the Al Suite Il main menu bar.

Displays the following message
if no VGA power saving engine is
detected.

Multiple system
operating modes

EPU Status

The items lighting up
means power saving
Tranquiity engine is activated

Displays the amount
of CO2 reduced
U *Shifts between the
display of Total and
Current CO2 reduced

Reliability

Configurations
Displays the current
CPU power

Monitor Update

Advanced settings for each mode

Displays the sy
properties of each mode

% *«  Select From EPU Installation to show the CO2 that has been reduced since you

installed EPU.

*«  Select From the Last Reset to show the total CO2 that has been reduced since you
click the Clear button [

+  Refer to the software manual in the support DVD or visit the ASUS website at
www.asus.com for detailed software configuration.
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4.3.5 FAN Xpert+

FAN Xpert+ intelligently allows you to adjust both the CPU and chassis fan speeds
according to different ambient temperatures caused by different climate conditions in
different geographic regions and your PC’s system loading. The built-in variety of useful
profiles offer flexible automatic and manual fan speed controls to achieve a quiet and cool
environment.

Launching FAN Xpert+

After installing Al Suite Il from the motherboard support DVD, launch FAN Xpert+ by
clicking Tool > FAN Xpert+ on the Al Suite Il main menu bar.

Using FAN Xpert+

Click Fan Name to select a fan and then click Setting to select a preset mode for your
selected fan.

Click to select a fan type Click to select a fan profile

e
IS FAN Xpert+

Fan Name FAN Xpert+

CPUFan arc CPU Fan Fan Speed

Click to apply the settings
Click to discard the settings

Fan setting

+ Disable: disables the FAN Xpert+ function.

+  Standard: adjusts fan speed in a moderate pattern.

+  Silent: minimizes fan speed for quiet fan operation.

+ Turbo: maximizes the fan speed for the best cooling effect.

+ Intelligent: automatically adjusts the CPU fan speed according to the ambient
temperature.
+  Stable: fixes the CPU fan speed to avoid noise caused by the unsteady fan rotation.
However, the fan will speed up when the temperature exceeds 70°C.

+ User: Allows you to configure the CPU fan profile under certain limitations.

/ Refer to the software manual in the support DVD or visit the ASUS website at
www.asus.com for detailed software configuration.
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4.3.6 Sensor Recorder

Sensor Recorder monitors the changes in the system voltage, temperature, and fan speed on
a timeline. The History Record function allows you to designate specific time spans on record
to keep track of the three system statuses for certain purposes.

Launching Sensor Recorder

After installing Al Suite Il from the motherboard support DVD, launch Sensor Recorder by
clicking Tool > Sensor Recorder on the Al Suite || main menu bar.

Using Sensor Recorder

Click on Voltage/ Temperature/ Fan Speed tabs for the status you want to monitor. Colored
lines will automatically appear on the diagram to indicate the immediate changes in the
system status.

Using History Record

1. Click on the History Record tab and adjust the settings on the left for Record Interval
and Record Duration according to need.

2. Click on Start Recording and start measurement and record of each sensor.

When stop recording, click on Recording again to interrupt record.

4. In order to track the recorded contents, please choose the Date / Type / Select display
items to display the history detail.

w

/ Click on Monitor > Sensor on the Al Suite Il main menu bar and a highlight of the system
statuses will appear on the right panel.
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4.3.7 Probe I

Probe Il is a utility that monitors the computer’s vital components, and detects and alerts you
of any problem with these components. Probe Il senses fan rotations, CPU temperature,
and system voltages, among others. With this utility, you are assured that your computer is
always at a healthy operating condition.

Launching Probe I

After installing Al Suite Il from the motherboard support DVD, launch Probe Il by clicking
Tool > Probe Il on the Al Suite [l main menu bar.

Configuring Probe Il

Click the Voltage/Temperature/Fan Speed tabs to activate the sensors or to adjust the
sensor threshold values. The Preference tab allows you to customize the time interval of
sensor alerts, or change the temperature unit.

MNSUS Probe I

Voltage Sensor

Alert Current Threshold

10.200

4.500

2.970

Defauit

Update

Saves your
configuration
Loads your saved Loads the default Applies your
configuration threshold values changes

for each sensor

% Refer to the software manual in the support DVD or visit the ASUS website at
www.asus.com for detailed software configuration.
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4.3.8 USB 3.0 Boost

The ASUS exclusive USB 3.0 Boost provides speed boost for USB 3.0 devices and the
up-to-date support of USB Attached SCSI Protocol (UASP). With USB 3.0 Boost, you can
accelerate the transfer speed of your USB 3.0 devices with ease.

Launching USB 3.0 Boost

After installing Al Suite Il from the motherboard support DVD, launch USB 3.0 Boost by
clicking Tool > USB 3.0 Boost on the Al Suite || main menu bar.

Configuring USB 3.0 Boost

1. Connect a USB 3.0 device to the USB 3.0 port.

2. USB 3.0 Boost automatically detects the property of the connected device and
switches to Turbo mode or UASP mode (if UASP is supported by the connected
device).

3. You can manually switch the USB 3.0 mode back to Normal mode at any time.

AMSUS USB 3.0 Boost

-
=

Normal

Update

/ Refer to the software manual in the support DVD or visit the ASUS website at
www.asus.com for detailed software configuration.
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43.9 USB BIOS Flashback

This utility allows you to check and save the latest BIOS version to a USB storage device.
With ASUS USB BIOS Flashback hardware feature, the system BIOS is conveniently
updated without booting your system.

Current BIOS
Sets the schedule information
for BIOS Update-
download

Click to check for

an update BIOS
firmware available for
download

Cancels all changes

Applies all changes

Scheduling the latest BIOS download

1. Inthe Download Setting field, tick Schedule (days) and select the number of days for the next
download update available.

2. Click Apply to save the BIOS download schedule. Click Cancel to cancel the changes made.

Downloading the updated BIOS

Plug the flash drive before you start downloading.
1. Click Check for New BIOS Update to look for an updated BIOS firmware.

2. Wait for the system to check the latest
BIOS firmware.

Checking for the latest BIOS firmware. Please wait ...

Cancel

ASUS P9X79 LE
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1. After the utility detects a new BIOS
firmware, save the BIOS firmware by
clicking [l from the Save to field,
select the USB flashdrive, and click
Download.

Download

2. After the download is complete,
click OK.

After you download the BIOS file to your flash drive, you can update the motherboard’s BIOS.
Refer to 2.3.10 USB BIOS Flashback for details.
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4.3.10 Remote GO!

Connect your computer to a wireless network and use Remote GO! to wirelessly stream
media files to DLNA devices. It allows you to remotely control and access your computer

using your mobile device, and easily transfer files between your computer and mobile device.

+ Remote GO! is supported only on Windows® 7.

+ All devices using the Remote GO! functions must be in the same network.

Using Remote GO!
To launch Remote GO, click Tool > Remote GO! on the Al Suite |l menu bar.

Allows you to set a
password

BEUS Remote GO!

Application
elp

Remote GO!
menu

Update

Remote GO! functions

. DLNA Media Hub: Provides support to the latest DLNA standard, and allows you to
stream media files to a DLNA-supported device.

. Remote Desktop: Allows you to view your computer’s desktop and remotely operate
your computer in real-time from your mobile device.

. File Transfer: Allows you to transfer files between your computer and mobile device.

R Launch W-Fi GO! Remote on your mobile device to use W-Fi GO! Remote control
functions. For more details, refer to next section W-Fi GO! Remote.
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W-Fi GO! Remote

Install the W-Fi GO! Remote application on your mobile device to use Remote GO!’s remote
control functions.

g \ + Wi-Fi GO! Remote supports iOS 4.0/Android 2.3 mobile devices or later versions.

For iOS devices, download the W-Fi GO! Remote from iTunes store. For Android
devices, download the W-Fi GO! Remote from Google Play Store or from ASUS
support DVD.

Launching W-Fi GO! Remote

1. Turn on your mobile device’s wireless connection. Ensure that your mobile device is
within the same network as your computer.

2. On your mobile device, tap B3 and
tap Enter on the W-Fi GO! Remote
page.

3. Tap the computer you want to
connect to your mobile device.

4.  Tap the computer you want to
connect to your mobile device.

4-18 Chapter 4: Software support



W-Fi GO! Remote menu

R The W-Fi GO! Remote’s user interface shown above is for reference only and may vary
with the mobile device’s operating system.

Below are the supported screen resolution of your mobile devices:

Screen type Low Density Medium Density High Density Extra high density
(120, Idpi) (160, mdpi) (240, hdpi) (320, xhdpi)
QVGA
Small creen (240 x 320) 480 x 640
WavGAd00 niness
(240 x 400) HVGA
Normal screen (320 x 480) WVGA854 640 x 960
WQVGA432
(240 x 432) (480 x 854)
600 x 1024
WVGA800
WVGA800 (480 x 800)
(480 x 800)
Large screen WVGA854
WVGA854 (480 x 854)
(480 x 854)
600 x 1024
YY;(;AX 800) 1536 x 1152 2048 x 1536
Extra large screen 1024 x 600 1024 x 768 1920 x 1152 2560 x 1536
1280 x 768 1920 x 1200 2560 x 1600
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DLNA Media Hub

DLNA Media Hub allows you to stream your multimedia files to your DLNA-supported device
and remotely control playback using your mobile device or your computer.

Click to select —
media file type BEUS Remote GO!

g9 DLNA Media Hub

Tick to select
source location =y
Click to refres { Lbrary
media files

Flaxen Hair

Media files pane Displays the target

receiver’s name
and the media file
currently playing

Click to go back
to main menu

Click to edit the playlist Click to select receiver

Using the DLNA Media Hub
1. From the main screen, click DLNA Media Hub.

2. Click to select a device as your receiver.

+ When using your DLNA display (such as DLNA TV) as the receiver, ensure that
DLNA function is enabled.

+ When using another computer as the receiver, launch Windows Media Player,
click Stream > Allow remote control of my Player to remotely control media
playback.

Create playlist ~

Allow Internet access te home media...

—

-

v Allow remote centrol of my Player...

Automatically allow devices to play my media...
More streaming options...
+ When using the computer as sender and receiver, launch Windows Media

Player, click Stream > Allow remote control of my Player and Automatically
allow devices to play my media.

Create playlist ~

Allow Internet access to home media...

v Allow remote control of my Player...

v Automatically allow devices to play my media...

| More streaming options...

% +  Only computers under Windows® 7 support the DLNA Media Hub function.

- +  Keep the Windows Media Player open. Ensure that your media file formats supported
on Windows Media Player and DLNA playback devices.

3. Click any of the tabs to select your preferred media file type.
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To play music:
1. Click Music tab.

2. Tick Library to view or play
files.

Tick Playlist and select an
existing playlist from the
dropdown list.

3. Click a music file, and click B.

To edit the library:
1. Tick Library.

2. Click [l to add or delete music
files.

3.  Click Add and locate the file from
the directory. To delete, tick the
selected file and click Delete.

4. Click OK.

To edit the music playlist:
1. Tick Playlist.
2. Click . A== Remote GO!

3. Tick to select or deselect the
music file and click Save Profile.

4. Select the profile name and click
Save. To add as a new playlist,
key in your profile name and click
Save.

5. To delete playlist, select the profile
and click ill}.
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To play a video file:
1. Click Video tab.

2. Tick Library to view the video files
from your local computer. Tick
Playlist to view the video files
saved in your profile.

3. Click the video file you want to
watch, and click E.

Change the resolution from the
Quality dropdown list.

To edit the video library:
1. Tick Library.

2. Click lEH to add or delete video
files.

3. Click Add and locate the file from
the directory. To delete, tick the
selected file and click Delete.

4. Click OK.

To edit the video playlist:
1. Tick Playlist.

2. Click BN

3. Tick to select or deselect the video
file and click Save Profile.

4. Select the profile name and click
Save. To add as a new playlist,
key in your profile name and click
Save.

5. To delete playlist, select the profile
and click fi].
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To view images:
1. Click Photo tab.

2. Tick Library to view the image
files from your local computer. Tick
Playlist to view the image files
saved in your profile.

An image slideshow plays when
pressing &,

To edit the image library:
1. Tick Library.

2. Click [EEH to add or delete image
files.

3. Click Add and locate the file from
the directory. To delete, tick the
selected file and click Delete.

4. Click OK.

To edit the image playlist:
1. Tick Playlist.

2. Click EE.

3.  Tick to select or deselect the
image file and click Save Profile.

4.  Select the profile name and click
Save. To add as a new playlist,
key in your profile name and click
Save.

5. To delete playlist, select the profile
and click [IL).
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Using the DLNA Media Hub via W-Fi GO! Remote
You can access the DLNA Media Hub on your mobile device via W-Fi GO! Remote.

1. Tap DLNA Media Hub.
2. Select and tap the receiver name.
Receiver : [:“, ASUS (ASUS-PC : WINDOWS MEDIA PLAYER) v
3. The mobile device shows the information of the DLNA Media Hub function. Tap Enter
to proceed to the Remote GO! function.

4.  Tap Music, Video or Photo, to play.

% Your mobile device’s WI-FI GO! Remote interface may vary with the mobile device’s
- operating system.

Remote Desktop

Remote Desktop allows you to view your computer’s desktop and remotely operate your
computer in real-time from your mobile device.

Using the Remote Desktop
1. From the main screen, click Remote Desktop.
2. Click Setting.
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Select a suitable codec Auto, Speed optimization, or Image optimization for your
mobile device.

4.  Click Apply.

/=SUS Remote GO!

Click to select icati
a video codec . ] Application help

Click to go back
to previous
screen

Using the Remote Desktop via W-Fi GO! Remote

When the Remote Desktop is enabled, the mobile device shows the contents of your
desktop.

% The W-Fi GO! Remote’s user interface shown above is for reference only and may vary
/- with the mobile device’s operating system.
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File Transfer
Allows you to transfer files wirelessly between your computer and mobile device.

Before using File Transfer, ensure that your computer is connected to your mobile device.
For more details, refer to the section Wi-Fi GO! Remote.

Remote GO!

Application help

Destination path for ' Destination

the files transferred path for the files

from mobile device T 3 transferred from
to desktop desktop to mobile

Click to go device

back to main
menu

lick to select a destination path for
your file transfer

/ + Android mobile devices can send and receive files.

~— + iOS mobile devices can only send files.

Using File Transfer
1. Right-click the file and click Send to > [Device name].
2. After the transfer is complete, click OK.

Using File Transfer via W-Fi GO! Remote

1. On your mobile device, tap File Transfer.

2. Tap Enable to receive files from PC.

3. Tap Enter to send files to PC.
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Tap to select
the file’s source

location

Tap to select files
for transfe

Tap to send Tap to select Tap to clear all
selected files all files files

The W-Fi GO! Remote’s user interface shown above is for reference only and may vary
with the mobile device’s operating system.

Securing your computer for Wi-Fi GO! Remote functions
Remote GO! Settings allows you to create a password for your computer.
To create a password:

1. Clickm in the main menu.

2. Tick Use Password and key in your password.

3.  Click Apply.

Tick to enable
password

Key in your

Click to go Click to apply
settings made

% + When you launch the Wi-Fi GO! Remote, the application prompts you to key in the
computer’s password.

Your password must contain 6-12 letters or numbers.
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4-27



4-28

4.3.11 ASUS Update

ASUS Update lays out the options for updating BIOS on your system. Update BIOS utility
on your system or simply save the utility for later use just by following the directions on this
convenient updating feature.

Launching ASUS Update

After installing Al Suite Il from the motherboard support DVD, launch ASUS Update by
clicking Update> ASUS Update on the Al Suite Il main menu bar.

Using ASUS Update

Select the way you would like to do with the BIOS utility. Click on Next and follow the
instructions to complete your request.

Update BIOS from Internet
Download the latest BIOS utility from the ASUS service website (www.asus.com) and
follow the suggested procedures to update the BIOS version on your system.

Download BIOS from Internet
Download the latest BIOS utility from the ASUS service website (www.asus.com) and
save for later use.

Update BIOS from file
Use the BIOS utility demanded from a source file to update the BIOS version on your
system.

. Save BIOS to file
Back up the current BIOS utility on your system to another file or USB disk to save for

later use.
' There may be risks of system crash when updating BIOS. Backing up the original BIOS
o utility is recommended before updating.
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4312 MylLogo2

This MyLogo utility lets you customize the boot logo. The boot logo is the image that appears
on screen during the Power-On-Self-Tests (POST). Personalize your computer from the very
beginning!

Launching ASUS Update

After installing Al Suite Il from the motherboard support DVD, launch MyLogo by clicking
Update> MyLogo on the Al Suite Il main menu bar.

i V1)

Monitor update |

Using MyLogo
Select the way you would like to do update your boot logo. Then click Next and follow the
given instructions.

Change the BIOS boot logo of my motherboard

1. Under Current BIOS, click Browse and choose the desired image for your boot logo.
Then click on Next.

LS MylLogo

ile and picture file.
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Click on Auto Tune to adjust image size compatibility or adjust the resolution bar.
You can click on Booting Preview to preview the boot image. Then click Next.
Click on Flash to start updating the image to the boot logo.

o~ 0N

Click on Yes to reboot or you can also see the new logo next time you restart your
computer.

BSUS Mylogo

0\20110419CHO1.IPG

Change the boot logo of a downloaded BIOS file and update (or do not update) this
BIOS to the motherboard

1. AtBIOS File, Browse to download the requested BIOS file to your system. This utility
will help you detect the compatibility of the BIOS version.

Then at Picture File, Browse to select the desired image for boot logo. Click Next.
Follow steps 2-5 in Change the BIOS boot logo of my motherboard to complete
logo update.

SBEUS Mylogo

file and picture file.

/ The fullscreen logo application in BIOS utility must be enabled for MyLogo to take effect.
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4.3.13  Audio configurations

The Realtek® audio CODEC provides 8-channel audio capability to deliver the ultimate audio
experience on your computer. The software provides Jack-Sensing function, S/PDIF Out
support, and interrupt capability. The CODEC also includes the Realtek® proprietary UAJ®
(Universal Audio Jack) technology for all audio ports, eliminating cable connection errors and
giving users plug and play convenience.

Follow the installation wizard to install the Realtek® Audio Driver from the support DVD that
came with the motherboard package.

If the Realtek audio software is correctly installed, you will find the Realtek HD Audio
Manager icon on the taskbar. Double-click on the icon to display the Realtek HD Audio
Manager.

A. Realtek HD Audio Manager for Windows® 7™ / Vista™

Configuration option tabs (vary with the audio devices connected)
1

Device advanced
settings
Information button

Exit button
L Minimize button

Control settings

Set default device buttons

Connector settings

Analog and digital connector status

B. Realtek HD Audio Manager for Windows XP

Configuration Exit button

options

] Sound Efict  Mixer _Audio VO Mictophane 30 Audio Demo L
———————— Minimize button
Enyironment Auditorium REcer ) Karaoke

EeR@

Equali
Control settings unzer

window

Information
button

<
.
()]
]
Q.
)
=
(O]

Refer to the software manual in the support DVD or visit the ASUS website at
www.asus.com for detailed software configuration.
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4.4 RAID configurations

The motherboard supports the following SATA RAID solutions:
Intel® Rapid Storage Technology with RAID 0, RAID 1, RAID 10 and RAID 5 support.

R + You must install Windows® XP Service Pack 3 or later versions before using Serial
ATA hard disk drives. The Serial ATA RAID feature is available only if you are using
Windows® XP SP3 or later versions.
Due to Windows® XP / Vista limitation, a RAID array with the total capacity over 2TB
cannot be set as a boot disk. A RAID array over 2TB can only be set as a data disk
only.

+  If you want to install a Windows® operating system to a hard disk drive included in a

RAID set, you have to create a RAID driver disk and load the RAID driver during OS
installation. Refer to section 4.5 Creating a RAID driver disk for details.

4.41 RAID definitions

RAID 0 (Data striping) optimizes two identical hard disk drives to read and write data in
parallel, interleaved stacks. Two hard disks perform the same work as a single drive but at a
sustained data transfer rate, double that of a single disk alone, thus improving data access
and storage. Use of two new identical hard disk drives is required for this setup.

RAID 1 (Data mirroring) copies and maintains an identical image of data from one drive to
a second drive. If one drive fails, the disk array management software directs all applications
to the surviving drive as it contains a complete copy of the data in the other drive. This RAID
configuration provides data protection and increases fault tolerance to the entire system. Use
two new drives or use an existing drive and a new drive for this setup. The new drive must be
of the same size or larger than the existing drive.

RAID 5 stripes both data and parity information across three or more hard disk drives. Among
the advantages of RAID 5 configuration include better HDD performance, fault tolerance, and
higher storage capacity. The RAID 5 configuration is best suited for transaction processing,
relational database applications, enterprise resource planning, and other business systems.
Use a minimum of three identical hard disk drives for this setup.

RAID 10 is data striping and data mirroring combined without parity (redundancy data) having
to be calculated and written. With the RAID 10 configuration you get all the benefits of both
RAID 0 and RAID 1 configurations. Use four new hard disk drives or use an existing drive
and three new drives for this setup.
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442 Installing Serial ATA hard disks

The motherboard supports Serial ATA hard disk drives. For optimal performance, install
identical drives of the same model and capacity when creating a disk array.

To install the SATA hard disks for a RAID configuration:

1. Install the SATA hard disks into the drive bays.

2. Connect the SATA signal cables.

3. Connect a SATA power cable to the power connector on each drive.

44.3 Setting the RAID item in BIOS

You must enable the RAID function in the BIOS Setup before creating RAID set(s) using
SATA HDDs. To do this:

Enter the BIOS Setup during POST.

Go to the Advanced menu > SATA Configuration, and then press <Enter>.
Set the SATA Mode item to [RAID Mode].

Save your changes, and then exit the BIOS Setup.

> W

% Refer to Chapter 3 for details on entering and navigating through the BIOS Setup.

% Due to chipset limitation, when set any of SATA ports to RAID mode, all SATA ports run at

RAID mode together.

444 Intel® Rapid Storage Technology Option ROM utility

To enter the Intel® Rapid Storage Technology Option ROM utility:
1. Turn on the system.
2. During POST, press <Ctrl> + <I> to display the utility main menu.

Intel (R) Rapid Storage Technology - Option ROM - v10.0.0.1032
Copyright(C) 2003-10 Intel Corporation. All Rights Reserved.

[ MAIN MENU ]

eate RAID Volume 3. Reset Disks to Non-RAID
ete RAID Volume 4. Recovery Volume Options
5. Exit

[ DISK/VOLUME INFORMATION ]

RAID Volumes:
None defined.

Physical Devices:

Port Device Model Serial # Size Type/Status(Vol ID)
0 ST3160812AS 9LSOHJA4 149.0GB

1 ST3160812AS 9LSOF4HL 149.0GB

2 ST3160812AS 3LS0JYL8 149.0GB

3 ST3160812AS 9LSOBJ5H 149.0GB

[1l]-Select [ESC] -Exit [ENTER] -Select Menu
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The navigation keys at the bottom of the screen allow you to move through the menus

and select the menu options.

At

The RAID BIOS setup screens shown in this section are for reference only and may not
exactly match the items on your screen.

% The utility supports maximum four hard disk drives for RAID configuration.

Creating a RAID set

To create a RAID set:

1. From the utility main menu, select 1. Create RAID Volume and press <Enter>. The

following screen appears:

Intel(R) Rapid Storage Technology - Option ROM - v10.0.0.1032
Copyright (C) 2003-10 Intel Corporation.

All Rights Reserved.

CREATE VOLUME MENU ]

EV N

RAID Level:
Disks:
Strip Size:
Capacity:
Sync:

Vol c’
RAIDO (Stripe)

Select Disks
128KB

0.0 GB

N/A

Create Volume

Enter a unique volume name that has no special characters and is
16 characters or less.

[TAB] -Next [ESC] -Previous Menu [ENTER] -Select

[1}]Change

Enter a name for the RAID set and press <Enter>.

When the RAID Level item is selected, press the up/down arrow key to select a RAID
level to create, and then press <Enter>.

4. When the Disks item is selected, press <Enter> to select the hard disk drives you want
to include in the RAID set. The SELECT DISKS screen appears:

[ SELECT DISKS ]

Port Drive Mode

Serial #

Status
N 0
Non-RA isk
Non-RAID Disk
Non-RAID Disk

149.0GB
149.0GB
149.0GB

9LSOF4HL
3LS0JYL8
9LSO0BJ5H

ST31 12as
ST3160812AS
ST3160812AS

Select 2 to 6 disks to use in creating the volume.

[1|]1-Prev/Next [SPACE]-SelectDisk [ENTER]-Done
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5. Use the up/down arrow key to select a drive, and then press <Space> to select. A small
triangle marks the selected drive. Press <Enter> after completing your selection.

6.  Use the up/down arrow key to select the stripe size for the RAID array (for RAID 0, 10
and 5 only),and then press <Enter>. The available stripe size values range from 4KB
to 128KB. The following are typical values:

RAID 0: 128KB
RAID 10: 64KB
RAID 5: 64KB

k We recommend a lower stripe size for server systems, and a higher stripe size for
multimedia computer systems used mainly for audio and video editing.

7. When the Capacity item is selected, enter the RAID volume capacity that you want
and press <Enter>. The default value indicates the maximum allowed capacity.

8. When the Create Volume item is selected, press <Enter>. The following warning
message appears:

Are you sure you want to create this volume? (Y/N):

9. Press <Y> to create the RAID volume and return to the main menu, or <N> to go back
to the CREATE VOLUME menu.

<
.
()]
)
Q.
)
=
(O]
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Deleting a RAID set

Take caution when deleting a RAID set. You will lose all data on the hard disk drives when
o | you delete a RAID set.

To delete a RAID set:

1. From the utility main menu, select 2. Delete RAID Volume and press <Enter>. The
following screen appears:

Intel(R) Rapid Storage Technology - Option ROM - v10.0.0.1032
Copyright(C) 2003-10 Intel Corporation. All Rights Reserved.

[ 1

Name Level Drives Capacity Status Bootable
olume0 RAIDO (Stripe) 2 298.0GB Normal Yes

Deleting a volume will reset the disks to non-RAID.

ALL DISK DATA WILL BE DELETED.
(This does not apply to Recovery volumes)

[1]]1-Select [ESC] -Previous Menu [DEL] -Delete Volume

2. Use the up/down arrow key to select the RAID set you want to delete, and then press
<Del>. The following warning message appears:

(This does not apply to Recovery volumes)

Are you sure you want to delete volume “Volume0”? (Y/N):

3. Press <Y> to delete the RAID set and return to the utility main menu, or press <N> to
return to the DELETE VOLUME menu.

Exiting the Intel® Rapid Storage Technology Option ROM utility

To exit the utility:

1. From the utility main menu, select 5. Exit, and then press <Enter>. The following
warning message appears:

[ 1

Are you sure you want to exit? (Y/N):

2. Press <Y> to exit or press <N> to return to the utility main menu.
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4.5 Creating a RAID driver disk

A floppy disk with the RAID driver is required when installing a Windows® operating system
on a hard disk drive that is included in a RAID set.

R +  The motherboard does not provide a floppy drive connector. You have to use a
USB floppy disk drive when creating a SATA RAID driver disk.

Windows® XP may not recognize the USB floppy disk drive due to Windows® XP
limitation. To work around this OS limitation, refer to section 4.5.4 Using a USB
floppy disk drive.

4.5.1 Creating a RAID driver disk without entering the OS

To create a RAID driver disk without entering the OS:

Boot your computer.

Press <Del> during POST to enter the BIOS setup utility.

Set the optical drive as the primary boot device.

Insert the support DVD into the optical drive.

Save changes and exit BIOS.

When the Make Disk menu appears, press <1> to create a RAID driver disk.
Insert a formatted floppy disk into the USB floppy disk drive, then press <Enter>.
Follow the succeeding screen instructions to complete the process.

® N oo~ WD

452 Creating a RAID driver disk in Windows®

To create a RAID driver disk in Windows®:

1. Start Windows?®.

2 Plug the USB floppy disk drive and insert a floppy disk.

3. Place the motherboard support DVD into the optical drive.
4

Go to the Make Disk menu, and then click Intel X79 RAID Driver Disk to create a
RAID driver disk.

Select USB floppy disk drive as the destination disk.
6. Follow the succeeding screen instructions to complete the process.

% Write-protect the floppy disk to avoid a computer virus infection.

ASUS P9X79 LE
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4.5.3

Installing the RAID driver during Windows® OS installation

To install the RAID driver in Windows® XP:

1.

During the OS installation, the system prompts you to press the F6 key to install third-
party SCSI or RAID driver.

Press <F6>, and then insert the floppy disk with RAID driver into the USB floppy disk drive.

When prompted to select the SCSI adapter to install, select the RAID driver for the
corresponding OS version.

Follow the succeeding screen instructions to complete the installation.

To install the RAID driver for Windows® Vista or later OS:

1.

During the OS installation, click Load Driver to allow you to select the installation
media containing the RAID driver.

Insert the USB flash drive with RAID driver into the USB port or the support DVD into
the optical drive, and then click Browse.

Click the name of the device you've inserted, go to Drivers > RAID, and then select
the RAID driver for the corresponding OS version. Click OK.

Follow the succeeding screen instructions to complete the installation.

% Before loading the RAID driver from a USB flash drive, you have to use another computer

to copy the RAID driver from the support DVD to the USB flash drive.
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454 Using a USB floppy disk drive

Due to OS limitation, Windows® XP may not recognize the USB floppy disk drive when you
install the RAID driver from a floppy disk during the OS installation.

To solve this issue, add the USB floppy disk drive’s Vendor ID (VID) and Product ID (PID) to
the floppy disk containing the RAID driver. Refer to the steps below:

1. Using another computer, plug the USB floppy disk drive, and insert the floppy disk
containing the RAID driver.

2. Right-click My Computer on the F .
Windows® desktop or start menu,

Explare
and then select Manage from the |
pop-up window. Trop NeCwor e

Disconnect Network Drive.

Create Shartut
Delete
Rename

Praperties

3. Select Device Manager. From the
Universal Serial Bus controllers,
right-click xxxxxx USB Floppy, and
then select Properties from the pop-up
window.

% The name of the USB floppy disk
- drive varies with different vendors.

1 computer Management

5 4% Other &

% pons (CoMaLPT)
o

USE Root
USE Root Hub

4. Click Details tab. The Vendor ID (VID)
and Product ID (PID) are displayed.

Mitsumi USB Floppy Properties

| General | Drivef | Detais |

e MisumiLISE Flopey

USEE’ID}IBEE&P\DiEEDT %&ESEDAEERD&Z

5. Browse the contents of the RAID driver
disk to locate the file txtsetup.oem. ] e o I
6.  Double-click the file. A window appears, [ (e
allowing you to select the program for e

opening the oem file. programs on your computer.

What do yau want o do?

i priate program
|_ () Select the program From a list

<
.
()]
)
Q.
)
=
(O]
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7. Use Notepad to open the file. Open With (3]

~ Choose the program you wank to use to open this file:
S

File:  txtsetup.oem

Programs

Recommended Programs:
B motepad
I Other Programs:
B adobe Reader 8.1
@ Internet Explorer
W Paint
@ windows Media Player
| windows Picture and Fax Wiewer
[A wordpad b
Type a description that you want to use for this kind of File:

[] Always use the selected program to open this kind of File

If the program you want is nok in the list or on your computer, you can look
for the appropriate program on the Web.

E3

8. Find the [Hardwarelds.scsi.iaAHCI_DesktopWorkstationServer] and
[Hardwarelds.scsi.iaStor_DesktopWorkstationServer] sections in the txtsetup.oem
file.

9. Type the following line to the bottom of the two sections:
id = “USB\VID_xxxx&PID_xxxx”, “usbstor”

[HardwareIds.scsi.iaAHCI_DesktopWorkstationServer]
id= “PCI\VEN 8086&DEV 1C02&CC 0106”,”iaStor”
| id= “USB\VID 03EE&PID 6901”, “usbstor” |

[HardwareIds.scsi.iaStor_ DesktopWorkstationServer]
id= “PCI\VEN 8086&DEV 2822&CC 0104”,”iaStor”
| id= “USB\VID 03EE&PID 6901”, “usbstor” |

R Add the same line to both sections.

% The VID and PID vary with different vendors.

10. Save and exit the file.
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5.1 AMD® CrossFireX™ technology

The motherboard supports the AMD® CrossFireX™ technology that allows you to install
multi-graphics processing units (GPU) graphics cards. Follow the installation procedures in
this section.

5.1.1 Requirements

. In Dual CrossFireX mode, you should have two identical CrossFireX-ready graphics
cards or one CrossFireX-ready dual-GPU graphics card that are AMD® certified.

. Ensure that your graphics card driver supports the AMD CrossFireX technology.
Download the latest driver from the AMD website (www.amd.com).

. Ensure that your power supply unit (PSU) can provide at least the minimum power
required by your system. See Chapter 2 for details.

R +  We recommend that you install additional chassis fans for better thermal environment.

Visit the AMD Game website (http://game.amd.com) for the latest certified graphics
card and the supported 3D application list.

5.1.2 Before you begin

For AMD CrossFireX to work properly, you have to uninstall all existing graphics card drivers
before installing AMD CrossFireX graphics cards to your system.

To uninstall existing graphics card drivers:

1. Close all current applications.

2. For Windows XP, go to Control Panel > Add/Remove Programs.
For Windows Vista, go to Control Panel > Programs and Features.

3. Select your current graphics card driver/s.

4. For Windows XP, select Add/Remove.
For Windows Vista, select Uninstall.

5. Turn off your computer.
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513 Installing two CrossFireX™ graphics cards

The following pictures are for reference only. The graphics cards and the motherboard
layout may vary with models, but the installation steps remain the same.

1. Prepare two CrossFireX-ready graphics
cards.

2. Insert the two graphics card into the
PCIEX16 slots. If your motherboard
has more than two PCIEX16 slots,
refer to Chapter 2 in this user manual
for the locations of the PCIEX16 slots
recommended for multi-graphics card
installation.

3. Ensure that the cards are properly
seated on the slots.

4. Align and firmly insert the CrossFireX
bridge connector to the goldfingers on
each graphics card. Ensure that the
connector is firmly in place.

goldfingers

CrossFireX bridge
(bundled with
graphics cards)

5. Connect two independent auxiliary power
sources from the power supply to the two
graphics cards separately.

6. Connect a VGA or a DVI cable to the
graphics card.
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5.1.4 Installing three CrossFireX™ graphics cards

1. Prepare three CrossFireX-ready graphics cards.

2. Insert the three graphics card into the PCIEX16 slots. If your motherboard has more
than three PCIEX16 slots, refer to Chapter 1 in this user manual for the locations of the
PCIEX16 slots recommended for multi-graphics card installation.

3. Ensure that the cards are properly seated on the slots.

5. Connect three independent auxiliary
power sources from the power supply to
the three graphics cards separately.

6.  Connect a VGA or a DVI cable to the
graphics card.
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5.1.5 Installing the device drivers

Refer to the documentation that came with your graphi
drivers.

cs card package to install the device

R Ensure that your PCI Express graphics card driver supports the AMD® CrossFireX™
technology. Download the latest driver from the AMD website (www.amd.com).

5.1.6 Enabling the AMD® CrossFireX™ technology

After installing your graphics cards and the device drivers, enable the CrossFireX™ feature

through the AMD Catalyst™ Control Center in Window.

Launching the AMD Catalyst Control Center
To launch the AMD Catalyst Control Center:

1. Right-click on the Windows® desktop and select
Catalyst Control Center.

2. Click Catalyst Control Center to configure the

displays and settings of your AMD graphic cards.

S environment.

= Catalyst Control Center

View »
Sort by 3
Refresh

Paste

Paste shortcut

Undo Rename Ctrl+Z
New »

IS Screen resolution

W Gadgets

Series Pro... (e

neric Non-PnP Monitor and Al

Adapter Monitor Troubleshoot
Color Management & Catalyst Control Center

Catalyst™
Control Center

The Catalyst Control Center is used to configure displays
nd settings fo MD GPL.

Catalyst Control Center

To open the Catalyst Control Center, cick on tis button:

Catalyst Control Center I

ok | [ cancel
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Enabling Dual CrossFireX technology

1.

2
3.
4

In the Catalyst Control Center window, click Performance > AMD CrossFireX™.
Select Enable CrossFireX™.
Select a GPU combination from the drop-down list.

Click Apply to save and activate the GPU settings made.

RADE!

Saarce Catalyst Control Center

|__AmMDI Preferences

][« AMD CrossFireX™ - ?
> Pinned # AMD CrossFireX™ enables multiple graphics processors to work together for improved graphics quality and
) Prosete # performance.
- Deskiop &
Management Choose to enable AMD CrossFireX for added graphics performance.

Common Display
> Tasks L

> My VGA Displays
"' P25 | g crable AMD Crassirex e
> Video +

> Gaming "

_) Disable AMD CrossFireX

« Performance @
1 prep—— Your system has more than two graphics processors that are capable of AMD

"AMD OverDrive CrossFireX. Select the GPU combination that you want to use.

> Audio

4GPUs (1924029) -
4GPUs(1924029)
3GPUs(19240)
2GPUs (1924

e

> Information

o

o
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5.2 NVIDIA® SLI™ technology

The motherboard supports the NVIDIA® SLI™ (Scalable Link Interface) technology that
allows you to install multi-graphics processing units (GPU) graphics cards. Follow the
installation procedures in this section.

5.2.1 Requirements
+  In SLI mode, you should have two identical SLI-ready graphics cards that are NVIDIA®
certified.

+  Ensure that your graphics card driver supports the NVIDIA SLI technology. Download the
latest driver from the NVIDIA website at www.nvidia.com.

+  Ensure that your power supply unit (PSU) can provide at least the minimum power
required by your system.

R + We recommend that you install additional chassis fans for better thermal environment.

+  Visit the NVIDIA zone website (http://www.nzone.com) for the latest certified graphics
card and supported 3D application list.

5.2.2 Installing two SLI-ready graphics cards

R The following pictures are for reference only. The graphics cards and the motherboard
layout may vary with models, but the installation steps remain the same.

1. Prepare two SLI-ready graphics cards.

2. Insert the two graphics card into the
PCIEX16 slots. If your motherboard
has more than two PCIEX16 slots,
refer to Chapter 2 in this user manual
for the locations of the PCIEX16 slots
recommended for multi-graphics card
installation.

3. Ensure that the cards are properly seated
on the slots.
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4. Align and firmly insert the SLI bridge connector to the goldfingers on each graphics
card. Ensure that the connector is firmly in place.

5. Connect two independent auxiliary power sources from the power supply to the two
graphics cards separately.

6.  Connect a VGA or a DVI cable to the
graphics card.

SLI bridge

Goldfingers

5.2.3 Installing three SLI-ready graphics cards

1. Prepare three SLI-ready graphics cards.

2. Insert the three graphics card into the
PCIEX16 slots. If your motherboard
has more than two PCIEX16 slots,
refer to Chapter 1 in this user manual
for the locations of the PCIEX16 slots
recommended for multi-graphics card
installation.

3. Ensure that the cards are properly
seated on the slots.

4. Align and firmly insert the 3-Way SLI
bridge connector to the goldfingers on
each graphics card. Ensure that the
connector is firmly in place.

5. Connect three independent auxiliary
power sources from the power supply to
the three graphics cards separately.

3-Way SLI bridge
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5.24 Installing the device drivers

Refer to the documentation that came with your graphics card package to install the device
drivers.

R Ensure that your PCI Express graphics card driver supports the NVIDIA® SLI™ technology.
Download the latest driver from the NVIDIA website (www.nvidia.com).

5.2.5 Enabling the NVIDIA® SLI™ technology

After installing your graphics cards and the device drivers, enable the SLI feature in NVIDIA®
Control Panel under the Windows® 7 operating system.

Launching the NVIDIA Control Panel
You can launch the NVIDIA Control Panel by the following two methods.

A.  Right click on the empty space of the Windows® desktop and select NVIDIA Control
Panel.

The NVIDIA Control Panel window appears (See Step
B3).

View 3
Sort by ]
Refresh

Paste
Paste shortcut

MVIDIA Control Panel

New 3
ES  Screen resolution
W Gadgets

& Personalize

B1. If you cannot see the NVIDIA Control Panel item in step View »
(A), select Screen Resolution. Sort by »
Refresh
Paste
Paste shortcut

Undo Rename Ctrl+Z

MNew 4

ES| Screen resolution
@ Gadgets

&l Personalize
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B2. From the Screen Resolution window,
click Advanced settings.

B3. The NVIDIA Control Panel window
appears.

Enabling SLI settings

From the NVIDIA Control Panel window,
select Configure SLI, Surround, PhysX.
In the Quad-SLI enabled, click Maximize
3D Performance SLI to set the display for
viewing SLI rendered content. When done,
click Apply.

ASUS P9X79 LE
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Notices

Federal Communications Commission Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions:

+  This device may not cause harmful interference.

+  This device must accept any interference received including interference that may cause
undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed

and used in accordance with manufacturer’s instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur

in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or more of the following measures:

»  Reorient or relocate the receiving antenna.

» Increase the separation between the equipment and receiver.

+  Connect the equipment to an outlet on a circuit different from that to which the receiver is
connected.

»  Consult the dealer or an experienced radio/TV technician for help.

to assure compliance with FCC regulations. Changes or modifications to this unit not
~ expressly approved by the party responsible for compliance could void the user’s authority
to operate this equipment.

; The use of shielded cables for connection of the monitor to the graphics card is required

IC: Canadian Compliance Statement

Complies with the Canadian ICES-003 Class B specifications. This device complies with RSS
210 of Industry Canada. This Class B device meets all the requirements of the Canadian
interference-causing equipment regulations.

This device complies with Industry Canada license exempt RSS standard(s). Operation is
subject to the following two conditions: (1) this device may not cause interference, and (2)
this device must accept any interference, including interference that may cause undesired
operation of the device.

Cut appareil numérique de la Classe B est conforme a la norme NMB-003 du Canada.
Cet appareil numérique de la Classe B respecte toutes les exigences du Réglement sur le
matériel brouilleur du Canada.

Cet appareil est conforme aux normes CNR exemptes de licence d’Industrie Canada. Le
fonctionnement est soumis aux deux conditions suivantes :

(1) cet appareil ne doit pas provoquer d'interférences et

(2) cet appareil doit accepter toute interférence, y compris celles susceptibles de provoquer
un fonctionnement non souhaité de I'appareil.
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Canadian Department of Communications Statement

This digital apparatus does not exceed the Class B limits for radio noise emissions from
digital apparatus set out in the Radio Interference Regulations of the Canadian Department
of Communications.

This class B digital apparatus complies with Canadian ICES-003.
VCCI: Japan Compliance Statement

VCCI Class B Statement

HRAEEESBERLY B ERMICoONT

IoHEE  ERABEESEIRSOIRWENRS (V) OBRCETC 7 7 A BEMLTEE
TE rORMBFEMETEASAIT LEEMELTLETA - TORERFI VAT LEY
IVRERCEREL TEASNI L RERTLIISBITILAD 2T -

BRHARCH S TEL RO RuEL TFan -

KC: Korea Warning Statement

BE 7171 34 HEEFA7ZA)
ol 7171 7HA4®F) AAFHIZNZA F2 7HAAA AHgse A& FFHos
e, BE AgoA ALEE F U5

R QT 9REA Shs4e L2 94PN Y A
Sy

Iy
ele
e
4>
2
oy

REACH

Complying with the REACH (Registration, Evaluation, Authorisation, and Restriction of
Chemicals) regulatory framework, we published the chemical substances in our products at
ASUS REACH website at http://csr.asus.com/english/REACH.htm.

DO NOT throw the motherboard in municipal waste. This product has been designed to
enable proper reuse of parts and recycling. This symbol of the crossed out wheeled bin
|

indicates that the product (electrical and electronic equipment) should not be placed in
municipal waste. Check local regulations for disposal of electronic products.

DO NOT throw the mercury-containing button cell battery in municipal waste. This symbol
of the crossed out wheeled bin indicates that the battery should not be placed in municipal
waste.

ASUS Recycling/Takeback Services

ASUS recycling and takeback programs come from our commitment to the highest standards for
protecting our environment. We believe in providing solutions for you to be able to responsibly
recycle our products, batteries, other components as well as the packaging materials. Please
go to http://csr.asus.com/english/Takeback.htm for detailed recycling information in different
regions.
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RF Equipment Notices

CE: European Community Compliance Statement

The equipment complies with the RF Exposure Requirement 1999/519/EC, Council
Recommendation of 12 July 1999 on the limitation of exposure of the general public to
electromagnetic fields (0-300 GHz). This wireless device complies with the R&TTE Directive.

Wireless Radio Use

This device is restricted to indoor use when operating in the 5.15 to 5.25 GHz frequency
band.

Exposure to Radio Frequency Energy

The radiated output power of the Wi-Fi technology is below the FCC radio frequency
exposure limits. Nevertheless, it is advised to use the wireless equipment in such a manner
that the potential for human contact during normal operation is minimized.

FCC Bluetooth Wireless Compliance

The antenna used with this transmitter must not be colocated or operated in conjunction with
any other antenna or transmitter subject to the conditions of the FCC Grant.

Bluetooth Industry Canada Statement

This Class B device meets all requirements of the Canadian interference-causing equipment
regulations.

Cet appareil numérique de la Class B respecte toutes les exigences du Réglement sur le
mateériel brouilleur du Canada.

BSMI: Taiwan Wireless Statement

R R S

SRR EhEANEES FEHFT > AF - GRBEAESFSNERENE - N
KThER o o O I a2 R Bonh R - (BT R M (5 A R S S R 2 BT AR
EREHTRRESE - EIAEA XS TRT RN SRR - fESAEEHERER

EMEMFR Z MRS - SRR ARNATRSXEERTR HEREFA TSN EE
R T

1A 5.25GHz Z 5.35GHz BigRR{E=
BB E H’\J#‘Eﬁﬂﬂ

T #5% 5250 ~ 5.350GHz ;% SRR EAER -

Japan RF Equipment Statement
ToRL, MERFERSIS~530GHzTRMIELTWE L &2, BAREWTOLEAAETT.
KC (RF Equipment)

neas 34 2 £4

FEALA G BE ALY

A% FALNE &4 F AREAN A5l A,

o 771e AWFAt AR Aulzo] AT + AgTh
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ASUS contact information

ASUSTeK COMPUTER INC.

Address 15 Li-Te Road, Peitou, Taipei, Taiwan 11259
Telephone +886-2-2894-3447

Fax +886-2-2890-7798

E-mail info@asus.com.tw

Web site www.asus.com.tw

Technical Support

Telephone +86-21-38429911

Online support support.asus.com

ASUS COMPUTER INTERNATIONAL (America)

Address 800 Corporate Way, Fremont, CA 94539, USA
Telephone +1-812-282-3777

Fax +1-510-608-4555

Web site usa.asus.com

Technical Support

Telephone +1-812-282-2787

Support fax +1-812-284-0883

Online support support.asus.com

ASUS COMPUTER GmbH (Germany and Austria)
Address Harkort Str. 21-23, D-40880 Ratingen, Germany
Fax +49-2102-959911

Web site www.asus.de

Online contact www.asus.de/sales

Technical Support

Telephone +49-1805-010923*

Support Fax +49-2102-9599-11

Online support support.asus.com

* EUR 0.14/minute from a German fixed landline; EUR 0.42/minute from a mobile phone.
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